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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА  

Учебно-методический комплекс (УМК) по дисциплине «Методика 

обучения компьютерной графике» разработан в соответствии с 

образовательными стандартами высшего образования первой ступени для 

специальности 1–03 01 03 «Изобразительное искусство и компьютерная 

графика».  

Целью УМК является информационно - методическое обеспечение 

учебного процесса по дисциплине «Методика обучения компьютерной 

графике». 

К основным функциям УМК относится:  

- раскрытие требований к содержанию дисциплины «Методика 

обучения компьютерной графике»,  к образовательной и профессиональной 

подготовке студента как будущего педагога; 

- управление учебной деятельностью студентов по дисциплине 

«Методика обучения компьютерной графике»; 

- объединение учебно-методических материалов, обеспечивающих 

преемственность  междисциплинарных связей в процессе освоения учебной 

дисциплины. 

Учебно-методический комплекс по дисциплине «Методика обучения 

компьютерной графике» имеет структуру: 

- пояснительная записка (введение в УМК); 

- теоретический раздел (структура и краткое содержание 

лекционного материала);  

- практический раздел содержит методические материалы для 

проведения практических и лабораторных занятий; 

- раздел контроля знаний включает вопросы к экзамену, рейтинговые 

контрольные задания;  

- вспомогательный раздел, содержит список основной и 

дополнительной литературы.  

Представленный учебно-методический комплекс разработан в 

соответствии с действующей программой по дисциплине «Методика 

обучения компьютерной графике». 

Структура данного комплекса обусловлена основной целью учебной 

дисциплины – обеспечение студента теоретическими знаниями и 

практическими умениями, рациональными методами, средствами и формами 

обучения компьютерной графике учащихся на факультативных занятиях в 

средней общеобразовательной школе  

Задачи учебной дисциплины: 

- освоение теоретических и практических основ работы с 

графическими редакторами растровой и векторной графики, а также со 

способами создания анимации; 

- формирование у студентов практических навыков работы в 

графических редакторах для решения художественно-творческих задач в 

средней общеобразовательной школе; 
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- формирование графической культуры и развитие художественно-

творческих способностей; 

- повышение культуры использования информационных технологий в 

сфере профессионального художественного творчества и образования. 

Структура содержания УМК по учебной дисциплины «Методика 

обучения компьютерной графике» построена на основе традиционного 

подхода с разбиением содержания на темы; при этом они представляют 

собой относительно самостоятельные дидактические единицы содержания 

обучения. 

Основными формами работы являются: лекции, практические,  

лабораторные занятия, самостоятельная работа студента, которая включает в 

себя подготовку и проведение фрагментов факультативных занятий, работу с 

литературными источниками, выполнение художественно-творческих работ. 

Контроль знаний, умений и навыков осуществляется в форме экзамена. 

Основными методами (технологиями) обучения, адекватно 

отвечающими целям изучения данной учебной дисциплины, являются: 

- проблемное обучение (проблемное изложение, частично-поисковый 

и исследовательский методы); 

- технология обучения как учебного исследования. 

В соответствии с содержанием конкретной темы и определенной 

системой художественно-творческих компетенций (знаний и умений, 

способов деятельности) студентом выполняются творческие работы. 

Выполнение графических работ позволит осуществить не только 

диагностику сформированности у них изобразительно-графических и 

художественно-творческих компетенций, но и выполнить обучающую 

функцию. Содержание практических работ призвано раскрыть роль и место 

компьютерной графики в производственной, педагогической и 

художественно-творческой деятельности. Основными формами работы со 

студентами являются лекции, практические и лабораторные занятия, 

самостоятельная работа. 

На лекциях сообщаются теоретические сведения по разделам методики 

обучения с учетом инновационных подходов и направлений в развитии 

художественного образования, которые способствуют формированию 

системы знаний по основным разделам дисциплины.  

На практических занятиях студенты овладевают знаниями и 

практическими умениями в области планирования занятий, моделирования и 

организации учебно-творческой деятельности учащихся, проведение 

фрагментов  факультативных занятий с последующим их анализом. 

Лабораторные занятия предполагают выполнение студентами 

индивидуальных творческих заданий, методических разработок, 

наобходимых для планирования и проведения факультативных занятий.  

В процессе изучения дисциплины студенты должны освоить основные 

понятия методики обучения компьютерной графики, овладеть 

художественно-педагогическими умениями и навыками, которые заложены в 

квалификационной характеристике специалиста данного профиля. 
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В результате изучения дисциплины студент должен знать:  

- структуру и содержание курса компьютерной графики в школе; 

- учебно-методическое и программное обеспечение курса; 

- методику изучения основных понятий и тем; 

- современные тенденции в графическом компьютерном дизайне. 

В результате изучения дисциплины студент должен  уметь: 

- использовать методику обучения учащихся приемам создания 

графических компьютерных композиций; 

- организовать художественно-творческую деятельность учащихся в 

виртуальной среде; 

- развивать и совершенствовать у учащихся навыки освоения 

программного обеспечения. 

В результате изучения дисциплины студент должен  владеть: 

 векторной, растровой и трехмерной графикой; 

 системами автоматического проектирования; 

 инструментами  обработки анимации и звука. 
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1.ТЕОРЕТИЧЕСКИЙ РАЗДЕЛ 

 

Лекция 1. Методика обучения компьютерной графике как научная 

дисциплина 

План лекции: 

1. Методика обучения компьютерной графики составная часть педагогики. Ее 

цели и задачи. Этапы и методы научных исследований в методике 

обучения компьютерной графике. 

2. Краткий исторический обзор преподавания компьютерной графики. 
Взаимосвязь методики компьютерной графики с наукой информатики и 

другими науками (психологией, педагогикой, информатикой, культурологией 

и др.) и специальными художественными дисциплинами.  

3. Организация факультативных занятий по компьютерной графике. Методы 

обучения. Дидактические принципы обучения. Подготовка учителя к 

уроку. 

Краткое содержание лекции 

1. Методика обучения компьютерной графики составная часть педагогики. Ее 

цели и задачи. Этапы и методы научных исследований в методике обучения 

компьютерной графике. 

Общие вопросы методики обучения обучения компьютерной графике. 

В начале зададимся вопросом: "Что такое методика и для чего она нужна?" 

Метод - прием, способ или образ действия; в другом смысле -fin к об 

познания, исследования явлений. 

Методика - совокупность методов, приемов целесообразного 

проведения какой-либо работы. Методика преподавания - строго 

последовательный, систематичный, точно следующий плану процесс 

обучения учебному предмету. 

Иногда можно услышать мнение, что личные качества учителя 

определяют успех обучения в большей мере, чем знание методики. При этом 

утверждается, что если у учителя есть глубокие знания и любовь к делу, то 

опыт и талант подскажут, как лучше учить учащихся. В этом высказывании 

верно только то, что знание дела необходимо учителю черчения так же, как и 

любому другому специалисту 

Знание дела для учителя означает не только знание своего предмета, но 

и знание тех закономерностей, которые свойственны процессу обучения и 

которыми следует управлять. 

Слово ―методика‖ происходит от древнегреческого ―методос‖, что 

означает ―путь исследования‖, ―способ познания‖. 

Перед методикой обучения компьютерной графики как отраслью 

педагогической науки стоят следующие основные задачи: 

o Определить конкретные цели изучения компьютерной графики, позна-

вательное и воспитательное значение как учебного предмета. 

o Определить содержание и структуру обучения. 
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o Разработать наиболее рациональные методы, средства и формы обучения, 

обеспечивающие прочное усвоение учащимися знаний, умений и навыков. 

 Исследовать процесс усвоения знаний учащимися. 

В методике рассматриваются вопросы изучения основных разделов и 

тем курса, пути формирования навыков работы в графических редакторах, 

роль творческих графических задач и их использование в обучении и др. 

Таким образом, методика обучения компьютерной графике—это 

область педагогической науки, определяющая задачи, содержание и методы 

обучения компьютерной графике школьников, изучающая рациональные 

приемы работы с растровыми и векторными изображениями, создание 

анимации и вставка звука и видео, разрабатывающая формы и средства 

эффективной организации учебного процесса исходя из целей и задач 

образования, воспитания и развития учащихся в процессе изучения 

компьютерной графики. 

Методика обучения компьютерной графики делится на общую и 

частную. Общая методика рассматривает вопросы теоретических основ курса. 

К ним относятся цели и задачи изучения компьютерной графики в школе; 

содержание и структура курса; разработка методов и организационных форм 

обучения; отбор, разработка и исследование методических средств обучения 

(учебно-наглядных пособий и оборудования); выявление межпредметных 

связей обучения компьютерной графики (с информатикой, изобразительным 

искусством; определение понятий и др. 

В частной методике рассматриваются содержание и последова-

тельность изучения тем программы, пути формирования понятий, 

рекомендации по применению наглядных пособий, содержание творческих 

графических работ и т. п. 

Методика преподавания компьютерной графики  как новый раздел 

педагогической науки и учебный предмет подготовки учителя изо  

компьютерной графики. 

К теории и методике обучения компьютерной графики нужно относить 

исследование процесса обучения везде, где бы он ни проходил и на всех 

уровнях: дошкольный период, школьный период, все типы средних учебных 

заведений, высшая школа, самостоятельное изучение информатики, 

дистанционные формы обучения и т.п. Каждая из перечисленных областей в 

настоящее время ставит свои специфические проблемы перед современной 

педагогической наукой. Нас в данном случае в первую очередь будет 

интересовать та область методики информатики и компьютерной графики, 

которая рассматривает обучение компьютерной графике в средней школе в 

рамках общеобразовательного предмета информатики. 

Понятно, что определение методики компьютерной графики как 

науки об обучении информатике само по себе еще не означает 

существования этой научной области в готовом виде. Теория и методика 

обучения информатике и компьютерной графике в настоящее время 

интенсивно развивается. 
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В соответствии с общими целями обучения методика преподавания 

компьютерной графики ставит перед собой следующие основные за дачи:  

• определить конкретные цели изучения компьютерной графики, а 

так же содержание соответствующего общеобразовательного предмета и его 

место в учебном плане средней школы; 

• разработать, предложить школе и учителю-практику наиболее 

рациональные методы и организационные формы обучения, направленные 

на достижение поставленных целей; 

• рассмотреть всю совокупность средств обучения компьютерной 

графике (учебные пособия, программные средства, технические средства и 

т. п.) и разработать рекомендации по их применению в практике работы 

учителя. 

Говоря иными словами, перед методикой преподавания 

компьютерной графики, как и перед всякой предметной школьной методи-

кой, ставится традиционная триада основных вопросов: 

• зачем учить? 

• что надо изучать? 

• как надо обучать ? 

Методика преподавания компьютерной графики — молодая наука, она 

формируется не на пустом месте, она включает в себя интеграцию методик 

изобразительного искусства и методику преподавания информатики в 

средней школе. Будучи фундаментальным разделом педагогической науки, 

методика опирается в своем развитии на философию, педагогику, 

психологию, информатику, а также обобщенный практический опыт 

средней школы. 

Из всей совокупности методико-педагогических знаний и опыта, 

объединяемых методикой информатики, выделяется учебный предмет 

«Методика обучения компьютерной графике», который согласно 

Государственному образовательному стандарту высшего 

профессионального образования входит в образовательно-про-

фессиональную программу подготовки учителя по специальности 

«Изобразительное искусство и компьютерная графика».  

На этой основе формулируются и главные задачи общеобразовательной 

школы: 

o обеспечение усвоения учащимися системы знаний, определяемой 

общественными и производственными потребностями; 

o формирование научного миропонимания, политической, экономической, 

правовой культуры, гуманистических ценностей и идеалов, творческого 

мышления, самостоятельности в пополнении знаний; 

o удовлетворение национально-культурных потребностей населения, 

воспитание физически и морально здорового поколения; 

o выработка у молодежи осознанной гражданской позиции, человеческого 

достоинства, стремления к участию в демократическом самоуправлении, 

ответственности за свои поступки . 
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Проектируемые результаты образовательно-воспитательнрй деятельности 

школы могут быть сгруппированы в три основные общие цели, которые ставятся 

перед системой общего школьного образования:  

o образовательные и развивающие цели;  

o практические цели;  

o воспитательные цели. 

Общие цели обучения компьютерной графике определяются с учетом 

особенностей информатики как науки, ее роли и места в системе наук, в жизни 

современного общества. Рассмотрим, как основные цели, характерные для школы 

в целом, могут быть отнесены к образованию школьников в области 

информатики  и компьютерной графики. 

Образовательная и развивающая цель обучения информатике  и компьютерной 

графике в школе — дать каждому школьнику начальные фундаментальные 

знания основ компьютерной графики, включая представления о процессах 

преобразования, передачи и использования информации, и на этой основе 

раскрыть учащимся значение информационных процессов в развитии 

современного общества.  

Практические цели 

Вооружить учащихся теми базовыми умениями и навыками, которые 

необходимы для прочного и сознательного усвоения знаний в области 

изобразительной деятельности, а также основ других наук, изучаемых в 

школе. Усвоение знаний из области компьютерной графики, как и 

приобретение соответствующих умений и навыков призвано существенно 

влиять на формирование таких черт личности, как общее умственное 

развитие учащихся, развитие их мышления и творческих способностей. 

Практическая цель школьного курса компьютерной графики — внести 

вклад профессиональную подготовку учащихся, т.е. вооружить их теми 

знаниями, умениями и навыками, которые могли бы обеспечить подготовку 

к трудовой деятельности после окончания школы. Это означает, что 

школьный курс компьютерной графики должен не только знакомить с 

основными понятиями, но и быть практически ориентированным — обучать 

школьника изобразительной деятельности  на компьютере с использованием 

средств новых информационных технологий. 

В целях профориентации курс компьютерной графики должен давать 

учащимся сведения о профессиях, непосредственно связанных с ЭВМ и 

информатикой, а также различными приложениями изучаемых в школе 

наук, опирающимися на использование ЭВМ. Наряду с производственной 

стороной дела практические цели обучения компьютерной графики 

предусматривают также и «бытовой» аспект — готовить молодых людей к 

грамотному использованию компьютерной техники и других средств 

информационных и коммуникационных технологий в быту, в повседневной 

жизни. 

Воспитательная цель школьного курса компьютерной графики 

обеспечивается, прежде всего, тем мощным мировоззренческим воздей-

ствием на ученика, которое оказывает осознание возможностей и роли 
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вычислительной техники и средств информационных технологий в развитии 

общества и цивилизации в целом.  

- отрасль педагогической науки, изучает закономерности обучения 

изобразительному искусству, накапливает технологический инструментарий, 

позволяющий оптимальными методами и средствами усваивать содержание 

обучения изобразительному искусству, овладевать опытом изобразительной 

деятельности, оценочными отношениями. 

- в узком смысле – учение о методах обучения изобразительному 

искусству (если речь идет только о тех методах, которые применяются для 

обучения именно изобразительному искусству):  

Методика – это осознанная система действий, приводящая к 

определенным результатам. 

- учебный курс, вузовская дисциплина, который преподается в 

педагогических учебных заведениях и др. учреждениях, соответствующих 

профилю специальности. В соответствии с требованиями стандарта 

специальности и программой имеет конкретные цели, задачи, содержание, 

перечни заданий и др. 

Объект исследования в методике компьютерной графике в школе – 

дидактические системы и процессы, напр.: дидактическая система обучения 

отдельного педагога, дидактическая система отдельного учебного курса, 

система заданий и др.; процесс формирования определенных умений; 

процесс развития определенных качеств личности и др. 

Предмет методики преподавания компьютерной графике в школе – ее 

содержание и структура, процесс овладения работой на компьютере в 

компьютерных графических системах в условиях обучения при 

взаимосвязанной деятельности учителя и учащихся. Методику интересуют 

цели, задачи, содержание обучения предмету, деятельность учителя и 

учащихся и их диагностика и др. 

Задачи методики преподавания компьютерной графике в школе 

подразделяют на фундаментальные и прикладные. К числу 

фундаментальных задач относят: исследование процессов овладения 

учащимися графических редакторов, изучение закономерностей обучения, 

определение принципов и методов обучения компьютерной графике в школе, 

принципов отбора материала для изучения и др. Прикладные задачи 

определяются (по традиции) вопросами: чему учить?; как учить?; почему так, 

а не иначе? «Чему учить?» означает создание программ, учебников и других 

пособий, определяющих содержание обучения компьютерной графике в 

школе. 

В белорусских учреждениях общего среднего образования используют 

методические разработки Высоцкой С.В. учителя информатики 

высшейкатегории УО «Государственная гимназия №4 г. Витебска»; 

Климович Анна Федоровна – кандидат педагогических наук, доцент кафедры 

прикладной математики и информатики БГПУ; Казеко Эдуард Николаевич – 

учитель информатики средней школы № 2,  Брестская область, г. Иваново; 

Ларченко Александр Петрович, учитель информатики ГУО «Станьковская 
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средняя общеобразовательная школа имени Марата Казея», Дзержинского 

района, Минской области; Пашковская Виктория Викторовна – руководитель 

кружка, Центр внешкольной работы Октябрьского района, г. Минск другие 

авторские программы. 

Этапы и методы научных исследований в методике обучения 

компьютерной графике. 

Целью исследований в области методики обучения компьютерной 

графике является выявление закономерностей и особенностей обучения, 

разработка и внедрение в практику эффективных методов и приемов работы 

при изучении тем программы, разработка системы графических задач, 

технических средств обучения, рекомендаций, позволяющих улучшить 

работу учителей по совершенствованию графической подготовки 

школьников. 

 Учитель, повседневно встречающийся с учащимися, видит реакцию 

учителей и учащихся на программу, учебник, дидактические материалы и 

наглядные пособия. Это позволяет ему быстрее понять недостатки обучения, 

наметить пути их устранения. 

Многие будущие педагоги уже со студенческой скамьи занимаются 

элементами педагогических исследований: разрабатывают наглядные 

пособия, выполняют мультимедийные презентации к занятиям с 

использованием анимации и звука,  материалы для индивидуальных занятий, 

анализируют уровни графической подготовки школьников, выступают с 

докладами и сообщениями на научных студенческих конференциях. 

Процесс педагогического исследования можно условно представить в 

виде ряда взаимосвязанных этапов. На каждом из них стоят свои 

определенные задачи. 

Первый этап — выявление проблемы исследования на основе изучения 

литературы и практической работы учителей. 

При изучении литературных источников должно быть выявлено: 

o основная идея автора работы, его позиция по исследуемой проб-

леме;  

o чем отличается его позиция от традиционной, что нового внес он 

в изучение этой проблемы; 

o какие основные вопросы темы не нашля отражения в работе; 

o какие задачи встают по дальнейшему исследованию проблемы. 

o При ознакомлении с опытом работы учителей необходимо вы-

явить: 

o какие затруднения испытывает учитель; 

o причины затруднений и недостатков. 

Второй этап — построение гипотезы. Гипотеза — это предположение, 

например, того, что если в основу методики изучения учащимися темы 

положить поэтапный подход с учетом разделения учебных задач на 

предваряющие и основные.  То это будет способствовать преодолению 

трудностей при использовании и обеспечит более глубокое понимание уча-

щимися сущности этого графического изображения. 
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В процессе исследования гипотеза не остается неизменной. По мере 

накопления фактов, их сопоставления исследователь уточняет гипотезу, 

переходит к более обоснованной. 

Третий этап — проверка гипотезы и построение теории. Такая 

проверка осуществляется с помощью эксперимента с использованием 

различных методов научного исследования (см. ниже). 

Четвертый этап — оформление и внедрение результатов исследования. 

В практике исследования перечисленные этапы часто не располагаются 

в строгой, последовательности. Исследователь может возвращаться в 

процессе работы к начальным этапам, иногда могут следовать несколько 

этапов одновременно. 

Методы исследования. В методике обучения применяются как 

общенаучные, так и специальные методы исследования. К общенаучным 

относятся метод теоретического исследования, наблюдение, беседа, 

эксперимент и др. 

Теоретический метод состоит в основном в изучении литературы, 

анализе, и обобщении педагогического опыта. 

Работа над литературой начинается с составления списка подлежащих 

изучению произведений (библиография), включающего книги, журналы, 

статьи в сборниках, реферативные обзоры. При этом приходится обращаться 

к справочно-библиографическимука-зателям, библиотечным каталогам, 

информациям о выходящей литературе. 

Наблюдение основано на длительном восприятии, осуществляемом без 

вмешательства в педагогический процесс. Наблюдение может быть прямым 

(осуществляемом непосредственно на уроках) и косвенным (путем 

ознакомления с графическими работами, со школьной документацией). 

Наблюдение должно вестись по плану, иметь ясную цель и задачи. Например, 

если исследователю необходимо провести наблюдение за выполнением 

учащимися, идя на урок, нужно наметить вопросы. Наблюдение дает 

возможность увидеть происходящее только в данный момент. О работе, 

которую проводил учитель на предыдущих уроках, готовя учащихся к 

восприятию материала, наблюдения не дают представления. Ответы на 

вопросы, которые возникают при наблюдении, можно получить во время 

беседы. 

Беседы могут проводиться как с учащимися, так и с учителями. С 

учащимися беседы проводят тогда; когда необходимо понять ход мысли 

ученика. Результаты бесед тщательно фиксируются в виде протокола, сте-

нографической или магнитофонной записи, а затем подвергаются анализу. 

Анкетный опрос. В соответствии с поставленными целями иссле-

дователь формулирует вопросы, на которые учащиеся должны дать 

письменные ответы. Каждый из вопросов должен быть конкретным и 

понятным для опрашиваемых. 

Учащимся необходимо разъяснить цели опроса и порядок оформления 

ответов. Для большей объективности ответа фамилии ученики могут не 

указывать. 
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Для рассмотренных выше методов исследования характерно то, что 

исследователь не вторгается активно в учебный процесс. Он лишь наблюдает 

его, анализирует, делает выводы по содержанию учебного материала, о 

целесообразности применения тех или иных методов, организационных форм 

и т. д. Чтобы сделать обоснованные выводы по исследуемому вопросу, 

необходимо применение методов, которые позволяют исследователю 

активно влиять на учебно-воспитательный процесс. Рассмотрим некоторые 

из них. 

Эксперимент — это один из самых сложных и важных методов 

исследования, дающий возможность наблюдать педагогическое явление 

изолированно от побочных, несущественных факторов, в условиях, 

поддающихся контролю и учету. 

Эксперимент подразделяется на естественный и лабораторный. 

Естественным называют эксперимент, который проводится со всем классом 

на уроке. В зависимости от длительности его проведения различают 

экспериментальное обучение и экспериментальные уроки. 

Экспериментальное обучение проводится при проверке программ, учебников, 

формировании графических понятий. Это требует длительного времени и 

системы взаимосвязанных уроков. Экспериментальные уроки необходимы 

при проверке отдельных разделов, метода или приема обучения, 

эффективности использования учебных таблиц, моделей. 

Лабораторный эксперимент проводится обычно индивидуально или с 

небольшим числом учащихся и позволяет более тщательно проследить за 

работой учащихся.  

Наиболее распространенной формой подведения итогов эксперимента 

является сравнение результатов. Организация и выяснение эффективности 

эксперимента осуществляется следующим образом. В одном из классов (или 

нескольких) в учебный процесс вводится экспериментальный фактор, а в 

другом классе (или нескольких) он отсутствует. Эта система используется 

только в экспериментальном классе; по остальным параметрам, в том числе и 

графической подготовке, данный класс не должен отличаться от остальных 

(контрольных). 

Через определенное время в обоих классах проводят контрольные 

работы, позволяющие определить эффективность предложенной системы 

задач. 

В методике обучения наряду с общенаучными применяются и 

специальные методы исследования.  

К специальным методам относятся циклография — регистрация 

кинематики движений,  

тензометрия и пьезометрия — регистрация величины усилий, 

окулография — регистрация движений глаз,  

хронометраж — регистрация времени, 

 мультиплицирование — регистрация последовательности выполнения 

графических изображений и др. 
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Наиболее доступны для использования в практике работы хронометраж 

и мультиплицирование. Метод хронометража состоит в том, что с помощью 

хронометра (секундомера) производится регистрация времени, 

затрачиваемого на выполнение графической ра боты в целом или ее. 

отдельной части.   

Метод мультиплицирования состоит в том , что последовательность 

выполнения изображения фиксируется через определенные промежутки 

времени. Фиксация может производиться путем  сохранения этапов 

выполнения задания. Анализ такого поэтапного выполнения изображений 

позволяет получить данные, характеризующие знания, умения и навыки уча-

щихся. По ним можно легко проследить за ходом мысли ученика, выявить 

рациональную последовательность выполнения различных изображений и 

особенности их построения, проанализировать типовые ошибки и этапы, на 

которых они начинают допускаться. Фиксирование хода выполнения 

изображений может производиться и при помощи фотосъемки, киносъемки. 

Все рассмотренные методы исследования используются в основном на 

этапе построения и проверки выдвинутой гипотезы. 

Результаты исследований могут быть оформлены в виде докладов, 

статей, курсовых и дипломных работ. 

 

2.Краткий исторический обзор преподавания компьютерной графики. 

Взаимосвязь методики компьютерной графики с наукой информатики и 

другими науками (психологией, педагогикой, информатикой, культурологией и 

др.) и специальными художественными дисциплинами. 

Методика преподавания компьютерной графики основывается на 

научных данных педагогики, психологии, информатики как науки, 

культурологии, физиологии, таких философских наук как этика, эстетика и 

др. Практическую основу дисциплины составляют знания и умения, 

приобретаемые студентами в процессе изучения рисунка, живописи, 

композиции, цветоведения и др. 

Методика обучения компьютерной графики оформилась как 

самостоятельная область педагогической науки сравнительно недавно. 

Компьютерная графика как учебная дисциплина возникла благодаря учебной 

дисциплине информатике. Эта сравнительно молодая наука и связана с 

быстрым развитием науки и техники,  с появлением первых электронных 

вычислительных машин (ЭВМ) в нашей стране в начале 50-х гг. XX века. 

Вместе с этим получила бурное развитие новая область человеческой дея-

тельности — программирование для ЭВМ.  

«Основные направления реформы общеобразовательной и про-

фессиональной школы» 1984г. 

 Одним из главных положений школьной реформы, стала задача 

введения информатики и вычислительной техники в учебно-воспитательный 

процесс школы и обеспечения всеобщей компьютерной грамотности молодежи.  

Информатика как учебный предмет была введена во все типы средних 

школ бывшего СССР с 1 сентября 1985 г. Новая учебная дисциплина 
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получила название «Основы информатики и вычислительной техники» 

(ОИВТ). В общеобразовательной школе предмет преподавался в двух 

старших классах (тогда это были IX и X кл.) 

Область интересов информатики — это структура и общие свойства 

информации, а также вопросы, связанные с процессами поиска, сбора, хране-

ния, преобразования, передачи и использования информации в самых 

различных сферах человеческой деятельности. Обработка огромных объемов и 

потоков информации немыслима без автоматизации и систем коммуникации, 

поэтому электронные вычислительные машины и современные 

информационные и коммуникационные технологии являются и 

фундаментальным ядром, и материальной базой информатики. 

К середине 1970-х гг. была поставлена задача создания САПР (систем 

автоматического проектирования); в рамках САПР получила развитие идея 

создания автоматизированных рабочих мест (АРМ) конструкторов, научных 

работников, плановиков и т.п. Позднее получила широкое распространение и 

поддержку идея создания гибких автоматизированных производств (ГАП) и про-

мышленных роботов. 

Одной из областей человеческой деятельности, испытывающей в 

настоящее время активное влияние информатики, является система 

образования. Ветвь информатики, обслуживающая проблемы средней школы, 

получила название школьной информатики.  

Школьная информатика определяется как ветвь информатики, 

занимающаяся исследованием и разработкой программно технического, 

учебно-методического и организационного обеспечения применения ЭВМ 

в школьном учебном процессе. 

Учебно-методическое обеспечение школьной информатики состоит в 

разработке учебных программ, методических пособий для учебников по 

школьному курсу информатики, а также по школьным предметам, которые 

могут испытывать методологическое влиянии информатики. 

Описанные выше проектируемые результаты образовательно-

воспитательнрй деятельности школы могут быть сгруппированы в три основные 

общие цели, которые ставятся перед системой общего школьного образования: 

образовательные и развивающие цели; практические цели; воспитательные цели. 

Общие цели обучения информатике и компьютерной графике 

определяются с учетом особенностей информатики как науки, ее роли и места в 

системе наук, в жизни современного общества. Рассмотрим, как основные цели, 

характерные для школы в целом, могут быть отнесены к образованию 

школьников. 

Образовательная и развивающая цель обучения информатике  и компьютерной 

графике в школе — дать каждому школьнику начальные фундаментальные 

знания основ науки информатики и компьютерной графики, включая 

представления о процессах преобразования, передачи и использования 

информации. На этой основе раскрыть учащимся значение информационных 

процессов в формировании современной научной картины мира, а также роль 
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информационной технологии и вычислительной техники в развитии 

современного общества.  

 Вооружить учащихся теми базовыми умениями и навыками, которые 

необходимы для прочного и сознательного усвоения этих знаний, а также 

основ других наук, изучаемых в школе. Усвоение знаний из области 

информатики, Как и приобретение соответствующих умений и навыков 

призвано существенно влиять на формирование таких черт личности, Как 

общее умственное развитие учащихся, развитие их мышления и творческих 

способностей. 

Практическая цель школьного курса информатики компьютерной 

графики — внести вклад в трудовую и технологическую подготовку 

учащихся, т.е. вооружить их теми знаниями, умениями и навыками, которые 

могли бы обеспечить подготовку к трудовой  профессиональной 

деятельности  после окончания школы. Это означает, что школьный курс 

информатики и факультативный курс компьютерной графики должен не 

только знакомить с основными понятиями информатики, которые, 

безусловно, развивают ум и обогащают внутренний мир ребенка, но и быть 

практически ориентированным — обучать школьника работе на компьютере 

и использованию средств новых информационных технологий. 

В целях профориентации курс должен давать учащимся сведения о 

профессиях, непосредственно связанных с ЭВМ и информатикой, а также 

различными приложениями изучаемых в школе наук, опирающимися на 

использование ЭВМ. Наряду с производственной стороной дела 

практические цели обучения информатике предусматривают также и 

«бытовой» аспект — готовить молодых людей к грамотному использованию 

компьютерной техники и других средств информационных и 

коммуникационных технологий в быту, в повседневной жизни. 

Воспитательная цель школьного курса обеспечивается, прежде всего, 

тем мощным мировоззренческим воздействием на ученика, которое 

оказывает осознание возможностей и роли вычислительной техники и 

средств информационных технологий в развитии общества и цивилизации в 

целом. Вклад школьного курса в научное мировоззрение школьников 

определяется формированием представления об информации как одном из 

трех основополагающих понятий науки: веществе, энергии и информации, 

лежащих в основе строения современной научной картины мира. Кроме 

того, при изучении информатики на качественно новом уровне формируется 

культура умственного труда и такие важные общечеловеческие 

характеристики, как умение планировать свою работу, рационально ее 

выполнять, критически соотносить начальный план работы с реальным 

процессом ее выполнения. 

Школьный учебный предмет информатики и факультативный курс 

компьютерной графики не может включать всего того многообразия сведений, 

которые составляют содержание активно развивающейся науки. В то же время 

школьный предмет, выполняя общеобразовательные функции, должен отражать 

в себе наиболее общезначимые, фундаментальные понятия и сведения, 
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раскрывающие существо науки, вооружать учащихся знаниями, умениями, 

навыками, необходимыми для изучения основ других наук в школе, а также 

подготавливающими молодых людей к будущей практической деятельности и 

жизни в современном информационном обществе. 

Из всей совокупности методико-педагогических знаний и опыта, 

объединяемых методикой информатики, выделяется учебный предмет 

«Теория и методика обучения информатике», который согласно 

Государственному образовательному стандарту высшего 

профессионального образования входит в образовательно-про-

фессиональную программу подготовки учителя по специальности 

«Информатика» [5]. Впервые учебный курс «Методика преподавания 

информатики» был введен в учебные планы педвузов в 1985 г. в :нязи с 

организацией подготовки учителей по дополнительной специальности 

«Информатика» на базе физико-математических факуль-гетов [24]. В 1993 г. 

был сделан первый набор на учительскую специальность «Информатика» как 

основную (Омский педуниверситет [16]). С 1995 г. действует 

Государственный стандарт высшего педагогического образования по 

специальности «Информатика». В российских педвузах стала расширяться 

подготовка «профильных» учителей информатики. В то же время справедливо 

отмечалось, что в течение весьма длительного периода содержание 

методической подготовки 5удущего учителя информатики — наиболее 

слабая часть (и наиболее слабо обеспеченная часть) его профессиональной 

подготовки [15]. В настоящее время появились издания других учебных книг 

по методике информатики ([3] и др.), хотя в течение долгого времени 

кафедрам и студентам приходилось делать основной упор на перио-цику. 

Официальным ориентиром в методической подготовке будущих учителей 

информатики служат рекомендованные Министерством эбразования РФ 

примерные учебные программы (см., например, [33]). Содержание этого 

учебного предмета составляет рассмотрение эбщих теоретических основ 

методики преподавания информатики, совокупности основных программно-

технических средств, а также методов изучения конкретных тем школьного 

курса информатики на. пропедевтическом, базовом и профильном этапах 

обучения. Рассмотрению этих двух групп вопросов посвящены, 

соответственно, первая и вторая части настоящего пособия. 

Изучение процесса обучения опирается на родственные науки, и 

прежде всего на дидактику, психологию, педагогику, информатику. 

В методике рассматриваются частные вопросы теории обучения 

дидактике. Поэтому методики часто называют частными дидактиками. В 

свою очередь примеры, факты, исследования, накапливаемые в частных 

методиках, служат источником для дидактических обобщений. Таким 

образом, связь методики с дидактикой является взаимной. 

Связь психологией. Для рационального построения методики черчения 

при раскрытии ее рекомендаций необходимо опираться на имеющиеся 

теоретические положения, касающиеся ощущения, восприятия, памяти, речи, 

мышления. 
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Опытные учителя и методисты всегда стремятся понять, что 

происходит в сознании учащегося при усвоении знаний. Они хорошо 

понимают, что педагогическое воздействие учителя на учащихся и их 

ответные реакции тесно связаны с их психической деятельностью. Чтобы 

управлять этой деятельностью, надо знать ее законы, знать, как они 

проявляются у учащихся в различных ситуациях.                                            

Связь методики обучения компьютерной графики оформилась как 

самостоятельная область педагогической науки сравнительно недавно с 

психологией, так же как и с дидактикой, является взаимной. Опираясь, 

например, на материалы наблюдений, полученные в процессе формирования 

и развития графических знаний и умений учащихся, психологами сделаны 

многие важные выводы о формировании представлений, о приемах 

установления ассоциаций и их роли в формировании знаний школьников. 

Психология дает возможность учителю знать подготовленность 

ученика к восприятию и запоминанию материала, учитывать его 

индивидуальные особенности. 

Психология и педагогика помогают методике ответить на вопросы, 

почему так, а не иначе надо излагать данный материал, почему именно такие 

методические приемы будут в данном случае более эффективны. Психология 

указывает методике пути организации познавательной деятельности 

учащихся. В данном случае учитель может идти к достижению цели 

индуктивным путем — от конкретных фактов к обобщению. Процесс 

познания в этом случае идет от частного к общему.  

Возможен другой путь организации процесса познания — дедуктивный, 

т. е. когда учащиеся сначала знакомятся с общей характеристикой понятия, а 

затем оно конкретизируется. Особое значение для методики имеет связь с 

наукой, которая является основополагающей для учебного предмета ―, а 

именно, информатикой. 

Методика обучения должна учитывать перспективы развития науки, 

отбирать данные, составляющие содержание курса компьютерной графики  и 

отвечающие требованиям развития общества. Рассматривая связь методики 

обучения с другими науками, необходимо обратить внимание на логику. На 

основе ее законов в методике разрабатываются рекомендации относительно 

определений понятий, формулирования правил. Развитие методики как науки 

невозможно без логического осмысления научных фактов, без построения 

гипотез, без овладения другими логическими категориями. Методика также 

связана с методиками других учебных предметов. Ведь процесс 

формирования элементов графических знаний и умений у учащихся 

рассматривается при обучении математике, физике, географии, химии и 

других предметов, где используются графические изображения. 

Методика обучения черчению тесно связана с другими науками не 

только из-за общности целей и задач обучения в школе, но и в значительной 

степени из-за общности принципов, методов, форм и средств обучения. 

3.Организация факультативных занятий по компьютерной графике. Методы 

обучения. Дидактические принципы обучения. Подготовка учителя к уроку. 
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Обучение компьютерной графке  имеет свою специфику по ряду 

признаков, к которым, как уже отмечалось, относятся возрастные 

особенности учащихся, их жизненный и трудовой опыт, а следовательно, 

несравненно более сознательные мотивы учения, потребность в 

приобретении знаний. Поэтому, анализируя стоящие перед ним задачи, 

учитель должен для каждого планируемого урока продумать его 

оптимальную структуру, наиболее полноценно отвечающую целям, стоящим 

перед уроком. Предстоящий урок в большой степени зависит от того места, 

которое он будет занимать в ряду уже проведенных занятий, то есть в целой 

системе их, осуществляемой в течение учебного года, от уже достигнутого 

уровня знаний и практических навыков, от характера объема знаний, 

который еще предстоит изложить учащимся. При этом отель будет опираться 

на достаточно широкий кругозор своих учащихся, на возможности 

самостоятельного приобретения ими знаний или научнопопулярной и 

литературе. В педагогике рассматриваются различные типы уроков и 

различные формы изложения знаний учителем. Так, например, различают 

следующие типы уроков: 

а) урок изучения нового материала; 

б) урок закрепления знаний, умений и навыков; 

в) повторительно-обобщающий урок; 

г) объединенный, или комбинированный, урок. 

Применительно к урокам наиболее употребительной формой является 

так называемый комбинированный урок, где наряду объяснением учителя в 

качестве важной составной части выступает и проведение практической 

работы, как формы закрепления знаний. 

В тесной взаимосвязи со структурой уроков находятся вопросы ыбора 

метода обучения, то есть того способа сообщения знаний, который 

обеспечивает самые высокие результаты учебно-воспитаельного процесса. 

Истории и классификации методов обучения в педагогической литературе 

также уделено много внимания. 

Наиболее простая классификация различает словесные, наглядней 

практические методы. На уроках черчения к словесным метода можно 

отнести устное изложение учителем учебного материала форме лекции-

беседы, объяснение, сопровождающее на компьютере, а также 

самостоятельную работу учащихся. 

К наглядным методам относится демонстрация по ходу урока учебно-

наглядных пособий в виде плакатов, учебных таблиц, мультимедийных 

презентаций с поэтапным выполнением заданий, кино- и видеофильмов. 

Практические методы состоят в самостоятельном выполнении учащими 
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творческих задание с использованием умений и навыков работы на 

персональном компьютере,  различных графических упражнений, спо-

обствующих прочному закреплению полученных знаний и практических 

навыков. 

Может показаться, что первые два метода относятся непосредственно к 

учителю, тогда как третий - практические работы, выполяемые учащимися, - 

имеет прямое отношение к ним. Однако все методы обучения являются 

ведущим признаком двустороннего проесса - учитель - учащиеся. 

Практические работы учащихся и их выполнение их контролируются 

учителем, за которым остается ведущая роль организатора и руководителя 

обучения и воспитания. 

Отметим некоторые особенности выбора метода обучения с учетом 

специфики рассматриваемого нами предмета. Наряду с другими методами, 

рекомендуется такая форма изучения нового материала, как лекция-беседа. 

За этим несколько громоздким названием скрывается рассказ учителя, 

содержащий обильную информацию о задании. 

Чтобы внимание учащихся не ослабевало, учитель периодически 

прерывает свой рассказ вопросами к учащимся, касающимися только что 

изложенных им сведений. 

Не следует задавать вопрос "Все поняли?", потому что редко кто 

отважится признаться в своей некомпетентности. Лучше задавать кон-

кретные вопросы. При такой постановке вопроса учащимся придется 

задуматься и выбрать из своих предположений наиболее правильное. В этом 

случае прослеживаются контуры проблемно-поисковых ситуаций на уроке. 

Владение этим методом требует от учителя тщательного предварительного 

продумывания количества и содержания вопросов, которые можно поставить 

перед учащимися. Такое ведение урока способно обеспечить внимание 

учащихся и понимание нового материала, оно не позволяет отвлечься от 

содержания урока, но поощряет активное участие учеников в занятии. 

Вопросы можно задавать всему классу, но можно обратиться и к 

конкретному ученику. 

Это означает, что учитель в процесса урока не должен увлекаться 

собственным объяснением. Его задачей является непрестанный, 

систематический контроль внимания класса путем возбуждения ответных 

реакций, свидетельствующих о восприятии учащимися излагаемого, степени 

сознательности в его понимании, словом, учитель должен поддерживать 

обратную связь. 
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Практические задания учащихся включают в себя работу над 

упражнениями. Кроме этого они должны выполнять работы обязательного 

минимума, предусмотренного программой. 

Это делает программу по компьютерной графике чрезвычайно 

насыщенной и требует от учителя большого организационного и 

методического мастерства для достижения максимальной эффективности 

каждого отдельного урока. Возможности экономии времени при изучении 

материала, применения наиболее рациональных приѐмов при организации 

практических работ будут рассмотрены ниже рекомендациях по изучению 

конкретных тем курса. Все графические упражнения и практические работы 

должны выполнятся на компьютере в графических редакторах. 

Дидактические принципы обучения 

Вопросами организации обучения занимается дидактика.  

Дидактика - часть педагогики, разрабатывающая теорию образования и 

обучения (цели, содержание, закономерности и принципы обучения), а также 

воспитания в процессе обучения. 

Научные основы обучения находят свое выражение в дидактических 

принципах - руководящих положениях, определяющих ход образования и 

обучения в соответствии с целями и задачами воспитания и образования. 

Конечно, при этом учитываются закономерности процесса усвоения знаний, 

умений и навыков учащихся. 

Важнейшей задачей обучения является вооружение подрастающего 

поколения системой научных знаний. Учащиеся изучают основы наук, 

изложенные в учебных предметах. Объем, система знаний, изучаемых по 

каждому предмету, зависят от цели обучения, типа школы и возраста 

учащихся. Но отбор изучаемых фактов, понятий и закономерностей проводят 

полном соответствии с требованиями науки. Научное знание обучения 

возможно только в контексте предметной деятельности. 

Доступность обучения - эмпирическая характеристика 

индивидуальных способностей учащихся к усвоению информации, к 

выполнению учебных заданий, в том числе к запоминанию учебного 

материала, решению задач, выполнению различных типов контрольных 

работ и тестов и самоконтроля. 

В широком смысле слова доступность обучения представляет собой 

необходимое условие преподнесения учебного и научного материала для 

сознательного усвоения учащимися; учитель обязан побуждать учеников к 

преодолению посильных трудностей, активизировать их умственную 

практическую деятельность. 
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Систематичность обучения - овладение системой знаний как основы 

их сознательного и творческого применения. Принцип систематичности 

обучения предполагает последовательное изложение учебного материала, 

когда все сообщенные учителем новые понятия логично вытекают и 

основываются на хорошо усвоенных ранее знаниях. Система знаний, 

базирующаяся на хорошей связи нового материала с пройденным, 

демонстрирует учащимся общую стержневую идею учебного материала. 

Связь с практикой и жизнью - обеспечение глубокого усвоения 

научных знаний и формирование навыков их практического применения. Это 

предпосылка и результат не только собственно трудовой деятельности 

учащихся, но и познавательных процессов, регулирующих поведение и 

направленность мышления. Потребность учащихся в такой связи 

обусловлена процессом их воспитания в широком смысле, то есть процессом 

приобщения к миру человеческой культуры, представленной как предметно 

(материальные потребности), так и функционально (духовные ценности). 

Сознательность и активность - обучение учащихся при руководящей 

роли учителя. Знания не могут быть вложены в готовом виде в голову 

учащихся, но являются результатом их собственной познавательной 

деятельности, осуществляемой под руководством учителя. 

Сознательность обучения - осознанное отношение к обучению, 

реализуемое через осмысление собственных действий и их резуль-итов в 

соответствии с целями и мотивами обучения. 

Активность обучения - самостоятельность при усвоении знаний, а 

также овладение приемами умственной деятельности, что обеспечивает 

саморегуляцию учебной деятельности. 

Наглядность обучения - чувственная основа для овладения 

Атрактными понятиями. Следует отметить, что понятие "наглядность" 

связано не с самими предметами (к примеру, с деталями ма-вин и прочим), а 

с их графическими изображениями. Всякое вображение, чертеж представляет 

собой чувственно, через органы зрения, воспринимаемый предмет. Поэтому 

наглядность рассматри-пся как свойство изображения вызывать в голове 

человека зри-№ный образ моделируемых на чертеже признаков объекта. 

Прочность усвоения знаний - обеспечение длительного сохранения в 

памяти системы основных узловых понятий, их постепенное уг-убление 

путем самостоятельного применения на практике. Можно вделить два 

фактора, влияющих на прочность усвоения знаний: 

-особенности самого материала, подлежащего запоминанию: 

пболее осмысленной и значимой для учащихся является инфор-нация, 

тем лучше она запоминается и держится в памяти; 
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- повторение, позволяющее увеличивать время обработки 

попупающего в память материала. При повторе запоминание  легче 

включаются в систему ассоциативных связей,образующих память. 

Коллективность обучения - оптимальное сочетание обучения ^уппы 

учащихся с его индивидуализацией. 

Коллективность учащихся в обучении - взаимодействие и их 

ваимоотношения, связанные с целями, задачами и ценностями деятельности.                    

Индивидуальный подход - важный психолого-педагогический принцип, 

согласно которого учитываются индивидуальные особенности каждого 

ученика.                                   

Межпредметные связи – взаимная, согласованность учебных 

программ, обусловленная системой наук и дидактическими целями. 

Пространственное представление - это способность представления о 

пространственных и пространственно-временных свойствах и отношениях: 

величине, форме, относительном расположении объектов, их поступательном 

и вращательном движении и т.д. Пространственное представление - 

необходимая способность познания и всей практической деятельности, 

особенно профессионально-технической. Степень обобщенности и 

схематизации образа зависит от освоения человека воспроизводить 

пространственные свойства объектов в различной графической форме (в виде 

рисунка, чертежа, схем, символической записи и т.д.). 

Пространственное представление - это первая стадия в развития 

технического мышления, которая является необходимой предпосылкой 

научно-технической,  изобразительно-художественной и многих других 

видов деятельности, связанных с конструктивным мышлением и 

техническим творчеством.  

Пространственное воображение - психический процесс, 

заключающийся в создании новых образов путем переработки 

предшествующего познавательного процесса восприятия, которое 

способствует свободному манипулированию закрепленных в памяти 

представлений об объектах. 

Пространственное воображение принято подразделять на вос-

создающее и творческое. 

Воссоздающее воображение - процесс создания образа предмета по его 

описанию, рисунку или чертежу. 

Творческое воображение - процесс самостоятельного создания новых 

образов. Оно требует отбора материалов, необходимых для построения 

образа в соответствии с собственным замыслом. 
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Итак, пространственное воображение - это более высокий (по 

сравнению с пространственным представлением) фактор развитого 

технического мышления. 

Оба эти фактора тесно связаны с восприятием и образ мышлением. 

Восприятие - чувственно-наглядное отражение пространенных свойств 

вещей (их величины и формы. В восприятии пространства участвуют все 

органы чувств человека. Ведущая роль в восприятии надлежит совместной 

деятельности зрительного, двигательного и осязательного анализаторов. 

Восприятие становится избирательным в зависимости о т конкретной 

задачи, поставленной перед человеком. 

Образное мышление - один из основных видов выделяемый наряду с 

наглядно-действенным и словесно-логическим мышлением. Образы-

представления выступают как важ продукт образного мышления. 

Творческое воображение - совокупность способностей, позволяющий 

получить продукт деятельности, который отличается новизной; высоким 

совершенством и общественной значимостью, формирование и развитие 

творческого воображения в условиях школы на занятиях по компьютерной 

графике огромной степени зависит от целенаправленной работы, собности и 

слаженности системы "учитель - ученик". 

Для художника самое сложное при изучении компьютерной графики - 

это начальный этап. Происходит переход с обычных форм рисования на 

новый, компьютерный уровень. И чтобы начать творить в новых условиях, не 

сдерживаясь техническими сложностями, необходимо многое преодолеть и 

изучить. Нужно посмотреть на сам процесс творчества другими глазами, где-

то изнутри преодолеть себя. Именно художнику, человеку творческому, 

приходится наиболее трудно при изучении некоторых технических 

особенностей, связанных с работой на компьютере. Ведь здесь нужно не 

только рисовать, используя разнообразные инструменты, но и знать, как 

сохранить полученный рисунок, перенести его на различные накопители, 

загрузить нужные объекты или фрагменты. Необходимо знать разные 

цветовые модели и возможности их применения, широкий спектр 

инструментов создания и редактирования изображений, в частности, 

фильтры, маски, многообразие функций, предназначенных для создания 

спецэффектов, уметь работать с несколькими слоями, использовать 

инструменты моделирования и ряд других технологий. Не всем учащимся 

удается легко справиться с этим материалом. 

Для некоторых юных художников компьютер так и останется чужеродным и 

неподходящим для творческого процесса, им доступнее традиционные 

средства. 

Есть ребята, которые, наоборот, настолько хорошо понимают компьютер, что 

созидание на виртуальной поверхности становится для них естественным. 

Такой подход к компьютерной графике дает возможность в дальнейшем 
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продуктивно работать по художественным специальностям. В современном 

мире таких специальностей много, и запрос на художников, 

профессионально владеющих компьютером, постоянно растет. 

Еще одной возможностью по восприятию компьютера является совмещение 

компьютерного и традиционного творчества. Это поможет настоящему 

художнику воплощать свои идеи в любом виде изобразительного искусства. 

Главное - сам процесс творчества, без которого он не может существовать. 

Важно быть профессионалом в том виде творчества, которым владеешь, и 

создавать произведения, достойные называться настоящим искусством. 

Процесс творческого поиска безграничен, и юные художники, используя 

новые компьютерные технологии, идут в ногу со временем. 

Подготовка учителя к уроку. 

 Педагог как организатор и руководитель учебного процесса. 

Учитель изобразительного искусства и компьютерной графики должен 

владеть передовыми технологиями, направленными на творческое 

саморазвитие личности учащихся, осознанное приобретение ими личного 

опыта понимания и переживания искусства, навыков изобразительной 

деятельности. 

Искусство преподавания требует и знания самого предмета, и усвоения 

основных положений педагогики, психологии, физиологии, и понимания 

закономерностей методики организации учебно-воспитательного процесса, и 

умения творчески использовать все эти знания в практике преподавания. 

Педагогическое мастерство приходит не сразу, а в процессе 

ежедневного кропотливого труда. Учителю необходимо постоянно работать 

над собой, овладевать новыми методиками, изучать передовой опыт. 

Преподавание становится искусством, когда педагог проявляет интуицию, 

умеет перестроить учебный процесс в связи с неожиданно возникшей 

ситуацией, творчески подходит к делу. 

Современные технологии развития личности учащегося на занятиях 

компьютерной графики включают организацию образовательного 

пространства художественными средствами, создание эмоционально-

благоприятной атмосферы на уроке, психологическую поддержку, 

диалогичность общения учителя с учениками, ценностное отношение к 

личностному опыту учащегося в изобразительной деятельности и др. 

Уроки изобразительного искусства имеют огромное значение в 

развитии у детей художественного вкуса. Для этого учителю необходимо 

знакомить учащихся с основными принципами эстетики, использовать 

шедевры изобразительного искусства, а в практической работе следить за 

тем, чтобы рисунки, вылепленные фигурки и выполненные декоративные 

изделия соответствовали критериям красоты. 

Для профессионально-педагогической готовности учителя ему 

необходимы качества творческого мышления, так как практические задачи, 

которые решает учитель в ходе своей педагогической деятельности, являются 

задачами комплексными и многосторонними. При их решении учителю 

важно принимать во внимание все многообразие условий, образующих 
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конкретную ситуацию деятельности. Поэтому перенос теоретических знаний 

в практику не является прямым; он включает в себя ряд переходных звеньев, 

которые интегрируются вокруг определенной практической проблемы, 

имеющей целостный и многосторонний характер, и переводится на язык 

практических действий учителя. Творчески мыслящий учитель умеет в 

случае необходимости быстро переключиться с одного способа действий на 

другой, разнообразить способы обучения, быстрее находить новые пути 

решения разного рода учебно-воспитательных задач, контролировать и 

оценивать процесс и результаты мыслительной деятельности учащихся. На 

уроках учитель осуществляет прямое и косвенное руководство 

познавательной и творческой деятельностью учащихся: демонстрирует 

наглядный материал, рассказывает, объясняет, показывает приемы работы, 

создает проблемные ситуации, наблюдает и контролирует самостоятельную 

работу детей и др. 

Реализация метода проектов и исследовательского метода на практике 

ведет к изменению позиции учителя. Из носителя готовых знаний он 

превращается в организатора познавательной, исследовательской 

деятельности своих учеников. Изменяется и психологический климат в 

классе, так как учителю приходится переориентировать свою учебно-

воспитательную работу и работу учащихся на разнообразные виды 

самостоятельной деятельности учащихся, на приоритет деятельности 

исследовательского, поискового, творческого характера. 

Преподавание изобразительного искусства в школе требует методики 

обучения, отвечающей основным принципам дидактики. Как бы ни 

строилась концепция или авторская программа, какие бы методы при этом ни 

использовались, в процессе обучения учащийся должен усвоить знания, 

умения и навыки в единой, последовательной системе. 

Основная задача преподавания компьютерной графики в школе — 

развитие творческого потенциала личности, эмоциональности, духовности, 

приобщение школьников к искусству через теоретические знания и 

практическую деятельность, их эстетическое воспитание. 

При подготовке учителя к занятиям по компьютерной графике 

выполняются практические занятия: выполняется календарно-тематический 

иллюстрированный план на учебный год обучения, с соблюдением 1-4 

четверти, каникул, с учетом календарных праздников; выполняется 

развѐрнутый план -конспек факультативного занятия и мультимедийная 

презентация с поэтапным выполнением творческого задания. 

Примерная схема плана-конспекта комбинированного урока 

факультативного занятия по компьютерной графике 

 Класс 

 Тема факультативного занятия: 

 Тип урока: (комбинированный, овладения новыми знаниями, 

формирования умений и практических навыков, контрольные уроки и др.). 

Тип урока определяется исходя из дидактической цели 
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 Вид деятельности: (изображение на плоскости, лепка, декоративно-

прикладная деятельность и др.). 

 Цель урока: 

Важно обращать внимание на реализуемость и достижение целей  

 Задачи урока:  

- Обучающая (знания, которые ученики должны получить по теории и 

истории изобразительного искусства, формирование умений и навыков 

непосредственно на этом занятий в объеме, предусмотренном программой); 

- Развивающая (развитие творческих способностей, зрительной памяти, 

образного мышления, воображения и т.д.; технических навыков работы с 

различными материалами и инструментами и др.). 

- Воспитывающая (формулируется с учетом возможного характера 

деятельности на уроке (планируется на раздел, тему, блок занятий, четверть, 

год). Это может быть воспитание эстетических чувств, художественного 

вкуса, любви к своему краю, и т.д., а также воспитание аккуратности, 

усидчивости, самостоятельности и т.д.). 

Оборудование урока:  

 для педагога_______ 

 для учащихся______ 

 Оформление классной доски. 

 План урока 

(План урока зависит от формы его презентации) 

1.Организационный этап (1-2мин) 

2. Сообщение нового материала (от 5-10 мин) 

3. Практическая художественно-творческая деятельность учащихся 

(индивидуальная работа с учениками, работа по предупреждению, 

выявлению, дифференциации и исправлению ошибок учеников; реализация 

методов по активизации художественно-творческой деятельности) 20 -25 мин  

4. Анализ и оценка результатов художественно-творческой 

деятельности учеников (до 5 мин.) 

5. Задание на дом (по компьютерной графике домашнее задание 

задается в форме посмотреть, подобрать, понаблюдать, принести материал и 

т.д.) 1-2 мин  

 

Ход урока: 

При описании хода урока, даѐтся подробный, развѐрнутый материал 

каждого раздела плана урока. 

Пример иллюстрированного календарно-тематического плана. 
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Лекция 2. Теория и методика изучения основных тем графических 

редакторов растровой, векторной графики для школьников 6 класса 

 План лекции: 

1. Принципы и средства работы с растровой, векторной графикой.  

2. Графический редактор Paint 

3. Рисование в Word,  

4. Создание мультимедийной презентации в программе Microsoft 

Power Point.  

 

Целью начального курса для учащихся 5-6 классов использование 

графических программ растровой и векторной графики и программы для 

создания презентаций, использование анимации и вставка звука. 

 Переход от настоящих кистей и карандашей к компьютерным 

происходит не всегда сразу. Для этой работы требуются другие навыки, 

поджидают сложности. Знания, полученные на уроках рисования, умение 

видеть цвет, правильно воспроизводить форму и компоновать изображение 

помогают в освоении нового аспекта творчества. Поэтому вначале 

чужеродная для юного художника "мышь" вскоре превращается в вол-

шебную кисточку с удивительно разнообразными возможностями. 

Юный художник, вступающий в мир компьютера, переходит на другой 

тип рисования. Монитор для него - лисг бумаги, "мышка" - это его карандаш. 

Очень важно не отпугнуть ребенка слишком новыми и непривычными 

способами рисования. Подходящей программой для перехода с обычного 

рисования на виртуальное является графический редактор Именно РС 

позволят свободно рисовать, предлагая разнообразные приемы и не 

обременяя начинающих излишними компьютерными возможностями. Изучая 

эту профамму, ребенок понимает, что на компьютере можно рисовать, но по-

новому занимательно. Виртуальный лист оказывается не просто бумагой, а 

волшебной поверхностью, обладающей различными текстурами, которыми 

можно управлять, меняя параметры. Компьютерная бумага может быть 

шероховатой, как торшон, гладкой, похожей на поверхность картона, или 

выдавленной причудливыми текстурами. И по такому необычному листу 

дети творят, создавая интересные образы. 

Впервые проведенная линия на мониторе компьютера разочаровывает 

своей неуверенностью и неловкостью по сравнению с привычной уверенной 

линией на листе бумаги. Но необыкновенно широкая возможность выбора 

компьютерных "кистей" заставляет детей пробовать все новые и новые вари-

анты, незаметно тренируя и набивая руку на работу с "мышью". Ребята про-

буют совершенно особые приемы, раскрывая необыкновенные возможности 

компьютерных "кисточек" и воплощая свои новые идеи. Здесь кисти разно-

цветные, любой толщины, формы и типа. И каждой так хочется порисовать. 

Дети забывают, что в их руках "мышь", они попадают в знакомую среду 

творческого созидания и поиска. Пейзажи и натюрморты, иллюстрации и 

фантастические композиции, все создается по-новому. 
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Следующие задания, такие, как рисование с помощью геометрических 

форм, копирование, работа с объектом, ввод различных шрифтов, уже не от-

талкивают своей необычностью, а привлекают ребят. С огромным интересом 

юные художники создают юмористические иллюстрации с использованием 

градиентных заливок и текста. 

Чем больше компьютерная "мышка" находится в руках юного 

художника, тем интереснее и смелее становятся рисунки, создаваемые им. 

Ребенок рисует раскрепощенно, хорошо представляя свою цель и добиваясь 

ее различными графическими способами. Живописные размывки, 

всевозможные эффекты, сложные заливки - все становится необходимым в 

работе. 

1. Принципы и средства работы с растровой, векторной графикой. 
Кодирование графической информации . 

Современный компьютер является прекрасным средством для работы с 

графическими изображениями. Области применения компьютерной графики 

также весьма разнообразны: деловая, научная, конструкторская, 

художественная, рекламная графика и др.  

В настоящее время для создания и хранения графических объектов в 

компьютере используются два принципа представления изображений: 

растровые и векторные изображения.  

С растровыми изображениями мы уже знакомились, когда создавали 

рисунки с помощью графического редактора Paint. 

Понятие растр означает разложение изображения на отдельные точки с 

помощью специальной сетки. Метод создания изображения из отдельных 

точек появился задолго до изобретения компьютеров. Например, мозаика или 

вышивание основываются на использовании отдельных небольших 

элементов, из которых создается рисунок. 

Растровое изображение - это совокупность отдельных точек-пикселей, 

каждый из которых имеет свой цвет (Ошибка! Источник ссылки не 

найден.). 

Приемы рисования при создании растровых изображений очень похожи 

на работу художника, рисующего кистью или карандашом. Растровая 

графика используется для создания оригинальных живописно-графических 

произведений, обработки фотографий, видеоизображений и др. 

Для создания и редактирования графических растровых изображений 

используются различные графические редакторы: Paint, Adobe Photoshop, 

Macromedia Director и др.  

Технология построения векторных изображений отличается от растровых 

изображений. В векторном графическом изображении каждый нарисованный 

элемент-примитив называется объектом. Каждый такой объект имеет вполне 

определенный перечень значений свойств, которые описывают этот объект. 

Разберем это на следующем примерах. 

Информация о нарисованной в векторном изображении линии хранится в 

следующем виде:  

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 32 

 начало линии - точка на координатной плоскости (x,y), длина линии, 

направление, в котором линия должна быть нарисована; 

 значения, определяющие цвет, ширину и тип линии (сплошная, 

пунктирная и др.).  

Таким образом, для описания линии необходимо иметь семь значений, т.е. 

определить семь свойств объекта. На первый взгляд такой подход является 

весьма громоздким. Однако, этих значений свойств достаточно для описания 

линии любого размера, цвета и толщины. 

В отличие от линии окружность имеет свой набор основных значений 

свойств: 

 координаты центра окружности (x, y), радиус окружности;  

 значения ширины контурной линии, цвета контура, типа линии 

контура окружности;  

 цвет заливки внутренней области, ограниченной окружностью.  

Таким образом, векторное изображение – это совокупность 

математических опорных значений свойств простых объектов изображения 

(Ошибка! Источник ссылки не найден.).  

Векторная графика применяется для создания расчетных чертежей, 

сложных графических композиций и издательских макетов, компоновки 

изображений, является основным инструментом дизайнера. 

Графические редакторы, в которых используется векторная графика: Corel 

Draw, Adobe Illustrator, Macromedia Flash, возможности для рисования в 

текстовом редакторе Word и др.  

Пользователю для выбора графического редактора для работы 

необходимо знать преимущества и недостатки растровой и векторной 

графики, которые мы приведем в таблице: 

Растровая графика Векторная графика 

1. Для сохранения растрового 

изображения необходим большой объем 

памяти, так как размер памяти зависит от 

размера изображения. При увеличении 

изображения в 2 раза, размер файла 

может увеличиться в 4 раза. 

1. Для сохранения векторного 

изображения требуется небольшой 

объѐм памяти, и он не зависит от 

размера рисунка. 

 

2. Растровое изображение плохо 

поддается трансформации, происходит 

его искажение. 

2. Векторное изображение легко 

поддается трансформации, качество 

изображения не изменяется. 

 

 

 

 

 

 

 

3. Растровое изображение быстро 3. Векторное изображение долго 
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выводится на дисплей компьютера и на 

принтер. 

выводится на дисплей компьютера и на 

принтер, так как для вывода оно 

преобразуется в растровое изображение. 

Различие в представлении растровых и векторных изображений 

существует лишь для графических файлов. При выводе на экран дисплея 

компьютера любого изображения, в видеопамяти компьютера формируется 

информация растрового типа.  

Графические редакторы, работающие с растровыми или векторными 

изображениями, решают следующие основные типовые задачи:  

 создание графических изображений; 

 редактирование графических изображений; 

 сохранение графических изображений в файле на диске; 

 загрузка графического изображения из файла на диске на экран 

монитора; 

 вывод графического изображения на принтер. 

Вам уже известно, что компьютер может обрабатывать информацию 

только в числовой форме, которая представлена в виде двоичного кода. 

Каждому символу текстовой информации ставится в соответствие двоичный 

код. Рассмотрим, каким образом кодируется графическая информация.  

При выводе на экран дисплея компьютера изображения растрового или 

векторного типов, в видеопамяти компьютера формируется информация 

растрового типа. Эта информация состоит из двоичных кодов каждого 

пикселя. Код пикселя — это информация о его цвете.  

Если на черно-белое изображение наложить сетку и каждой ячейке 

черного цвета поставить в соответствие 1, а белого цвета – 0, то можно 

создать матрицу изображения из нулей и единиц. Например, для растрового 

изображения буквы И, матрица изображения представлена на Рис. Ошибка! 

Текст указанного стиля в документе отсутствует..1. 

       1 0 0 0 0 0 1 

       1 0 0 0 0 1 1 

       1 0 0 0 1 0 1 

       1 0 0 1 0 0 1 

       1 0 1 0 0 0 1 

       1 1 0 0 0 0 1 

       1 0 0 0 0 0 1 
Рис. Ошибка! Текст указанного стиля в документе отсутствует..1 

Для черно-белого изображения информационный объем пикселя равен 

одному биту. Чем больше цветов в изображении, тем больше битов 

понадобиться для кодирования одной точки  

Количество цветов Количество бит для кодирования цвета 

2
2
=4 цвета 2 бита 

2
3
=8 цветов 3 бита 

2
4
=16 цветов 4 бита 

2
8
=256 цветов 8 бит (1 байт) 
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2
16

=65536 цветов 16 бит (2 байта) 

2
24

=16777216 цветов 24 бит (3 байта) 

2
32

=4294967296 цветов 32 бит (4 байта) 

На экране монитора цвет пикселя изображения формируется смешением 

трех цветовых лучей: красного (red - англ. слово), зеленого(green – англ. 

слово) и синего (blue – англ. слово), поэтому при кодировании цветных 

изображений используется специальная модель RGB.  

Например, для кодирования шестнадцатицветной палитры изображений 

используется следующая кодировка для цвета: 

Бит яркости 

цвета 

R

ed 

Gre

en 

Bl

ue 
Цвет 

0 0 0 0 черный 

0 0 0 1 синий 

0 0 1 0 зеленый 

0 0 1 1 голубой 

0 1 0 0 красный 

0 1 0 1 розовый 

0 1 1 0 коричневый 

0 1 1 1 серый 

1 0 0 0 темно-серый 

1 0 0 1 ярко-синий 

1 0 1 0 ярко-

зеленый 

1 0 1 1 ярко-

голубой 

1 1 0 0 ярко-

красный 

1 1 0 1 ярко-

розовый 

1 1 1 0 ярко-желтый 

1 1 1 1 белый 

Качество двоичного кодирования изображения определяется 

разрешающей способностью экрана монитора и глубиной цвета.  
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Любое графическое изображение на экране монитора состоит из строк, 

которые содержат определенное количество пикселей. Чем больше строк 

размещается на экране монитора и чем больше в каждой строке размещено 

пикселей, тем выше разрешающая 

способность экрана монитора, а 

соответственно и качество графического 

изображения. Современные компьютеры 

имеют различные разрешающие 

способности: 800x600, 1024x768, 1280x1024 

точки. Разрешение экрана и количество 

цветов может быть изменено. Для этого в 

контекстном меню Рабочего стола нужно 

выбрать Свойства затем вкладку Параметры 

(Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..2).  

Глубина цвета определяется количеством 

битов, используемых для кодирования цвета 

пикселя.  

В файле на диске с графическим растровым изображением хранится 

информация о цвете каждого пикселя изображения, а векторного 

изображения – опорные значения свойств простых элементов изображения, 

которые необходимы для его построения.  

Коротко о главном 

 Для создания и хранения графических объектов в компьютере 

используются два принципа представления изображений: растровые и 

векторные изображения.  

 Растровое изображение - это совокупность отдельных точек-пикселей, 

каждый из которых имеет свой цвет. 

 Векторное изображение – это совокупность математических опорных 

значений свойств простых объектов изображения.  

 Графические редакторы решают следующие основные типовые задачи:  

 создание графических изображений; 

 редактирование графических изображений; 

 сохранение графических изображений в файле на диске; 

 загрузка графического изображения из файла на диске на экран 

монитора; 

 вывод графического изображения на принтер. 

 При выводе на экран дисплея компьютера любого изображения, в 

видеопамяти компьютера формируется информация растрового типа. Эта 

информация состоит из двоичных кодов каждого пикселя. Код пикселя — это 

информация о его цвете.  

 Качество двоичного кодирования изображения определяется разрешающей 

способностью экрана монитора и глубиной цвета.  

 В файле на диске с графическим изображением растрового типа, хранится 

информация о цвете каждого пикселя изображения, а векторного изображения – 

 
Рис. Ошибка! Текст 

указанного стиля в документе 

отсутствует..2 
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опорные значения свойств простых элементов изображения, которые 

необходимы для его построения.  

1. Назовите области применения компьютерной графики. 

2. Какие два принципа представления графических изображений 

используются в компьютерной графике? 

3. Из чего состоит растровое изображение? 

4. Что представляет собой векторное изображение? 

5. Чем отличается растровое изображение от векторного изображения? 

6. Перечислите преимущества и недостатки растровой и векторной 

графики. 

7. Назовите графические редакторы для работы с растровой и векторной 

графикой. 

8. Графические изображения какого типа выводятся на экран монитора? 

9. Почему при кодировании цветных изображений используется 

специальная модель RGB? 

10. Приведите примеры кодирования цвета изображения. 

11. От чего зависит качество двоичного кодирования изображения на 

экране монитора? 

12. Что понимается под разрешающей способностью экрана монитора и 

глубиной цвета? 

13. Как в файле на диске хранятся растровые и векторные изображения? 

Упражнения. 

1. Создайте матрицу из нулей и единиц следующего черно-белого 

изображения: 
а) 

           

           

           

           

           

           

           

           

           

           

б)  

          

          

          

          

          

          

          

          

          

          

2.Приѐмы и методы работы в графическом редакторе Pаint. Создание 

простых графических изображений с помощью примитивов. Редактирование 

графических изображений. Операции с графическими изображениями. 

Шрифт. Вставка и редактирование изображений. 

3.Создание простых векторных графических изображений  

Многие подготовленные пользователем документы выглядят более 

привлекательными, если в них размещены графические изображения.  

В текстовом редакторе Microsoft Word для создания векторных 

графических изображений предлагается панель Рисование (Рис. Ошибка! 

Текст указанного стиля в документе отсутствует..3). 
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Рис. Ошибка! Текст указанного стиля в документе отсутствует..3 

Для вывода на экран панели Рисование необходимо выполнить в 

текстовом редакторе Word следующую команду: меню Вид → Панели 

инструментов → Рисование, или нажать кнопку  на панели инструментов 

Стандартная.. 

Назначение некоторых основных инструментов панели Рисование, 

используемых для создания простых векторных графических изображений 

представлены в таблице:  

Инструме

нт 

Назначение 

инструмента для 

рисования 

Инструме

нт 

Назначение 

инструмента для 

рисования 

 
Линия 

 
Вид стрелки 

 

Стрелка 
 

Тип штриха 

 
Прямоугольник 

 
Тип линии 

 

Овал 
 

Цвет линии 

Рисование линий, прямоугольников, овалов и других основных фигур с 

помощью панели Рисование текстового редактора Word аналогично 

рисованию в графическом редакторе Paint, при этом цвет, тип линии, тип 

штриха и вид стрелок может быть сформирован после создания основного 

объекта. 
Рисование основных фигур 

При выборе на панели Рисование любой фигуры на экране появляется Полотно 

– область для создания рисунка. После этого достаточно кликнуть мышью в 

любой области Полотна для получения изображения рисунка. Любая фигура, 

находящаяся на полотне является объектом. Местоположение объекта и его 

размеры могут быть изменены пользователем в любой момент времени, 

независимо от наличия и местоположения других объектов. Для изменения 

размеров у любого объекта имеются ключевые точки (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..4). При наведении указателя 

мыши на ключевую точку, он изменит вид на стрелку, указывающую как можно 

изменить размер. 
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Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..4 

Пример 1. Нарисуем овал (Этап 1), чтобы его выделить, щелкнем по нему 

левой кнопкой мыши, выберем цвет (Этап 2), выберем тип линии (Этап 3) и тип 

штриха (Этап 4). 

 

  

 

 

 

 

 

Этап 1 Этап 2 Этап 3 Этап 4 

 
Рис. Ошибка! 

Текст указанного 

Ключевые 

точки 
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При использовании инструмента Прямоугольник при 

нажатой клавише Shift, строится квадрат, а инструмента 

Овал – круг. 
Использование автофигур. 

Панель Рисование предоставляет пользователю 

возможность создавать различные Автофигуры (Рис. 

Ошибка! Текст указанного стиля в документе 

отсутствует..5). Меню Автофигуры содержит несколько 

категорий фигур: Линии, Основные фигуры, Фигурные 

стрелки, Блок схемы, Звезды и Ленты и др. 

В свою очередь в каждой категории автофигур содержится большое число 

различных объектов, которые пользователь может нарисовать (Рис. Ошибка! 

Текст указанного стиля в документе отсутствует..6). 

Линии Соединительные линии 

  
Основные фигуры Фигурные стрелки 

  
Блок-схема Звезды и ленты 

  

Рис. Ошибка! Текст указанного стиля в документе отсутствует..6 

Рисование многих автофигур аналогично рисованию основных фигур, 

расположенных на панели Рисование. Сначала выберем автофигуру, затем 

кликнем мышью по Полотну. После меняем (если надо) цвет, толщину и тип 

линии, местоположение и размер автофигуры. Однако для работы с 

некоторыми автофигурами используются свои методы. 
Использование кривых и ломаных линий 

Инструменты для рисования кривых и ломаных линий расположены в 

разделе Линии меню Автофигуры (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..7).  

стиля в документе 

отсутствует..5 
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Рис. 

Ошибка! 

Текст 

указанного 

стиля в 

документе 

отсутствует..7 

Инструмент Полилиния позволяет нарисовать ломаную линию или 

многоугольник. Клик мышью по полотну определяет положение очередной 

вершины. Если последний клик совпадет по местоположению с первым, то 

получим многоугольник – замкнутую ломаную линию. (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..8) 

Инструмент Кривая позволяет создать линию, аналогичную ломаной, но с 

«закругленными углами». (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..9) 

Для рисования линий «карандашом» используется инструмент Рисованная 

кривая. ( Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..10) 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..8 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..9 

 

Рис. Ошибка! Текст 

указанного стиля в 

документе 

отсутствует..10 

Любую незамкнутую линию можно замкнуть, а любую замкнутую – 

разомкнуть. Соответствующие команды есть в контекстном меню линии. 

Кривая, Полилиния и Рисованная кривая состоят из узлов – вершин и 

сегментов – линий соединяющих две вершины. Отредактировать линию 

можно выполнив команду Начать изменение узлов (в контекстном меню 

линии или в меню Действия). После этой команды линия примет вид как на 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..11. 

Кривая 

Полилиния (Ломаная) 

Рисованная кривая 
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Каждая точка является узлом. В контекстном меню узла (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..12) находятся команды, 

которые позволяют удалять и добавлять узлы, а также менять вид узла. 

Гладкий узел позволяет «скруглить угол». Угловой узел используется для 

пересечения линий под произвольным углом. Сегмент тоже имеет свое 

контекстное меню (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..13).  

 
Рис. Ошибка! Текст 

указанного стиля в 

документе 

отсутствует..11 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..12 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..13 

Пример 2. Нарисовать листик. Для рисования используем Полилинию, 

которая вначале опишет контур изображения (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..14, а). Добавим 

дополнительные узлы и изменим положение некоторых имеющихся (Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..14, б), а затем 

каждый узел, кроме самого верхнего, сделаем гладким (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..14, в), сегменты автоматически 

становятся искривленными. Можно рисовать листик, используя инструмент 

Кривая, а затее подправить положение и количество узлов. Можно 

нарисовать листик сразу, используя Рисованную кривую, однако для этого 

надо обладать навыками художника. 
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 а) б) в)  

Рис. Ошибка! Текст указанного стиля в документе отсутствует..14 

Использование соединительных линий 

Существует три типа соединительных линий (Атофигуры → 

Соединительные линии), используемых для соединения объектов: прямые, 

уступом и скругленные.  

 
Рис. Ошибка! Текст 

указанного стиля в 

документе 

отсутствует..15 

После выбора соединительной линии при перемещении указателя мыши 

по объектам, на объектах отображаются синие места 

соединения (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..16). Эти точки обозначают места, 

к которым можно прикрепить соединительную линию.  

Концы не прикрепленной соединительной линии имеют 

зеленые маркеры. При прикреплении конца 

соединительной линии к объекту конец линии 

блокируется, и маркер становится красным (Рис. Ошибка! 

Текст указанного стиля в документе отсутствует..17). 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..17 

При изменении положения соединенных объектов соединительные линии 

остаются прикрепленными к объектам и перемещаются вместе с ними. При 

перемещении одного из концов соединительной линии этот конец 

освобождается и открепляется от объекта. После этого он может быть 

прикреплен к другому месту соединения на том же объекте, либо 

заблокирован на другом объекте.  

 
Рис. Ошибка! 

Текст указанного 

стиля в 

документе 

отсутствует..16 

Прямая соединительная линия 

Соединительная линия уступом  

Скругленная соединительная линия 
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Соединительная линия уступом имеет желтый маркер, потянув за который 

можно изменить вид линии. После изменения положения соединенных 

объектов может потребоваться спрямление некоторых соединительных 

линий, позволяющее добиться кратчайших соединений и избежать 

пересечений. Команды, позволяющие менять вид соединительной линии и 

спрямлять соединения находятся в контекстном меню соединительной 

линии.(Рис. Ошибка! Текст указанного стиля в документе отсутствует..18) 

 
Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..18 

Пример 3. Изобразить на блок-схеме команду цикла. Этапы создания 

показаны на (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..19) 

 
Рис. Ошибка! Текст указанного стиля в документе отсутствует..19 

Вставка надписи. 

В созданные простые векторные графические объекты может быть вписан 

текст.  

Пример 4. Нарисуем ленту, выбрав ее в автофигурах Звезды и ленты,. 

Затем выполним последовательность действий: 

1. Выделите объект (например, лента), внутри которого будет 

располагаться текст.  

2. Выполните: меню Вставка→Надпись. 

Этап 1 Этап 2 Этап 3 

Этап 5 Этап 4 
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3. Щелкните левой кнопкой мыши по выделенному объекту (например, 

ленте). 

4. Введите нужный текст (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..20).  
 

С Днем Рождения! 
 

 
Рис. Ошибка! Текст указанного стиля в документе отсутствует..20 

Если созданный графический объект по какой-либо причине нас не 

устраивает, его можно удалить. Для этого необходимо: 

1. Выделить объект, который следует удалить.  

2. Нажать клавишу DEL или BS. 

К вставленным графическим объектам могут быть применены различные 

действия: изменение размеров и цвета, вращение, отражение, а также 

комбинирование с другими фигурами. Многие из этих операций мы 

рассмотрим в дальнейшем. 

Коротко о главном 

 В текстовом редакторе Microsoft Word для создания векторных 

графических изображений используется панель Рисование. 

 Для создания простых векторных графических объектов на панели 

Рисование размещаются следующие инструменты: Линия, Стрела, 

Прямоугольник, Овал. Кроме этого, создаются различные Автофигуры: Линии, 

Соединительные линии, Основные фигуры, Фигурные стрелки, Звѐзды, Ленты и 

др. 
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Упражнения. 

1. Используя известные вам инструменты панели Рисование, создайте 

следующие рисунки: 

а)  

 

б)  

в)  

2. Нарисуйте блок-схему и впишите в каждый блок текст.  
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Да Нет 

Начало 

Внизу 

линия? 

Робот в верхнем 
левом углу 

Вправо 

Клетки закрашены 

Конец 

Да 

Нет 

Справа 

линия? 

Вниз 
Закрасить 

 

Заливка векторного графического изображения  

Для создания цветных рисунков в текстовом редакторе Word на панели 

Рисование используется инструмент Заливка . Заливать цветом можно 

только замкнутые области рисунка. 

Рассмотрим основные виды заливок векторных 

графических изображений на конкретном примере. 

Нарисуем с помощью кривой линии листок (Рис. Ошибка! 

Текст указанного стиля в документе отсутствует..21): 

панель Рисование Автофигуры → Линии → Кривая и 

выполним разные виды заливок и изменим цвет контура 

листка. 

Заливка в векторной графике может быть различных видов: 

равномерная, градиентная, текстурой и узором. 

Для заливки листочка рассмотрим последовательность выполняемых 

действий: 

1. Выделите листок с помощью щелчка левой кнопкой мыши по его 

изображению (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..21). 

2. Выполните: панель Рисование→Цвет заливки→ выберите цвет, 

  
Рис. Ошибка! 

Текст указанного 

стиля в 

документе 

отсутствует..21 РЕ
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например, травяной (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..22). 

В результате выполненных действий листок станет залит выбранным 

цветом цвета (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..23). 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..22 

  

Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..23 

Для заливки или изменения цвета контура векторного изображения 

могут использоваться другие цвета заливки и цвета линий из обычной 

палитры цветов или из спектра (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..24). 

Обычный расширенный набор цветов Спектр цветов 

  

Рис. Ошибка! Текст указанного стиля в документе отсутствует..24 

Различные способы заливки векторных изображений предлагает 

градиентная заливка. Для ее использования выполняется цепочка действий: 

панель Рисование → Заливка → Способы заливки → вкладка 

Градиентная заливка: заливка в один цвет (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..25), заливка в два цвета (Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..26), заливка 
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заготовка (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..27). 

 

  
 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..25 

 

  
 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..26 

 

   
 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..27 

Открыв вкладку Текстуры в окне Способы заливки, можно выбрать 
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еще один оригинальный способ заливки, например, зеленый мрамор (Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..28). Панель 

Рисование предлагает 24 варианта текстуры: циновка, мрамор, бумага, 

ткань, дерево и т. д. За исключением текста, применять текстуру можно к 

любому объекту. 

 

  

Рис. Ошибка! Текст указанного стиля в документе отсутствует..28 

 

  
 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..29 

Еще один способ заливки – выполняется при выборе вкладки Узор в 

окне Способы заливки (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..29). Панель Рисование предлагает более 40 

двухцветных узоров для различных графических объектов. 

Коротко о главном 

 Для создания цветных рисунков в текстовом редакторе Word на 

панели Рисование используется инструмент Заливка, а для 
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изменения цвета контура изображения или цвета линий 

используется инструмент Цвет линии.  

 Заливка в векторной графике может быть различных видов: 

равномерная, градиентная, текстурой, узором. 

1. Какие инструменты на панели Рисование используются для заливки и 

изменения цвета контура векторного графического изображения ?  

2. Какие виды заливки могут использоваться векторной графике ? 

Упражнения. 

1. Нарисуйте листья и, используя различные виды заливки, разукрасьте 

их, как показано на рисунках.  

  

 

 

  

 

 

  
   

 
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2. Нарисуйте и раскрасьте пейзаж. Этапы создания пейзажа показаны на рисунке. 

 

 

3. Определите какие автофигуры использовались для создания рисунка. Какие способы заливки 

применили? 
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Операции над векторными графическими изображениями 

Основные операции над графическими векторными изображениями: 

копирование, вырезка, вставка, удаление и перемещение выполняются также 

как и для текстовых фрагментов. Единственное различие — это выделение 

графического объекта, которое выполняется простым щелчком левой кнопки 

мыши по этому объекту. 

Для облегчения работы с отдельными графическими объектами 

используются дополнительные операции: группирование и разгруппирование 

графических объектов. 

Группирование графических объектов – это объединение нескольких 

графических объектов в одну целостную группу.  

Группирование графических объектов упрощает работу с ними. 

Сгруппированные графические объекты перемешаются, вращаются, 

отражаются, а также пропорционально или непропорционально изменяют 

свои размеры точно так же, как единый объект. 

Например, для создания кувшина необходимо иметь три фигуры: 

квадрат, круг и трапеция (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..30). Для того, чтобы выполнять операции над целым 

предметом (кувшином) надо сгруппировать фигуры, из которых он должен 

состоять. Для этого необходимо: 

1. Постройте новый объект (например, кувшин), составляя фигуры, из 

которых его надо сложить. 

2. Удерживая нажатой клавишу Shift, выделите объекты (например, круг, 

квадрат и трапеция), из которых уже составлен новый объект. 

3. Сгруппируйте выделенные объекты: панель Рисование→ Действия → 

Группировать.  
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Рис. Ошибка! Текст указанного стиля в документе отсутствует..30 

После выполнения операции группирование, графическое изображение 

кувшина становится целостным объектом. 

Операцию обратную группированию называют разгруппированием. 

Разгруппирование графических объектов - это разделение одного 

графического объекта на несколько отдельных объектов. 

Для разгруппирования объекта, состоящего из частей необходимо: 

1. Выделить объект. 

2. Выполнить: панель Рисование→ Действия → Разгруппировать.  

При создании сложных графических изображений используют большое 

количество различных объектов. Если предположить, что каждый объект 

нарисован на отдельном листе прозрачной пленки, то весь рисунок будет 

напоминать стопку сложенных друг на друга листов прозрачной пленки. Так 

же как листы пленки можно перекладывать в стопке, можно менять порядок 

размещения графических объектов и текста на рисунке.  

Например, предположим, что нам необходимо на рисунке прикрыть о 

солнце облаком (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..31), т.е. его надо расположить поверх солнца. Для этого 

необходимо сделать следующее: 

1. Выделить объект, выносимый на передний план (например, облако). 

2. Выполнить: панель Рисование→Действия→ Порядок→На 

передний план (рис. 4.21). 
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Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..31 

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..32 

Выделенные объекты можно размещать на заднем плане: панель 

Рисование→Действия→Порядок→На задний план. Таким образом, 

рисунки в документе можно располагать в несколько слоев.  

Кроме этого, выделенный графический объект можно 

поместить перед текстом или за текстом (Рис. Ошибка! 

Текст указанного стиля в документе отсутствует..33). Для 

изменения относительного положения текста и рисунков 

используйте: панель Рисование→Действия→Порядок→ 

Поместить перед текстом или Поместить за текстом. 

Графические изображения с помощью панели 

Рисование можно поворачивать, отражать, а также свободно вращать с 

помощью последовательности действий над выделенным объектом (Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..35 – Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..36): панель 

Рисование → Действия → Повернуть /отразить → выберите Повернуть 

влево, Повернуть в право, Отразить слева направо, Отразить сверху 

вниз (Рис. Ошибка! Текст указанного стиля в документе отсутствует..34). 

 
Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..34 

Чтобы повернуть объект на любой угол необходимо: 

1. Выделите поворачиваемый объект. 

 
 

Рис. Ошибка! 

Текст 

указанного 

стиля в 

документе 

отсутствует..33 
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2. Выполните: панель Рисование → Действия → Повернуть/отразить → 

Свободное вращение. Вокруг графического изображения появятся 

четыре зеленых опорных точки (Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..36).  

3. Поместите указатель мыши на одну из опорных точек, чтобы он 

превратился в круговую стрелку, и нажмите левую кнопку мыши. 

4. Начните вращение объекта, удерживая нажатой левую кнопку мыши, 

когда указатель примет вид четырех стрелок, расположенных по кругу.  

Вращение можно выполнять в любую сторону. Во время вращения объекта 

пунктиром обозначается его текущее положение. 

Отражения слева направо 

и сверху вниз. 

Повернуть влево, отразить слева направо, 

свободное вращение. 

 
 

Рис. Ошибка! Текст 

указанного стиля в документе 

отсутствует..35 

 
Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..36 

 

 

 

Коротко о главном 

 Основные операции над графическими векторными изображениями: 

копирование, вырезка, вставка, удаление и перемещение 

применяются одинаково как к тексту, так и к графике.  

  Для облегчения работы с отдельными графическими объектами 

используются дополнительные операции: группирование и 

разгруппирование графических объектов. 

 Группирование графических объектов – это объединение нескольких 

графических объектов в одну целостную группу.  

 Разгруппирование графических объектов - это разделение одного 

графического объекта на несколько отдельных объектов. 
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 При создании сложных графических изображений часто используют 

слои. Применение слоев очень удобно для организации порядка 

размещения графических объектов и текста. 

  Графические изображения с помощью панели Рисование можно 

поворачивать, отражать, а также свободно вращать. 

1. Какие действия можно выполнить с графическими изображениями. 

2. Как выполняются копирование, вырезание, вставка и перемещение 

графического изображения? 

3. Как сгруппировать и разгруппировать графические объекты? 

4. Для чего используются слои? 

5. Каким образом выполняется вращение графического изображения. 

6. Какие действия необходимо выполнить, чтобы отразить рисунок 

слева направо или сверху вниз? 

Упражнения. 

1. Используя автофигуры выполните рисунки. К этим рисункам 

примените различные виды заливок, копирование, вставку, поворот, 

отражение. Выполняйте все действия по этапам.  

а)

    

  

  

    

 
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б) 
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Настройка изображений и добавление тени к графическому 

объекту  

Многие графические изображения можно настраивать, изменяя их 

яркость, контрастность, цветовую гамму. В текстовом редакторе Word это 

осуществляется с помощью панели Настройка изображения.  

Вывод на экран этой панели производится после выполнения 

следующей последовательности действий: меню Вид → Панели 

инструментов → Настройка изображения (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..37).  

 
Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..37 

Рассмотрим настройку изображения на конкретном примере картины с 

зимним пейзажем (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..38). 

 
Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..38 

Для того, чтобы настроить изображение его необходимо сначала 
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выделить. С помощью последовательности действий: панель Настройка 

изображения →  Цвет →Оттенки серого можно сделать изображение с 

оттенками серого цвета (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..39), Черно-белое - черно-белым изображением (Рис. Ошибка! 

Текст указанного стиля в документе отсутствует..40) или Подложка - 

сделать изображение светлым, малоконтрастным для использования в 

качестве «водяных знаков» (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..41). 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..39 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..40 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе отсутствует..41 

Контрастность изображения можно увеличить или уменьшить 

следующим образом: панель Настройка изображения → Увеличить 

контрастность (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..42) или Уменьшить контрастность (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..43) 

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..42 

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..43 

На панели Настройка изображения также возможно Увеличить 

яркость изображения  (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..44) или Уменьшить яркость изображения  
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(Рис. Ошибка! Текст указанного стиля в документе отсутствует..45). 

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..44 

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..45 

Чтобы удалить часть рисунка с какой-либо стороны, целесообразно 

воспользоваться последовательностью действий: панель Настройка 

изображения →Обрезка  (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..46). 

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..46 

В текстовом редакторе Word существует возможность добавления тени к 

любому графическому объекту, а также изменения размера, направления и 

цвета тени. Изменение цвета тени не влияет на цвет самого объекта. При 

вращении объекта с тенью, тень автоматически подстраивается под новое 

положение объекта.  

 � 
Рис. Ошибка! Текст указанного стиля в документе отсутствует..1 
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Для добавления тени к графическому 

объекту необходимо его выделить, а затем 

выполнить следующую 

последовательность действий: панель 

Рисование → Стиль тени  и выбрать 

один из готовых видов тени (Рис. Ошибка! 

Текст указанного стиля в документе 

отсутствует..47) 

Выбрав пункт меню Настройка тени (Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..47) пользователь может настроить тень с 

помощью открывающегося окна Настройка тени и, если необходимо, 

изменить цвет тени.(Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..48) 

 
Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..48 

Коротко о главном 

 Инструменты панели Настройка изображения в текстовом редакторе 

Word позволяют устанавливать оттенки серого и черно-белого цвета, 

яркость и контрастность изображения, выполнять его обрезку. 

 В текстовом редакторе Word существует возможность добавления 

тени к любому графическому объекту, а также изменения размера, 

направления и цвета тени. 

 
Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..47 
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1. Для чего используется панель Настройка изображений? 

2. Как сделать изображение черно-белым? 

3. Какие изменить контрастность и яркость изображения? 

4. Каким образом обрезается изображение? 

5. Как добавить тень к графическому объекту с помощью панели 

Рисование?  

6. Как можно менять положение тени от объекта и изменять ее цвет? 

Упражнения. 

1. Вставьте в документ Word готовую фотографию розы, измените 

настройку этой фотографии. 

   

Готовая фотография 

розы 

Применить оттенки 

серого 

Применить черно-белое 

   
Увеличить 

контрастность 

Применить подложку Уменьшить яркость 

2. Нарисуйте и дополните объекты тенью. 

 
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Выполнение конструирования из графических объектов  

В текстовом редакторе Word на панели Рисование в меню Автофигуры 

пользователю предлагается дополнительный набор рисунков, который называется 

Другие фигуры. Некоторые из этих рисунков представлены в таблице.  

 
Офисный стул  

 

Офисный стул с 

подлокотниками  

 

Стул для гостей 

 

Двухместный диван 

 

Диван 

 

Письменный стол 

прямоугольной 

формы 

 

Угловой письменный 

стол  
 

Угловой письменный 

стол  2 

 

Настольная лампа 

 

Дверь 

 

Шкаф для документов 

 

Шкаф для бумаг  
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Торшер 

 

Персональный 

компьютер  

 

Телефон  

 

Растение 

К дополнительным рисункам в автофигурах может применяться 

инструмент Заливка и изменяться цвет контура (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..49).  

   

 
Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..49 

Из представленного набора рисунков Дополнительные фигуры можно 

конструировать размещение мебели в жилой комнате или офисе (Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..50).  

  

  
Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..50 

Составленные рисунки комбинируются с картинками или рисунками из 

файлов, что делает документы более привлекательными. 

Чтобы придать фигуре трехмерный вид, на панели Рисование 

предлагается кнопка Объем. При ее использовании круги и овалы 

превращаются в цилиндры или конусы, а прямоугольники — в бруски. 

Объемные фигуры можно вращать, чтобы менять перспективу. Для имитации 

объема к рисункам добавляются дополнительные цвета и заливка. 
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Рассмотрим создание объемной фигуры на примере кольца.  

1. Нарисуем кольцо с помощью последовательности действий: панель 

Рисование →Автофигуры → Основные фигуры →Кольцо.  

2. Выделим это кольцо и с помощью кнопки Объем выберем 

необходимый для нас стиль объема (Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..51). 

Объем, который мы установили для фигуры, может быть настроен с 

помощью дополнительной панели Настройка объема (Рис. Ошибка! Текст 

указанного стиля в документе отсутствует..52).  

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..51 

 
Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..52 

Возможности панели Настройка объема представим в таблице. 

  
  

  

Кольцо для настройки объема 
Выключить/включить объем  Повернуть вниз 

  
    

Повернуть вверх Повернуть влево  Повернут вправо 

      

 Глубина  Направление Цвет 
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 Поверхность, каркас 

 

Коротко о главном 

 В текстовом редакторе Word на панели Рисование в меню 

Автофигуры пользователю предлагается дополнительный набор 

рисунков, который называется Другие фигуры. Из этого 

представленного набора рисунков можно конструировать 

размещение мебели в жилой комнате или офисе. 

 Для придания фигуре трехмерного вида на панели Рисование 

используется специальная среда Объем. Объемные фигуры можно 

вращать, чтобы менять перспективу. Для имитации объема к 

рисункам добавляются дополнительные цвета и заливка. 

1. Какие возможности для конструирования предоставляет 

пользователю набор рисунков Другие фигуры?  

2. Как с помощью панели Рисование придать фигуре объемный вид? 

3. Как осуществлять вращение трехмерных изображений? 

 

Упражнения. 

1.Нарисуйте план комнаты офиса, используя панель Рисование → 

Другие фигуры и уже изученные инструменты: Линии, Основные фигуры.  

  

2 .Выполните объемные конструкторские композиции. 

 
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Вставка фигурного текста 

Приложение WordArt предназначено для создания фигурных текстов. Для 

вставки фигурного текста необходимо выполнить команду Вставка → 

Рисунок Объект WordArt (Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..53). Далее выбрать стиль надписи из предложенных.  

 
Рис. Ошибка! Текст указанного 

стиля в документе 

отсутствует..53 

 
Рис. Ошибка! Текст указанного стиля 

в документе отсутствует..54 

В новом окне Изменение текста WordArt ввести текст надписи (Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..54). При работе 

с WordArt открывается дополнительная панель, с помощью которой можно 

производить изменение объекта WordArt. 

 
Рис. Ошибка! Текст указанного стиля 

в документе отсутствует..55 

 

Пример 3. Написать с помощью WordArt фразу «С Днем Рождения».  

1. Выполняем команду Вставка → Рисунок Объект WordArt 

2. Выбираем понравившийся стиль 

3. Пишем текст «С днем рождения» 

4. Устанавливаем шрифт, размер шрифта и начертание. 

5. Результат:  

Вставка объекта 

WordArt 

Изменение стиля  Изменение формы 

Работа с текстом  
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Вставка рисунков 

Word позволяет вставлять различные рисунки: 

 Рисунки, хранящиеся на диске в графических файлах. 

 Рисунки из коллекции картинок. 

 Рисунки со сканера или камеры. 

 Рисунки, созданные с помощью инструментов панели Рисование. 

Кроме того, вставить рисунок можно, пользуясь буфером обмена. Для этого в 

любой программе выделяем фрагмент рисунка и выполняем команду 

Копировать. Затем возвращаемся в Word и 

выполняем команду Вставить. 

В текст документа может быть вставлен рисунок, 

созданный в любом графическом редакторе, 

например в Paint, и хранящийся на диске в виде 

файла. Для этого нужно выполнить команду 

Вставка →РисунокИз файла. Затем указать 

имя файла. Рисунок будет вставлен в позицию 

курсора. 

Для вставки рисунка со сканера или камеры, эти 

устройства должны быть подключены к 

компьютеру. 

Рассмотрим подробнее работу с коллекцией 

рисунков. 

Для вставки рисунка из коллекции картинок 

нужно выполнить следующую команду: Вставка 

→ Рисунок  Картинки… В правой части 

экрана (в области задач) откроется панель (Рис. 

Ошибка! Текст указанного стиля в документе 

отсутствует..56) 

Затем нужно выбрать внизу команду Коллекция 

картинок и выбрать подходящую коллекцию. 

Коллекция картинок Microsoft поставляется вместе с Microsoft Office (Рис. 

Ошибка! Текст указанного стиля в документе отсутствует..57). Для 

вставки картинку в документ Нужно выполнить команду Копировать, а затем 

вернуться в документ и выполнить команду Вставить. При желании, 

пользователь может удалять и добавлять картинки, а также создавать свои 

коллекции. 

 
Рис. Ошибка! Текст 

указанного стиля в 

документе 

отсутствует..56 РЕ
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Рис. Ошибка! Текст указанного стиля в 

документе отсутствует..57 

Удобным способом подбора картинок для иллюстрации документа, является 

Поиск. Для осуществления поиска нужно ввести ключевое слово в окно 

Искать текст, а затем нажать кнопку Поиск.  

Пример 4. На Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..58 вы видите введенное для поиска слово «ребенок» и результат 

поиска на Рис. Ошибка! Текст указанного стиля в документе 

отсутствует..59. Рисунок, найденный с помощью поиска вставляется в текст 

щелчком мыши. 

 
Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..58 

 
Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..59 

Форматирование объектов 

Для форматирования объекта, вставленного в документ необходимо 

выполнить команду Формат →Объект или Формат →Рисунок. Эту же 

команду можно выбрать из контекстного меню объекта (рисунка). Откроется 

окно Формат объекта (рисунка).  
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Рис. Ошибка! Текст указанного 

стиля в документе отсутствует..60 

Вкладка Цвета и линии позволяет настраивать цвет заливки и линий. С ее 

помощью можно изменить, например, цвета стилей фигурного текста 

WordArt или фон рисунка из коллекции Microsoft Office. 

Вкладка Размер позволит изменить размер объекта: задать нужный размер в 

сантиметрах или в процентах относительно исходного размера. Изменять 

размер рисунка можно с помощью мыши. Для этого нужно установить 

указатель мыши на границе рисунка и, удерживая нажатой левую клавишу 

мыши, увеличить или уменьшить размер рисунка (объекта). 

Вкладка Положение позволит определить положение объекта в документе: 

установить обтекание объекта текстом и выравнивание относительно текста. 

Положение «в тексте» размещает объект как символ текста. 

Рассмотрим различные положения рисунка (объекта) относительно текста: 

Пример 1: Формула в тексте: 

Таким образом, по формуле q
pp

x 









2

22
 можно находить корни 

приведенного квадратного уравнения. 

Пример 2: Обтекание рисунка «Вокруг рамки» (по правому краю). 

В. Быкаў. Альпійская балада 

Яны спусціліся па схіле ад верхяй мяжы лугу да яго 

сярэдзіны. Тут мак трохі пачаў расступацца, даючы месца 

настырнаму багаццю іншых кветак. Сям-там сінелі лапікі 

буйных духмяных незабудак, калыхаліся на ветры званочкі, 

ад густога водару жоўтай азаліі п’янела ў галаве. Мясцінамі 

ў кветкавых чаўобах трапляліся жарстявыя плешыны, 

тырчалі з травы шэрыя камяні, каля іх заўжды было многа 

калючага шчэбню, ѐн шкодзіў ступням.  

Пример 3: Обтекание рисунка «По контуру». 

 

 

А. С. Грин. Алые паруса. 

– Не знаю, сколько пройдет лет, – только в Каперне расцветет одна сказка, 

памятная надолго. Ты будешь большой Ассоль. Однажды утром в морской 
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дали под солнцем сверкнет алый парус. Сияющая 

громада алых парусов белого корабля двинется, рассекая 

волны, прямо к тебе. Тихо будет плыть этот чудесный 

корабль, без криков и выстрелов; на берегу много 

соберется народу, удивляясь и ахая; и ты будешь стоять 

там.  

Вкладка Рисунок позволяет настроить яркость и контраст 

изображения. 

Коротко о главном 

 Текстовый редактор Word позволяет вставлять в текст документа символы 

из кодовой таблицы и такие объекты как: фигурный текст, формулы и 

рисунки. 

 Все объекты вставляются в позицию курсора. 

 К объектам в документе можно применить форматирование.  

- Как вставить символ из кодовой таблицы в текст документа? 

- Как создать формулу? 

- Как выполнить надпись фигурным текстом? 

4. Создание мультимедийных презентаций в программе Microsoft Power Point. 

Методы создания презентации с использованием размѐтки слайда и шаблона. 

Изменение цветовой схемы слайда. Вставка текста. Создание анимационных 

эффектов презентации. Принципы использования шрифтовой композиции 

WordArt при оформлении слайдов. Смена слайдов.  Показ слайдов. 

Гиперссылки. Звук. Просмотр слайдов. 
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Лекция 3. Методика изучения графических редакторов растровой 

графики для школьников 7 класса. Принципы  работы с растровой 

графикой Adobe Photoshop. 

ОСНОВНЫЕ ВОЗМОЖНОСТИ ADOBE PHOTOSHOP CS 5 

И ЭЛЕМЕНТЫ ЕГО ИНТЕРФЕЙСА 

Графический редактор Adobe Photoshop CS 5 предназначен для 

создания и редактирования растровых изображений. Он используется для 

работы с фотографиями, рисованными изображениями, слайдами.  

Adobe Photoshop с успехом используют художники-графики, 

дизайнеры, фотохудожники и обычные преподаватели для создания 

растровых изображений, их ретуши, цветовой и тоновой коррекции, 

повышения резкости и создания художественных эффектов. 

Для запуска графического редактора можно воспользоваться 

пиктограммой программы  на Рабочем столе или выполнить команду: 

Пуск → Программы → Adobe Photoshop CS 5. 

Рассмотрим назначение основных элементов окна программы (рис. 1). 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Рис. 1. Рабочее окно Adobe Photoshop CS 5: 

1 – заголовок программы; 2 – строка меню; 3 – панель настройки выбранного инструмента; 

4 – панель инструментов; 5 – рабочая область;  

6 – строка состояния; 7 - палитры 

Строка меню содержит команды работы с основным окном 

графического редактора и рисунками. 

Панель инструментов – это панель, которая содержит изображения 

инструментов и групп инструментов. Каждая группа обозначается 

треугольником в нижнем правом углу изображения. Открывают группу 

щелчком правой клавишей мыши по кнопке группы. Конкретный инструмент 

выбирают щелчком левой клавишей мыши по нему. 

1 
2 

3 

4 

5 

6 

7 
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Панель настройки выбранного инструмента (Панель опций) позволяет 

настраивать отдельные инструменты, например, выбирать способ заливки.  

В строке состояния отображаются значения следующих параметров: 

масштаб изображения, размер документа, объем памяти. 

Рабочая область изображения (холст) – это место размещения 

графических изображений. 

Палитры – наборы различных свойств, параметров и операций, которые 

в дальнейшем можно будет применить к изображению. 

Для создания нового документа выполняют команду Файл → Новый 

(File → New), в результате которой открывается новый файл, где необходимо 

установить нужный размер, положение листа, разрешение изображения, цвет 

фона, цветовую модель, можно задать имя файла (рис. 2). После установки 

всех необходимых параметров нажимают кнопку ОК. 
 

 

Рис. 2. Диалоговое окно создания нового документа 

 

Для загрузки файла с рисунком выполняют последовательность 

действий: Файл → Открыть → Имя файла → Открыть (File → Open → Name 

→ Open). Далее находят нужный каталог (папку), в котором должен 

храниться файл с рисунком, а затем открывают этот файл, отыскав его по 

имени среди других файлов. 

Сохранение файла с рисунком является действием, обратным загрузке, 

выполняется в такой последовательности: Файл → Сохранить как… (File → 

Save as…). В окне сохранения файла требуется указать имя файла с рисунком 

и выбрать один из типов файла: PSD или JPG, затем нажать кнопку 

Сохранить (Save). 

РАБОТА С ПАЛИТРОЙ ЦВЕТ (COLOR) 

 

Палитра Цвет (Color) предназначена для смешивания и выбора цвета и 

обычно располагается в правой части окна. Чтобы загрузить  (выключить) 

палитры Цвет (Color), Образцы (Swatches), Палитра цветов (Color Picker), 

выполняют команду Окно → Цвет (Window → Color). 

Цвет в палитре Цвет (Color) (рис. 1) можно выбрать двумя способами: 

1) передвинуть ползунки рядом с конкретным цветом; 
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2) щелкнуть в нижней части панели с градиентом образцов, расположенной 

внизу палитры. 

 
 

Рис. 1. Палитра Цвет (Color) 

 

Палитра Образцы (Swatches) (рис. 2) используются в том случае, если 

нужно выбрать готовые цвета. В нее можно добавлять или удалять отдельные 

образцы. Команды меню этой палитры позволяют также  загрузить, 

присоединить или сохранить палитры цветов, созданные пользователем. 

 

 
Рис. 2. Палитра Образцы (Swatches) 

 

Чтобы открыть панель Палитра цветов (Color Picker) (рис. 4), где также 

можно выбрать цвет, щелкают один раз по квадратику фонового или 

основного цвета на панели инструментов (рис. 3). 

 

 
 

Рис. 3. Элементы управления цветом  

на панели инструментов 

 

ИНСТРУМЕНТЫ РИСОВАНИЯ 

 

 

 

 

 

 

 

 

Рис. 1. Инструменты рисования 

Щелкнув мышью по кнопке Кисть (Brush 
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Tool)  на панели инструментов, можно выбрать один из инструментов: 

Кисть (Brush Tool) или Карандаш (Pencil Tool) (рис. 1). Инструмент Кисть 

(Brush Tool) имеет больше параметров, поэтому в дальнейшем мы будем 

рассматривать только его. 

Чтобы выбрать тип кисти, щелкните по стрелке в поле Кисть (Brush 

Tool) на панели настройки выбранного инструмента (рис. 2). Число под 

каждой пиктограммой обозначает ширину кончика кисти в пикселах, 

щелкните мышью где-либо вне панели. 

 

 

 

 

 

 

 

 

 

 

 

Рис. 2. Панель настройки инструмента Кисть (Brush Tool) 

В поле Непрозрачность (Opacity) можно определить степень 

непрозрачности будущей линии в процентах. Если значение непрозрачности 

равно 100%, то нарисованная линия будет полностью закрывать 

расположенное под ней изображение. Если же нет, то нижнее изображение 

будет просвечиваться (рис. 3). 

 

 
 

Рис. 3. Вид линии в зависимости от параметра Непрозрачность (Opacity) 

 

 

Вместе с программой Adobe Photoshop CS поставляются библиотеки 

кистей. Вы можете использовать готовые кисти или модифицировать любую 

кисть библиотеки. При выполнении команды Окно → Кисти (Window → 

Brushes) открывается палитра Кисти (Brushes) (рис. 4). 
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Рис. 4. Палитра Кисти (Brushes) 

 

 

Эта палитра позволяет выбрать форму кисти, ее диаметр (ширину 

линии), жесткость контура, интервал между штрихами, изменить угол 

наклона или округлость кисти. Возможен предварительный просмотр кисти 

по миниатюре ее следа. Кисть с измененными характеристиками можно 

сохранить в качестве нового экземпляра. 

Чтобы закрыть окно с палитрой Кисти (Brushes), выполняют цепочку 

команд Окно → Кисти (Window → Brushes). 

Кривую линию рисуют, перемещая мышь при нажатой левой кнопке. 

Для создания прямой линии щелкают мышью в начале линии, а затем, нажав 

клавишу Shift, - в ее конце. 

 

 

Пример 1.  

Выполнить пейзаж «Дерево» (рис. 5), используя инструмент Кисть 

(Brush Tool)  и палитру Цвет (Color). 

 

1. Открыть новый документ. На панели инструментов выбрать 

инструмент Кисть (Brush Tool). Щелкнуть по стрелке в поле Кисть 

(Brush Tool) на панели настройки инструмента Кисть (Brush Tool), 

чтобы выбрать тип кисти. Величину параметра Непрозрачность 

(Opacity) установить равной 55 %. Выбирать и менять цвет кисти 

следует с помощью палитры Палитра цветов (Color Picker). 

2. Выбрать на палитре цвет для неба, мазки проводить параллельно 

горизонтальной плоскости, постепенно изменяя цвет. При рисовании 

луга мазки проводить тоже горизонтально (рис. 5, а). 
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3. Выбрать кисть «Травка». Установить фоновый и основной цвета, 

используя палитру Палитра цветов (Color Picker). Это могут быть, 

например, желтый и зеленый. Диаметр кисти для переднего плана 

следует выбрать больше, чем для заднего (рис. 5, б). 

4. Выбрать кисть или карандаш малого диаметра и нарисовать дерево: 

ствол сделать толще, чем ветки. При рисовании использовать оттенки 

коричневого цвета (рис. 5, в). 

5. Выбрать кисть «Кленовый лист»  и установить фоновый и основной 

цвета, используя палитру Палитра цветов (Color Picker). В процессе 

рисования листьев можно изменять диаметр кисти и ее цвет. 

Готовый пейзаж показан на рис.5, г. 

 

 

 
 

Рис. 4. Панель Палитра цветов (Color Picker) 

 

РИСОВАНИЕ ФИГУР 

Чтобы нарисовать фигуру, нужно активировать инструмент Фигуры 

(Shapes Tool) и выбрать необходимую форму (рис. 1): 
 Прямоугольник (Rectangle Tool); 

 Прямоугольник со скругленными углами  (Rounded rectangle Tool); 

 Эллипс (Ellipse Tool); 

 Многоугольник  (Polygon Tool); 

 Линия (Line Tool); 

 Произвольная фигура (Custom Shape Tool). 

 

 

 

 

 

Рис. 1. Группа 

инструментов 

Фигуры (Shapes Tool) 
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Панель настройки инструмента Фигуры (Shapes Tool) показана на рис. 2. 

 

 

 

 

 

 

 

Рис. 2. Панель настройки инструмента Фигуры (Shapes Tool): 

1 – Форма слоя (Shape layers); 2 – Залить пикселы (Fill pixels); 3 – Формы 

фигуры (Shapes);  4 – Стиль слоя (Style); 5 – Цвет (Color) 

 

Использовать данный инструмент можно двумя способами. Если 

активировать режим Форма слоя (Shape layers), выставленная фигура будет 

считаться отдельным слоем с набором параметров, которые выбираются на 

панели опций. В этом случае фигуры можно вставлять, но нельзя изменять с 

помощью инструментов рисования. При этом на панели настройки 

инструмента Фигуры (Shapes Tool) будет больше вариантов заливки. Чтобы 

вставленные фигуры можно было изменять, выполняют цепочку команд 

Слой → Объединить с видимым (Layer → Merge Visible).  

Если активировать режим Залить пикселы (Fill pixels), вставленная 

фигура будет считаться формой заливки и ее легко можно изменить 

инструментами рисования. 

Инструменты Прямоугольник (Rectangle Tool), Скругленный 

прямоугольник (Rounded rectangle Tool), Эллипс (Ellipse Tool), Полигон 

(Polygon Tool) и Линия (Line Tool) позволяют рисовать простые фигуры, по 

которым они названы. 

Работа с инструментом Произвольная фигура (Custom Shape Tool) 

аналогична работе в Paint. Но более интересна. Этот инструмент 

предоставляет большой выбор форм (рис. 3). Пример композиции, 

нарисованной с его помощью, показан на рис. 5. 

 

 

 

 

 

 

 

 

 

 

 

Рис. 3. Формы кисти инструмента Произвольная фигура (Custom Shape 

Tool) 

 

1 2 3 4 5 
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Для выбора заливки фигур используется палитра Стиль слоя (Style) 

(рис. 4). 

 

 
 

Рис. 4. Палитра Стиль слоя (Style) 

 

Пример 1. 

Выполнить композицию (рис. 5), используя инструмент Произвольная 

фигура (Custom Shape Tool). 

 

1. Открыть новый документ, активировать на панели инструментов 

пункт Фигуры (Shapes Tool) и выбрать форму Прямоугольник 

(Rectangle Tool). Нарисовать прямоугольник и применить к нему  

заливку Стиль слоя (Style) или Цвет (Color) (рис. 5, а). 

2. Для выполнения других рисунков (зайца, цветов, травы) 

воспользоваться инструментом рисования Произвольная фигура 

(Custom Shape Tool), выбирая нужную форму кисти. 

3. К объектам применить заливку Стиль слоя (Style). 

Готовая композиция показана на рис. 5, в. 

 

 

           
  

а                                                    б                                                в  

 

Рис. 5. Рисование инструментом Произвольная фигура (Custom Shape Tool 
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ОПЕРАЦИЯ «ВЫДЕЛЕНИЕ» 

При работе с изображениями часто возникает необходимость в 

обработке не всего изображения, а его части. Когда на изображении есть 

выделенная активная область, редактировать можно только ее, остальная 

часть изображения защищена. Границы выделенной области представляют 

собой  перемещаемую рамку. Сам процесс выделения аналогичен действиям, 

выполняемым в графическом редакторе Paint. 

Рассмотрим создание выделенной области с помощью инструментов 

Прямоугольная область (Rectangular Marquee Tool), Овальная область 

(Elliptical Marquee Tool), Лассо (Lasso Tool), Прямолинейное лассо (Polygonal 

Lasso Tool),  Магнитное лассо (Magnetic Lasso Tool) (рис. 1) . Операции 

выделения будем рассматривать на одном слое. 

 

              
                                                  а                                                                                              

б 

Рис. 1. Инструменты для выделения активной области: 

а – Прямоугольное выделение (Rectangular Marquee Tool); 

б – Лассо (Lasso Tool) 

 

Для выделения прямоугольной или эллиптической области необходимо 

в группе инструментов Прямоугольное выделение (Rectangular Marquee Tool) 

активизировать инструмент Прямоугольная область (Rectangular Marquee 

Tool) или Овальная область (Elliptical Marquee Tool).  Сам процесс выделения 

аналогичен действиям, выполняемым в графическом редакторе Paint. 

Например, инструмент выделения Прямоугольная область (Rectangular 

Marquee Tool) выделяет активную область следующим образом (рис. 2). 

Для выделения области изображения произвольной форма 

необходимом в группе инструментов Лассо (Lasso Tool) выбрать нужный 

инструмент: Лассо (Lasso Tool), Прямолинейное  лассо (Polygonal Lasso Tool) 

или Магнитное лассо (Magnetic Lasso Tool). 

Инструментом Лассо (Lasso Tool) или Прямолинейное лассо (Polygonal 

Lasso Tool) изображение можно выделить так, как показано на рисунке 3. 
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Рис. 2. Выделение активной области инструментом Прямоугольная 

область  

(Rectangular Marquee Tool)  

 

 

 

 

 

 

 

Рис. 3. Выделение активной области инструментом Лассо (Lasso Tool) 

 

Инструмент Магнитное лассо (Magnetic Lasso Tool) автоматически 

создает выделенную область, граница которой «прилипает» к ближайшей 

зоне наибольшего контраста света и тени, определяющей гграницу фигуры 

(рис. 4). 

 

 

 

 

 

 

Рис. 4.  Выделение активной области  

инструментом Магнитное лассо (Magnetic Lasso Tool) 

Особыми инструментами выделения являются инструменти Волшебная 

палочка (Magic Wand Tool) и  Быстрое выделение (рис. 5). 
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Рис. 5 . Инструменты для выделения активной области  

Волшебная палочка (Magic Wand Tool) и  Быстрое выделение 

 

Он выделяет участки изображения не по форме, а по оттенку цвета. 

Поэтому его удобно использовать при выделении близких по цвету участков 

(рис. 6). 

 

 

 

 

 

 

 

 

 

 

 

Рис. 6. Выделение активной области 

инструментом Волшебная палочка (Magic Wand Tool) 

 

 

Параметр Допуск или Обратная чувствительность (Tolerance) на панели 

настройки инструмента Волшебная палочка (Magic Wand Tool)  (рис. 7) 

регулирует величину отклонения оттенка выделяемых пикселов от оттенка 

оого пиксела, на котором был произведен щелчок мышью. Этот параметр 

может принимать значение от 1 до 255, и чем оно больше, тем шире диапазон 

выделяемых оттенков. 

 

 
 

Рис. 7. Панель настройки инструмента Волшебная палочка (Magic Wand 

Tool) 

Иногда возникает необходимость в удалении выделенной области. 

Чтобы удалить выделенную область, нажимают клавишу  Delete. Можно 

также воспользоваться командой Редактирование → Очистить (Edit Cut). При 
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удалении выделенного участка из слоя его место становится прозрачным, из 

фона – закрашивается фоновым цветом (рис. 8). 

 

 
 

Рис. 8. Удаление выделенной области 

 

Чтобы поменять местами выделенную и невыделенную области – 

инвертировать  выделение, выполняют команду Выделение → 

Инвертировать Выделение (Select → Inverse) (рис. 9). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 9 Инвертирование выделенной области 
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ЗАЛИВКА  

 

Выбрать цвет объекта можно несколькими способами. 

1. Выбрать нужный оттенок, передвигая движки на палитре Цвет 

(Color). Щелкнув мышью по верхнему цветному квадратику,  можно 

задать основной цвет, по нижнему – фоновый. 

2. Выбрать один из цветов в палитре Образцы (Swatches), щелкнув 

мышью по нужному цвету. 

3. Щелкнуть мышью по первому или второму квадрату управления 

цветом на панели инструментов и выбрать нужный оттенок в 

диалоговом окне Палитра цветов (Color Picker). 

4. Цвет можно взять прямо с рисунка инструментом Пипетка 

(Eyedropper Tool). Им обычно пользуются, когда нужно подобрать 

оттенок, точно соответствующий использованному в изображении.  

Щелчок пипеткой по выбранному оттенку «заряжает» основной 

цвет, а щелчок при нажатой клавише  Alt – фоновый. 

Чтобы закрасить выделенную область, используют инструменты 

Заливка (Paint Bucket Tool) и Градиент (Gradient Tool). 

Инструмент Заливка (Paint Bucket Tool) заливает цветом или узором 

области объекта. Этим инструментом можно воспользоваться, не создавая 

выделенную область. По умолчанию для заливки используется основной цвет. 

Чтобы залить объект узором на панели настройки в поле Заливка 

устанавливают значение Шаблон (Pattern), выбирают подходящий рисунок 

(рис. 1). 

 

 
 

Рис. 1. Панель настройки инструмента Заливка (Paint Bucket Tool) 

 

Инструмент Градиент (Gradient Tool) заливает рисунок не однородным 

сплошным цветом, а с переходами. Чтобы выполнить заливку, надо провести 

этим инструментом линию на рисунке, указав программе начальную и 

конечную точки градиента (рис. 2). 

 

             

                                               а                                              б 

Рис. 2. Создание градиента: 

а – линия, проводимая инструментом Градиент (Gradient Tool); 

б – готовый градиент 
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На рис. 3 показана панель настройки этого инструмента с развернутым 

списком стандартных градиентов. Кроме стиля градиента можно выбрать 

также его тип: 

 линейный; 

 радиальный; 

 угловой; 

 зеркальный; 

 ромбовидный. 
 

 

 

 

 

 

Рис. 3. Панель настройки инструмента Градиент (Gradient Tool): 

1 – линейный; 2 – радиальный; 3 – угловой; 4 – зеркальный; 5 – ромбовидный 

 

 

 

 

 

 

Рис. 4. Кнопки работы с выделениями: 

1 – добавить в выделение;  2 – вычесть из выделения; 

 3 – пересечение выделения 

 

 

Пример 1. 

Нарисовать вазу с цветами (рис. 5), используя инструменты выделения, 

градиентную заливку, трансформацию, копирование, вставку. 

 

1. Инструментами выделения нарисовать вазу. Используя кнопки  и 

, а также кнопки, позволяющие добавлять и вычитать выделения 

(рис. 4), создать контуры вазы. Затем применить градиентную заливку 

и снять выделение (рис. 5, а). 

2. Открыть изображение с цветами (рис. 5, б). Выбрать инструмент 

Магнитное лассо (Lasso Tool) и выделить цветок. Выполнить цепочку 

команд Редактирование → Копировать (Edit → Copy). 

3. Открыть изображение с вазой. При помощи цепочки команд 

Редактирование → Вставка (Edit → Paste) вставит цветок в вазу. 

Используя трансформацию, придать ему нужные форму и размер. 

Можно изменить масштаб и наклон. 

4. При помощи копирования (цепочки команд Редактирование → 

Копировать (Edit → Copy) и Редактирование → Вставка (Edit → Paste) 

вставить этот цветок в нашу вазу еще два раза. 

1 2 3 4 5 

1 2 3 
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Готовое изображение показано на рис. 5, в. 

 

 

             

                        а                                                  б                                                  в 

Рис. 5. Этапы выполнения композиции «Ваза с цветами»: 

а – ваза; б – цветы; в – готовое изображение 

 

ИСПОЛЬЗОВАНИЕ ИНСТРУМЕНТА ЛАСТИК (ERASER TOOL) 

Группа инструментов Ластик (Eraser Tool) содержит три инструмента 

(рис. 1): Ластик (Eraser Tool), Фоновый ластик  (Background Eraser Tool) и 

Волшебный ластик (Magic Eraser Tool). 

 

 

 

 

 

 
Рис. 1. Группа инструментов Ластик (Eraser Tool) 

Инструмент Ластик (Eraser Tool)работает подобно инструментам Кисть 

(Brush Tool) или Карандаш (Pencil Tool). Только он всегда рисует одним 

цветом – прозрачным. Прозрачные области изображения обозначаются 

шашечками. 

Инструмент Фоновый ластик  (Background Eraser Tool) делает области 

прозрачными или заливает их фоновым цветом. Достоинство этого 

инструмента заключается в том, что можно осуществлять контроль за 

определенными критериями (например, стирать соседние или несмежные 

области). Аккуратно выбрав кисть, можно контролировать размер стираемой 

области и регулировать мягкость ее границ. 

Инструмент Волшебный ластик (Magic Eraser Tool) позволяет одним 

щелчком мыши стирать в изображении все пикселы, цвет которых с учетом 

заданного допуска похож на цвет пиксела, по которому вы щелкнули. 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 88 

Удаляемые пикселы становятся прозрачными или окрашиваются в фоновый 

цвет (если находятся на фоновом слое). 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 89 

ИНСТРУМЕНТЫ РЕДАКТИРОВАНИЯ ЦВЕТА 

ЦВЕТОВАЯ И ТОНОВАЯ КОРРЕКЦИЯ 

 

Графический редактор Adobe Photoshop позволяет качественно 

редактировать изображение: его цвета, яркость, контрастность и т. д. Все 

команды цветовой коррекции изображения собраны в меню Изображение → 

Коррекция (Image → Adjustments) (рис. 1). При редактировании следует 

помнить, что все изменения применяются только к выделенной части 

изображения. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 1. Инструменты цветовой и тоновой коррекции 

 

Теперь рассмотрим наиболее употребляемые команды подробнее.  

Команда Автотон (Auto Hue) позволяет настроить параметры яркости и 

контрастности цвета автоматически, что сокращает время работы над 

фотографией.  

 

            

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 90 

                                 а                                                            б 

Рис. 2. Результат выполнения команды Автотон (Auto Hue ): 

а- исходное изображение; 

б – отредактированное изображение 

 

 

 

Команда Автоконтраст (Auto Contrast) преобразует самые светлые 

пикселы изображения в белые, а самые темные – в черные и распределяет 

между ними уровни серого. 

Цвета можно скорректировать при помощи команды Цветовой баланс 

(Color Balance). Воспользуйтесь диалоговым окном Цветовой баланс (Color 

Balance) (рис. 3), чтобы скорректировать тени, средние тона или светлые 

изображения  или внести в них какой-либо теплый или холодный оттенок. 

Теплые и холодные тона расположены парами напротив друг друга. 

Ползунки следует передвигать в сторону того цвета, который хотите 

добавить.  

Коррекцию цвета проще заметить на изображении с широким 

диапазоном цветов. 

 

 

 
 

Рис. 3. Диалоговое окно  

Цветовой баланс (Color Balance) 

Команда Яркость / Контрастность (Brightnes / Contrast…) позволяет 

настроить параметры яркости и контрастности изображения (рис. 4). 
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Рис. 4. Диалоговое окно  

Яркость / Контрастность (Brightnes/ Contrast…) 

 

 

 

Команда Цветовой тон / Насыщенность… (Hue/ Saruration) позволяет 

изменять цветовую гамму изображения. В диалоговом окне Цветовой тон / 

Насыщенность… (Hue/ Saruration) (рис. 5) выбирают вариант настройки 

цветов изображения Мастер ( Masrer) все цвета настраиваются сразу или 

настраиваются только цвета, входящие в определенный диапазон. 

 

 
 

Рис. 5. Диалоговое окно 

 Цветовой тон / Насыщенность… (Hue/ Saruration) 

 

Передвигая ползунок Цветовой тон (Hue) влево или вправо, можно 

сдвигать цвет в другую область оттенков (рис. 6). Передвигая ползунок 

Насыщенность (Saruration) влево, насыщенность цветов уменьшают, вправо – 

увеличивают. Чтобы осветлить изображение или слой, ползунок Яркость 

(Lightness) передвигают вправо, а чтобы затемнить – влево. 
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                                             а                                                                             

б 

 

Рис. 6. Результат выполнения команды  

Цветовой тон / Насыщенность… (Hue/ Saruration): 

а- исходное изображение; 

б – отредактированное изображение 

 

 

Команда Черно-белое… или Обесцветить (Desaturate) позволяет убрать 

из изображения цвет (преобразовать его в оттенки серого цвета), не изменяя 

при этом его действительного режима (рис. 7). 

 

 

           

                                             а                                                                             

б 

 

Рис. 7. Результат выполнения команды  

Черно-белое…  или Обесцветить (Desaturate): 

а -  исходное изображение; 

б – отредактированное изображение 

 

Команда Инверсия (Invert) делает изображение похожим на негатив 

(рис. 8). 

Для предварительного просмотра результатов преобразований 

необходимо выставить флажок Предварительный просмотр (Preview).  
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Рис. 9 Результат выполнения команды  

Инверсия (Invert) 

 

КОРРЕКЦИЯ ФОТО. ОБРЕЗКА ФОТО, ПОВОРОТ, 

ТРАНСФОРМИРОВАНИЕ ИЗОБРАЖЕНИЯ 

Операция «обрезка» 

 

Для обрезки фотографии и изменения ее размера в графическом 

редакторе Adobe Photoshop CS5 существует специальный инструмент  

«Рамка»  (Crop Too). Главной особенностью этого инструмента является то, 

что с его помощью можно обрезать фотографии до нужного формата: 10x15, 

13x18, 20х30, а также любого другого.  

 

Рассмотрим последовательность обрезки фотографии с помощью 

инструмента «Рамка»  (Crop Too). 

Открываем исходную фотографию и на панели инструментов выбираем 

инструмент «Рамка» (Crop Tool) (рис. 1). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 1. Выбор инструмента «Рамка» 
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Далее выделяем область, которую нужно оставить (рис. 2) и нажимаем 

на клавиатуре клавишу Enter. 

 

 

 

Рис. 2. Выделение области на фотографии 

 

 

Обрезанную фотографию (рис. 3) необходимо сохранить через меню 

Файл→ Сохранить как (File → Save As). 

 

 

 

Рис. 3. Обрезанная фотография 

 

Важно отметить, что Adobe Photoshop CS5 при открытии исходной 

фотографии подгоняет еѐ масштаб под окно просмотра. В нашем случае 

разрешение исходного изображения составляло 1600х901 пиксель, и «Adobe 
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Photoshop» изменил масштаб просмотра до 50%. Поэтому размеры 

обрезанной фотографии на самом деле в два раза больше. 

Трансформация объекта 

 

Изображения в процессе работы приходится преобразовывать, или 

трансформировать. Под трансформацией растрового изображения 

понимается изменение его формы: масштабирование (изменение размеров), 

поворот, наклон. Для того, чтобы выполнить трансформацию, выделяют 

объект и выбирают команду Редактирование → Трансформирование → 

Масштабирование (Edit →Transform → Scale), Поворот (Rotate), Наклон 

(Skew), Искривление (Distort), Перспектива (Perspective), Отразить по 

горизонтали (Flip Horizontal) или Отразить по вертикали (Flip Vertical) и т.д. 

(рис. 4). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 4. Команды трансформации выделенной области 
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Рассмотрим на примере последовательность действий для выполнения 

трансформации Поворот (Rotate): 

1. Открываем исходную фотографию и выделяем изображение. 

2. Выполняем команду Редактирование → Трансформирование → 

Поворот (Edit →Transform → Rotate). Вокруг изображения появится 

габаритная рамка (рис. 5). 

 

 

Рис. 5. Габаритная рамка 

 

3. Чтобы повернуть изображение, потянем за двойную стрелку против 

часовой стрелки (рис. 6).   

 

 

Рис. 6. Поворот изображения 

Для того чтобы зафиксировать внесенные изменения, дважды 

щелкнем мышью внутри габаритной рамки либо нажмем клавишу 
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Enter. Чтобы отменить трансформацию, щелкнем мышью по кнопке 

отмены или нажмем клавишу Esc. 

 

4. Выполняем обрезку фотографии (рис. 7). 

 

 

Рис 7. Обрезка фотографии 

 

5. Полученное изображение сохраняем (рис. 8). 

 

 
Рис. 8.  Говая фотография 
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ИНСТРУМЕНТЫ РЕДАКТИРОВАНИЯ ИЗОБРАЖЕНИЯ 

К инструментам редактирования можно отнести инструменты 

Клонирующий штамп (Clone Stamp Tool), Обрезка (Crop Tool), Размытие 

(Blur Tool), Резкость (Sharpen Tool) и Палец (Smudge Tool). 

Пожалуй, самый широко применяемый инструмент Adobe 

Photoshop CS5 - Клонирующий штамп (Clone Stamp Tool)       .  

Он используется для переноса клона объекта с одного 

изображения на другое или с одного слоя на другой. 

Рассмотрим панель настройки этого инструмента (рис. 1). 

 

 
 

Рис. 1. Панель настройки инструмента 

Клонирующий штамп (Clone Stamp Tool) 

 

В поле Кисть (Brush Tool) выбирают размер и форму кисти. Затем 

назначают режим смешивания в поле Режим (Mode), а также задают значение 

параметра Непрозрачность (Opacity) в процентах. 

На палитре Слои (Layers) выбирают слой, фрагмент которого хотят 

клонировать. Нажав клавишу  Alt, щелкают по нужной области, чтобы 

создать исходную точку. На этом же слое перетаскивают курсор в то место, 

где должна появиться копия фрагмента изображения ( можно также выбрать 

или создать другой слой). После щелчка мышью в месте копирования на 

экране появится два курсора: перекрестие над исходной точкой и курсор 

инструмента Клонирующий штамп (Clone Stamp Tool) или пиктограмма 

кисти там, где будет «проявляться» изображение копируемого фрагмента. 

Теперь рассмотрим наиболее часто используемые возможности 

инструмента  Клонирующий штамп (Clone Stamp Tool). 

 

1. Редактирование фотографии. При съемке со вспышкой на 

фотографии часто остается падающая тень от объекта. При помощи 

Клонирующего штампа (Clone Stamp Tool), ее можно легко убрать. Для этого 

выбирают образец фона, фрагмент которого хотят клонировать, и, нажав 

клавишу Alt, щелкают по этой области слоя. Затем отпускают клавишу Alt, 

создав тем самым исходную точку копирования. Далее щелкают левой 

кнопкой мыши в области падающей тени. На экране появляются два курсора: 

перекрестие над исходной точкой и курсор инструмента. Последующая 

работа с инструментом Клонирующий штамп (Clone Stamp Tool) аналогична 

работе инструмента Кисть (Brush Tool). Пример такой обработки 

изображения представлен на рис. 2.  
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                        а                                                         б                            

 

Рис. 2. Результат применения инструмента 

Клонирующий штамп (Clone Stamp Tool): 

а – исходное изображение; б – отредактированное изображение 

2. Создание эффекта наложения. Используя Клонирующий штамп 

(Clone Stamp Tool), можно выполнить композицию «Портрет» (рис. 3). Для 

этого активизируют инструмент Клонирующий штамп (Clone Stamp Tool) и 

выбирают размер и форму кисти из набора кистей на панели настройки 

инструмента. Нажав клавишу Alt, щелкают по изображению портрета, а 

затем клавишу  Alt отпускают. На палитре Слои (Layers)  выбирают слой, где 

будет находиться новое изображение, и щелкают мышью в нужном месте. На 

экране появляется пиктограмма кисти. Перемещая кисть при нажатой левой 

клавише мыши, получают новое изображение. В зависимости от формы 

выбранной кисти наложение изображений сопровождается различными 

эффектами. 
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                  а                                    б                                      в 

 

Рис. 3. Результат применения инструмента 

Клонирующий штамп (Clone Stamp Tool) с разной формой кисти: 

а – кленовый лист; б – травка; в - звездочка 

При использовании эффекта наложения лежащие ниже пиксели будут 

слегка проглядывать сквозь клонированные.  

При изменении параметра Непрозрачность (Opacity) изменяется 

прозрачность разных слоев изображения (рис. 3.в).  

Инструменты Размытие (Blur Tool), Резкость (Sharpen Tool) и Палец 

(Smudge Tool) объединены на панели инструментов в одну группу (рис. 4). 

Размытие (Blur Tool) позволяет создавать эффект пролитой воды, Резкость 

(Sharpen Tool) придает участку рисунка эффект сильной резкости, Палец 

(Smudge Tool) по своему действию аналогичен размазыванию краски мокрым 

пальцем. 

  
 

Рис. 4. Панель инструментов 

Размытие (Blur Tool), Резкость (Sharpen Tool) и Палец (Smudge Tool) 

Использование любого из этих инструментов аналогично 

использованию инструмента Кисть (Brush Tool), у которого отсутствует ряд 
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параметров. У всех этих инструментов на панели настройки присутствует 

собственный параметр Сила (Strength), определяющий степень изменения 

изображения. Изначально установлено значение, равное 50 %.  На рис. 5 

приведен пример изменения фона инструментами Размытие (Blur Tool) и 

Палец (Smudge Tool). 

 

 
 

Рис. 5. Результат применения инструментов  

Размытие (Blur Tool), Резкость (Sharpen Tool) и Палец (Smudge Tool) 
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РАБОТА СО СЛОЯМИ 

 

Adobe Photoshop предлагает удобный способ работы с объектами – слои. 

Слои похожи на прозрачные пленки, сложенные стопкой. Если посмотреть на 

эту стопку сверху, можно увидеть целостное изображение. В то же время 

каждый слой содержит один объект, а сквозь его прозрачные участки видны 

нижележащие слои. 

 Каждое изображение в Adobe Photoshop имеет хотя бы один слой. 

Однослойные изображения получают в результате сканирования и открытия 

файлов. 

Фоновым слоем (Background) называют единственный слой (задний 

план), который имеет большинство изображений. Он отличается от прочих 

слоев в первую очередь тем, что не может быть прозрачным. Фоновый слой 

всегда располагается внизу, под остальными слоями, и служит фоном. 

Объект, находящийся на отдельном слое, изолирован от остального 

изображения, поэтому его можно как угодно изменить: масштабировать, 

перемещать, поворачивать, изменять цвет и т. д. 

Для того чтобы открыть палитру Слои (Layers), необходимо выполнить 

цепочку команд Окно → Слои (Window → Layers). 

Она содержит список слоев, начиная с самого верхнего и заканчивая 

самым нижним (рис. 1). Слой, выделенный в данный момент (активный), - 

единственный, который можно редактировать. Чтобы сделать слой активным, 

достаточно щелкнуть по его имени мышью. 

 

 

 
Рис. 1. Палитра Слои (Layers): 

1 – Панель выделенного слоя; 2 – Слой заливки;  

3 – Создать новый слой;  4 – Удалить слой 

 

 

Панель выделенного слоя палитры Слои (Layers) указывает на 

параметры активного слоя: его вид (обычный, растворение, умножение и т. 

д.), непрозрачность, блокировку, заливку. 
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При открытии нового документа палитра будет содержать только 

фоновый слой. 

Для создания нового слоя щелкают по кнопке Создать новый слой , 

расположенной внизу палитры Слои (Layers). 

Для удаления слоя этот слой выделяют и нажимают клавишу  Delete 

или просто перетаскивают его на значок корзины внизу панели . 

Для создания копии слоя его перетаскиваю на кнопку Создать новый 

слой , расположенную внизу палитры Слои (Layers). Дубликат слоя 

появится над исходным слоем и станет активным (рис. 2). 

 

 
 

Рис. 2. Дублирование слоя 

 

 

Чтобы скрыть слой (сделать его невидимым), щелкают по значку в виде 

глаза , соответствующему выбранному слою. Ели щелкнуть по тому же 

квадратику еще раз, слой снова станет видимым. 

При выполнении графичкского изображения иногда возникает 

необходимость изменить порядок наложения слоев. Например, чтобы текст 

читался, слой с текстом должен быть расположен выше изображения. 

Порядок расположения слоев и способы их наложения можно 

изменить, просто перетащив слой вверх или вниз на палитре. 

Пример изменения порядка расположения слоя представлен на рис.  3. 

 

          
 

Рис. 3.  Измененный порядок наложения слоев 
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Если необходимо создать фон для файла, у которого нет фона, можно 

преобразовать в фон существующий слой, выбрав слой и воспользовавшись 

цепочкой команд Слой → Новый → Фон из слоя (Layer → New → 

Background From Layer). Новый фон будет расположен на палитре Слои 

(Layer) в самом низу. 

Копирование и вставка видимой области слоя в другое изображение 

выполняется аналогично копированию и вставке выделенной области. 

 

Пример 1.  

Выполнить монтаж из нескольких изображений. Для этого выбрать три 

файла с фотографиями. 

 

Открыть первое изображение, выделить его и скопировать. Для этого 

следует выполнить цепочки команд Выделение → Все (Select → All) и 

Редактирование  → Скопировать (Edit → Copy), затем следует создать новый 

документ, создать в нем новый слой  и выполнить цепочку команд 

Редактирование → Вставить (Edit → Paste). Изображение расположится на 

первом слое (рис. 4). 

 

                                

 
 

Рис. 4.  Первый слой изображения 

Открыть фотографию с изображением рыбы, с помощью Магнитное 

лассо (Magnetic Lasso Tool) выделить изображение  (рис. 5). Далее следует 

скопировать выделенную область и вставить во второй слой документа. 
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Рис. 5. Выделение фигуры 

 

 

На палитре Слои (Layers) щелкнуть по значку в виде глаза  напротив 

каждого слоя и открыть их.  

Работа над многослойными изображениями обычно заканчивается 

объединением слоев. Для этого можно воспользоваться командами Слить с 

нижним (Merge Down), Слить видимые (Merge Visible), которые позволяют 

слить вместе два и более слоев.  

Готовый монтаж из трех изображений показан на рис. 6. 

 

 

                 
 

Рис. 6. Готовое изображение 

 

 

 

 

Слой заливки (Fill Layer) вспомогательный слой, который не добавляет 

в изображение новые объекты, а изменяет уже существующие. Он может 

соделжать однотонную окраску, градиент или узор. Его можно редактировать 

или удалять, не влияя при этом на остальные слои. 

Выполнив цепочку команд Слои → Новая заливка слоя → Узор ... 

(Layers → New  Fill Layer → Pattern … ), выбирают варианты заливки: 
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Однотонный цвет… (Solid Color …) – создает новый слой, равномерно 

окрашенный в выбранный цвет; 

Градиент… (Gradient…)  - новый слой содержит градиентную заливку; 

Узор… (Pattern…) – слой заливается по выбранному шаблону. 

В появившемся окне Новый слой () 

 (рис. 7) необходимо задать имя слоя и его параметры: Цвет (Color), Режим 

(Mode), Непрозрачность (Opacity). 

 

 

 
 

Рис. 7. Диалоговое окно Новый слой (→ New Layer) 

 

 

Так как большинство форматов, кроме Photoshop (. psd), Photoshop PDF 

(. pdf) и TIFF (.tif), не поддерживают многослойность изображений, то для 

экспорта файла в другое приложение слои необходимо объединить. 

Воспользовавшись командами Слить с нижним (Merge Down), Слить 

видимые (Merge Visible), можно слить вместе два и более слоя. Но для 

удобства редактирования наилучший способ – сохранить копию файла с 

объединенными слоями с помощью цепочки команд Файл → Сохранить 

как… (File → Save As…), установив флажок Как копию… ( As a Copy…). 

При этом многослойная версия изображения будет сохранена. 

 

РАБОТА С ФИЛЬТРАМИ 

Фильтрами называются специальные инструменты, с помощью 

которых в изображение вносят определенные художественные изменения 

(эффекты). Используя их, можно получить огромное количество эффектов, 

начиная от небольшого увеличения резкости и заканчивая значительными 

изменениями. Например, фильтры Размытие (Blur) или Резкость (Sharpen) 

можно использовать для едва заметного ретуширования изображения; 

фильтры  Цветной растр (Color Halftone), Рельеф (Emboss) или Ветер (Wind) 

– для более ярких эффектов; Художественный (Artistic), Мазки кисти (Brush 

Strokes) или Текстура (Texture) – для создания изображения, 

«нарисованного» вручную; Эффекты освещения (Lighting Effects) – для того, 

чтобы «осветить» изображение. 

Приведем примеры действия разных фильтров на простой натюрморт 

(рис. 1). 

Фильтр Мозаика (Mosaic) объединяет пикселы близких цветов в 

квадратные ячейки (рис. 2). Он применяется цепочкой команд Фильтр → 

Оформление → Мозаика  (Filter → Pixelate →Mosaic). 
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Фильтр Эффекты освещения (Lighting Effects) имитирует разные типы 

освещения (рис. 3). Он применяется цепочкой команд Фильтр → Рендеринг 

→ Эффекты освещения (Filter → Render → Lighting Effects). 

Фильтры группы Текстура (Texture) создают разнообразные текстуры. 

Например, фильтр Кракелюры (Сraquelure) добавляет к изображению эффект 

искусственного старения (рис. 4). Его можно применить цепочкой команд 

Фильтр → Текстура → Кракелюры  (Filter → Texture → Сraquelure). 

 Фильтр Тиснение (Emboss) имитирует объем (рис. 5). Его можно 

применить цепочкой команд Фильтр → Стилизация → Тиснение (Filter → 

Stylize → Stamping). 

Фильтр Акварель (water color) создает изображение, имитирующее 

акварельную живопись (рис. 6). Его можно применить цепочкой команд 

Фильтр → Имитация → Акварель (Filter → water color). 

Все фильтры сгруппированы в 13 категорий, перечисленных в меню 

Фильтр (Filter). Импортированные фильтры появляются в своих собственных 

подменю. 

Фильтр можно применить как к слою в целом, так и к его выделенной 

части. 

 

 
Рис. 1. Исходное изображение 

 

 
Рис. 2. Действие фильтра  

 Мозаика (Mosaic) 

 

                    
                          

                                     а                                                                               б 

Рис. 3. Действие фильтра Эффекты освещения (Lighting Effects): 
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а – итоговое изображение; б - диалоговое окно фильтра 

 

 

                             
                               

                                а                                                                           б 

Рис. 4. Действие фильтра Кракелюры (Сraquelure) 

а – итоговое изображение; б - диалоговое окно фильтра 

 

 

                      
а                                                                     б 

Рис. 5. Действие фильтра Тиснение (Stamping) 

а – итоговое изображение; б - диалоговое окно фильтра 

                         
 

а                                                                      б 

Рис. 6. Действие фильтра Акварель (water color) 

а – итоговое изображение; б - диалоговое окно фильтра 
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Некоторые фильтры можно применить, просто выбрав 

соответствующую команду из подменю, а другие фильтры можно 

использовать только установив определенные значения переменных в 

диалоговом окне. 

Чтобы включить предварительный просмотр эффекта, нужно 

установить флажок Предварительный просмотр (Preview). Если щелкнуть по 

кнопке «плюс», изображение в окне предварительного просмотра можно 

увеличить, по кнопке «минус» - уменьшить. 

С помощью команды Ослабить (Fade) эффект от применения фильтра 

можно ослабить. Для этого сразу после применения фильтра выполняют 

цепочку команд Правка → Ослабить (Edit → Fade). 

Выполнив цепочку команд Фильтр → Последний фильтр (Filter → Last 

Filter), можно повторно применить последний фильтр с теми же 

характеристиками. 

При работе с фильтрами следует учитывать, что в режиме RGB 

доступны все фильтры, а в режиме  CMYK – только некоторые из них. 

Фильтры неприменимы к изображениям в режиме Bitmap  и  Indexed Color  и 

к изображениям, в которых на каждый канал приходится 16 бит. 

 

РАБОТА С ТЕКСТОМ 

Работа с текстом в программе Adobe Photoshop CS используется для 

создания заголовков художественным текстом. Текст хранится в векторном 

виде, благодаря чему с ним всегда можно работать как с текстом, а не как с 

рисунком. В текст можно вставлять буквы, заменять слова, менять шрифт, 

изгибать и изменять цвет. 

Чтобы ввести какую-либо надпись, используют инструмент Текст 

(Type). В зависимости от направления ввода о н может быть горизонтальным 

- Текст (Horizontal Type Tool) или вертикальным (Vertical Type Tool) (рис. 1). 

 

 
 

Рис. 1. Панель инструмента Текст (Type) 

 

 

После выбора инструмента Текст (Type) нужно щелкнуть мышью в той 

точке рисунка, где должна быть надпись, и сразу вводить текст. Есть и 

другой способ: сначала растянуть рамку, а затем вводить в нее текст. В рамке 

(рис. 2) есть узлы для трансформации. При обычном растягивании, сжатии, 

повороте рамки размеры букв не изменяются – текст перераспределяется в 

соответствии с ее габаритами. При выполнении этих же действий при 

нажатой клавише Ctrl  размеры букв также будут изменяться. 
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Рис. 2. Рамка для ввода текста 

 

 

Надпись всегда вводится основным цветом. Если цвет в процессе 

работы необходимо изменить, можно воспользоваться  дополнительной 

панелью настройки инструмента Текст (Type) (рис. 3). 

 

 

 
 

Рис. 3. Панель настройки инструмента Текст (Type) 

Для того чтобы изменить цвет текста, его необходимо выделить, как 

показано на рис. 4. 

 

              

                                   а                                                                  б 

 

Рис. 4. Текст без выделений (а) и выделенный (б) 

 

Чтобы внести в текст исправления, необходимо выбрать инструмент 

Текст (Type), а затем выделить слой с текстом на палитре Слои (Layers). 

Программа Adobe Photoshop CS позволяет выполнять надписи с 

искажением. Для этого следует воспользоваться кнопкой Создать 

деформированный текст (Create Warped Text), 

расположенной на панели настроек инструмента Текст (Type). В 

появившемся окне Деформировать текст (Warped Text) можно задать 

параметры и расположение текста (рис. 5). 
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Рис. 5. Окно Деформировать текст (Warped Text) 

Пример 1.  

Написать текст по дуге. 

 

 

 

   

                    

 

 

 

                        а                                                                               б 

Рис. 6.  Написание текста по дуге: 

а – ввод текста; б – готовое изображение 

 

1. Написать текст и выделить его (рис 6, а). 

2. Щелкнуть мышью по кнопке Создать деформированный текст 

(Create Warped Text) и в списке окна Деформировать текст (Warped 

Text) выбрать стиль «Дуга». 

Готовое изображение текста по дуге показано на рис. 6, б. 

 

 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 112 

Используя слои и разнообразные фильтры, можно применять к 

написанному тексту всевозможные эффекты, например, эффект сияющего 

текста или объема. 

 

 

 

Пример 2.  

Создать эффект сияющего текста. 

 

 

     

                       а                                             б                                                в 

Рис. 7. Эффекты сияющего текста: 

а – ввод текста; б – размытие изображения; в – готовый текст 

 

1. Создать новое изображение с черным фоном и написать какой-

нибудь текст белым цветом. Затем объединить слои, выполнив 

цепочку команд Слои → Слить видимые (Layers → Merge Visible) 

или нажав клавиши Ctrl + E (рис. 7, а). 

2. Размыть изображение. Для этого следует выполнить цепочку команд 

Фильтр → Размытие → Размытие по Гауссу (Filter → Blur → 

Gaussian Blur). Края размыть не 2-3 пиксела (рис. 7, б). 

3. Применить эффект стилизации при помощи цепочки команд Фильтр 

→ Стилизация → Соляризация (Filter → Stylize → Solarize). Для 

усиления эффекта следует выполнить цепочку команд Изображение 

→ Коррекция → Авто Уровни (Image → Adjustments → Auto 

Levels). 

4. Для получения сияния вокруг текста следует применить фильтр 

Ветер (Wind) цепочкой команд Фильтр → Стилизация  → Ветер 

(Filter → Stylize → Wind). 

Этот фильтр надо применить ко всем сторонам текста. Для этого 

необходимо выполнить следующий алгоритм: 

1) Выполнить цепочку команд Изображение → Вращение 

изображения → 90° по часовой стрелке (Image → Rotate 

Canvas → 90° CW);  

2) Применить фильтр Ветер (Wind).  

Так следует повторять пока, пока текст не вернется в исходную 

позицию. 

5. Для добавления цвета выполнить цепочку команд Изображение → 

Коррекция → Цветовой баланс (Image → Adjustments → Color 

Balance) и установить параметры цвета. 

Готовый эффект приведен на рис. 7, в. 
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Пример 3.  

Создать эффект объемного текста. 

 

 

     

                    а                                            б                                            в 

Рис. 8. Создание эффекта объемного текста: 

а – используемая текстура; б – ввод текста; в – готовый эффект 

1. Создать новое изображение (10 × 10 см). Выбрать любую текстуру: 

деревянную, металлическую или любую другую поверхность (рис. 

8). 

2. Продублировать слой текстуры. В результате должно получиться 

два одинаковых слоя, которые выглядят как один. 

3. Инструментом Текстовая маска (Type Mask Tool) из группы 

инструментов Текст (Type) написать букву или слово, желательно 

использовать шрифт большого размера (рис. 8, б). 

4. Очистить область вокруг буквы. Для этого выполнить цепочку 

команд Выделение → Инверсия (Select → Inverse) и нажать кнопку 

Del. Снять выделение цепочкой команд Выделение → Отменить 

выделение (Select → Deselect). 

5. Придать тексту объем цепочкой команд Слой → Стиль слоя → 

Тиснение (Layer → Layer Style → Emboss). Параметры тиснения 

выбрать по усмотрению. 

6. Применить эффект Тень (Shadow). Для этого выполнить цепочку 

команд Слой → Стиль слоя → Тень (Layer → Layer Style → 

Shadow). Параметры также выбрать по усмотрению. 

7. Чтобы добавить контрастности, следует воспользоваться командой 

Изображение → Коррекция → Яркость/Контрастность (Image → 

Adjustments → Brightness/contrast) в открывшемся окне сдвинуть 

ползунки, регулируя яркость и контрастность изображения. 

Готовый эффект показан на рис. 8, в. 

 

 

Пример 4.  

Создать эффект светящихся букв. 
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                                            а                                                                                     

б          

 

           

                                     в                                                                      г 

Рис. 9. Создание эффекта светящихся букв: 

а – ввод текста; б – выбор цвета; в – размытие; г – готовый эффект 

1. Создать новый документ (12 – 6 см). залить фон черным цветом. 

Выбрать инструмент Текст (Type) с подрежимом Создать маску или 

выделение (Create a Mask or Selection) и написать текст (рис. 9, а). 

2. Залить выделенную область зеленым цветом. Применить 

растушевку к контуру выделенного текста на величину 2 пиксела. 

Для этого выполнить цепочку команд Выделение →  Модификация 

→ Растушевка (Select → Feather) (рис. 9, б). 

3. Для получения эффекта применить фильтр Размытие (Blur) 

цепочкой команд Фильтр → Размытие → Радиальное размытие 

(Filter → Blur → Radial Blur). Фильтр можно применить два раза 

(рис. 9, в). 

4. Инвертировать выделение и выполнить цепочку команд Фильтр → 

Размытие → Радиальное размытие (Filter → Blur → Radial Blur) с 

теми же параметрами, что и раньше. 

Готовый эффект показан на рис. 9, г. 
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Лекция 4.Методика изучения графических редакторов векторной 

графики для школьников 8 класса. 

 
ОСНОВНЫЕ ВОЗМОЖНОСТИ ПРОГРАММЫ СorelDRAW X5 

И ЭЛЕМЕНТЫ ЕЕ ИНТЕРФЕЙСА 

Программа CorelDRAW X5, разработанная фирмой Corel Corporation, 

предназначена для создания и редактирования изображений векторной 

графики. Кроме того, она позволяет обрабатывать растровые изображения и 

текстовую информацию. 

Для работы с векторной графикой программа CorelDRAW  X5 имеет 

большой набор инструментов рисования простых объектов и их 

модификаций. Для заливок и контуров объектов используются почти все 

известные цветовые палитры. 

Возможности программы позволяют трансформировать объекты, 

копировать их, дублировать, клонировать, выравнивать, размещать на 

равных расстояниях друг от друга. Причем эти операции не приводят к 

потере качества изображения, так как форма, цвет и пространственное 

положение объектов векторной графики описываются математическими 

формулами. Особое место отведено работе с формой объекта. При помощи 

всевозможных преобразований формы можно получить практически любой 

объект. 

В программе CorelDRAW X5 имеется большой набор эффектов, с 

помощью которых к объекту можно добавить тень, создать красивые 

контуры, имитировать объем, построить переходы между объектами, сделать 

объект частично прозрачным и т. д. 

Кроме векторной графики программа позволяет использовать и 

обрабатывать растровые изображения. Такие изображения (например, 

выполненные в Paint или Photoshop) легко импортируются в CorelDRAW X5. 

К ним можно применять следующие эффекты: художественные мазки, 

трехмерные эффекты, размытость, искажение, цветные и творческие 

преобразования. 

Возможность сочетать в одном графическом редакторе объекты 

векторной и растровой график позволяет достаточно быстро создавать 

художественные эффекты к изображениям, рисунки для сайтов и рекламы. 

Для работы с текстом программа CorelDRAW X5 имеет достаточно 

широкие возможности форматирования, что позволяет прямо в ней создавать 

текстовые документы с рисунками или  использовать программу для 

компьютерной верстки. Готовый текст, набранный в текстовом редакторе, 

можно импортировать в CorelDRAW X5 и использовать для создания 

рекламного буклета. Однако текст можно набирать и непосредственно в этой 

программе. 

Поскольку программа CorelDRAW  X5 – не первый графический 

редактор, с которым вы знакомитесь, при изложении материала внимание 

будет уделяться именно особенностям этой программы. 
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ЭЛЕМЕНТЫ ОКНА ПРОГРАММЫ CorelDRAW X5 

Запуск программы осуществляется стандартными для OC Windows 

способами: по команде Пуск → Программы → CorelDraw  X5  или двойным 

щелчком мыши по пиктограмме программы . 

При запуске программы на экране может отображаться окно Добро 

пожаловать в CorelDraw (Welcome to CorelDraw) с набором управляющих 

кнопок, предназначенных для выбора следующего шага работы: 

 Новый (New Graphic) – для создания нового графического 

документа с использованием шаблона по умолчанию; 

 Открыть последний (Open Last Edited) – для открытия документа, 

который обрабатывался последним; 

 Открыть (Open Graphic) – для загрузки документа, хранящегося 

на диске; 

 Шаблон (Template) – для создания нового документа в одном из 

шаблонов, предлагаемых на выбор разработчиками CorelDraw 

X5; 

 CorelTUTOR – для создания нового документа и открытия окна с 

электронным учебником по CorelDraw X5; 

 Что нового? (What' s New) – для создания нового документа и 

открытия диалогового окна, содержащего сведения о новых 

возможностях данной версии CorelDraw. 

Чтобы при последующих запусках CorelDraw X5 это окно не 

появлялось, следует снять флажок  Показывать это окно при запуске (Show 

this Welcome at startup). 

Операции создания, открытия, сохранения файлов в программе 

CorelDraw X5 выполняются стандартными для OC Windows способами. 

После запуска команды OC Windows на экране компьютера появляется 

окно, основные элементы которого показаны на рис. 1. 

Для удобства работы настройку интерфейса программы обычно 

начинают с расстановки стандартной панели инструментов 4, панели 

настроек инструмента 3, строки состояния 15, панели инструментов 

рисования 2. Включить или отключить эти объекты можно несколькими 

способами: 

1) щелкнуть правой кнопкой мыши в окне CorelDraw X5 (вне окон 

документов) и в появившемся меню включить или отключить флажки 

нужных объектов;  

2) щелкнуть правой кнопкой мыши в области окна документа, в 

появившемся меню выбрать команду Вид (View)  и включить или 

отключить флажки нужных объектов в дополнительном меню. 

Тосно так же по мере необходимости можно включать или отключать и 

другие объекты (например, цветовые палитры, направляющие и т.д.) 

 

Основными элементами окна программы CorelDraw X5 являются: 

строка заголовка программы, строка меню, стандартная панель инструментов 
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4, панель настроек выбранного инструмента 3, строка состояния 15, цветовая 

палитра 8, панель инструментов рисования 2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 1. Главное окно CorelDraw 11: 

1 – метрические линейки; 2 – панель инструментов рисования; 

3 – панель настроек инструмента; 4 – стандартная панель инструментов;  

5 – рабочая область рисования; 6 – страница документа; 7 – кнопка отмены 

цвета; 8 – цветовая палитра; 9 – кнопка разворачивания цветовой палитры;  

10 – навигатор документа; 11 – индикатор цвета заливки; 12 – индикатор 

цвета контура; 13 – пиктограмма цвета контура; 14 – пиктограмма цвета 

заливки; 15 – строка состояния; 16 – навигатор страниц документа 

Внутри окна программы CorelDraw X5 находятся окна документов, в 

которых создаются и обрабатываются изображения. Основными элементами 

окна документа являются: строка заголовка, рабочая область рисования 5, 

страница документа 6, навигатор страниц документа 16, навигатор документа 

10, горизонтальная и вертикальная метрические линейки 1. Если окно 

документа содержит несколько страниц, переходы между ними 

осуществляются с помощью навигатора страниц 16. Одновременно может 

быть открыто несколько документов. Перечень всех открытых окон можно 

увидеть в подменю команды Окно (Window). Переключение между ними  

производится либо в меню Окно (Window), либо клавишами Ctrl + Tab.  

Поскольку окно программы CorelDraw X5 и окна ее документов 

являются стандартными окнами OC Windows, многие их элементы вам уже 

знакомы. Поэтому рассмотрим назначение лишь тех элементов и действий, 

которые являются специфическими для программы CorelDraw X5. 

Панель настроек инструмента 3 представляет собой панель, кнопки 

которой используются для настройки параметров  активного (выбранного) 
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инструмента. Ее вид изменяется в зависимости от применяемого инструмента 

и выполняемой операции (рис.2). 

 

 
 

Рис. 2. Панель настроек инструмента 

 

Строка состояния 15 (рис. 1) размещается вдоль нижнего края окна 

программы и содержит текущую информацию о применяемом инструменте и 

выполняемой операции. В правой части этой строки в виде двух строк  

представлена информация о цвете заливки 14, о цвете и толщине линии 

контура 13 выделенного объекта. Правее пиктограмм можно увидеть 

соответствующие текстовые названия и индикаторы выбранных цветов. Если 

вместо цветных индикаторов появились белые кнопки с наклонными 

черными крестами, то выбранный инструмент или действие не позволяет 

рисовать и заливать объекты. 

Чтобы изменить или настроить цвет заливки или контура выделенного 

объекта, можно дважды щелкнуть мышью в соответствующей строке и в 

появившемся диалоговом окне выбрать необходимые параметры. 

Цветовая палитра 8 (рис. 1) содержит кнопки различных цветов и 

обычно располагается в правой части окна в виде одного столбца (рис.3, а). С 

помощью кнопок навигации 2 цветовой палитры прокручиваются кнопки 

цветов. Если удерживать кнопку выбранного цвета несколько секунд, 

появится дополнительная палитра оттенков этого цвета (рис.3, б). 

С помощью кнопки разворачивания 4 можно расширить цветовую 

палитру до нескольких столбцов (рис. 3, в). Для возврата к обычному виду 

палитры следует щелкнуть мышью вне палитры. 

Для удобства работы цветовую палитру можно перетащить поближе к в 

выполняемому изображению  – она приобретет плавающий вид. Для возврата 

плавающей палитры к обычному виду ее следует перетащить к границе окна 

программы или дважды щелкнуть мышью в строке заголовка палитры. 

В верхней части цветовой палитры есть кнопка отмены цвета 3. Если 

щелкнуть по ней мышью , то с выделенного объекта снимется цвет заливки. 

После щелчка правой кнопкой  мыши снимается цвет контура. 
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Рис. 3. Цветовая палитра CorelDraw X5: 

а -  обычный вид (1 – меню палитры; 2 – кнопки прокрутки палитры; 3 – кнопка 

отмены цвета; 4 – кнопка разворачивания палитры); б – палитра с панелью 

оттенков цвета;  

в – расширенный вид 

Кнопка Меню палитры (Default) 1 (рис. 3) содержит меню команд 

цветовой палитры. Например, если нужно узнать название выбранного цвета, 

следует выполнить команду Показать имена цветов (Show Color Names). К 

сожалению, названия цветов даются только по-английски. 

 

1 

2 

2 

3 

4 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 120 

Панель инструментов 2 (рис. 1) содержит кнопки инструментов 

рисования и обычно располагается в левой части окна программы. Если в 

правом нижнем углу кнопки инструмента есть черный треугольник, то, 

удерживая его, можно открыть подменю кнопок инструмента или его 

аналогов. Причем при свертывании дополнительной панели  в основной 

панели остается кнопка последнего выбранного инструмента. На рис. 4 

показаны все дополнительные панели кнопок. 

 

Рабочая область рисования 5 (рис. 1) занимает практически все окно 

документа. Рисовать можно в любой ее точке, но на печатающее устройство 

будут выведены только те объекты, которые расположены на Странице 

документа 6 (рис. 1). 

 

Навигатор страниц документа 16 (рис. 1) включает набор элементов 

управления страниц активного документа. Обычно он совмещен по строке с 

горизонтальной линейкой прокрутки. 

 

Навигатор документа 10 (рис. 1) представляет собой небольшой белый 

значок квадратной формы, который находится в правом нижнем углу 

рабочего окна документа (в месте стыка полос прокрутки). Он позволяет 

регулировать рабочую область рисования документа путем перемещения 

рамки, очерчивающей исходную область. Если щелкнуть мышью по кнопке 

навигатора, появится маленькое изображение всей рабочей области 

документа и рамка, с помощью которой удобно перемещаться и находить 

нужный объект. 

 

Метрические линейки расположены по верхней и левой стороне 

рабочей области для рисования. В месте их стыковки расположена кнопка . 

Перетащив ее в нужную точку изображения, можно перенести туда начало 

отсчета. 
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Рис. 4. Панель инструментов рисования со всеми 

дополнительными панелями: 

1 – указатель (Pick Tool); 2 – форма (Shape Tool); 3 – обрезка (); 4 – масштаб 

(Zoom Tool); 

5 – свободная форма (); 6 – интеллектуальная заливка (); 7 – прямоугольник 

(Rectangle Tool);  8 – эллипс (Ellipse Tool); 9 – многоугольник (); 10 – 

основные фигуры (); 

11 – текст (); 12 – инструменты таблицы (); 13 – параллельный размер (); 14 

– прямая соединительная линия (); 15 – перетекание (); 16 – цветовая 

пипетка (); 17 – перо контура (Outline Tool); 18 – заливка (Fill Tool); 19 – 

интерактивная заливка (Interactive Fill Tool) 
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МАРКЕРЫ ОБЪЕКТА ПРОГРАММЫ CorelDraw X5 

Объект на изображении выделяют инструментом Указатель (Pick Tool) 

– кнопка  на панели инструментов рисования. После первого щелчка этим 

инструментом по объекту около него появляются маркеры следующего вида 

(рис. 1): 

                       
               

          Рис.1. маркеры в режиме выделения 

 

 черные квадратики – маркеры размеров, определяют 

прямоугольную область вокруг объекта. С их помощью можно 

изменять размеры объекта: за угловые – пропорционально по 

высоте и ширине, за боковые – не пропорционально; 

 белые квадратики (узелки) – маркеры формы, используются для 

изменения формы объекта; 

 крест – задает центр объекта. С его помощью можно 

перетаскивать объект. 

Если по выделенному объекту еще раз щелкнуть инструментом 

Указатель (Pick Tool), то появятся другие маркеры (рис. 2): 

 прямые горизонтальные и вертикальные двунаправленные 

стрелки – маркеры деформации, используются для скоса, 

искажения объекта в указанных направлениях; 

 круг с точкой в центре – определяет центр вращения объекта, его 

можно перетаскивать; 

 кривые двунаправленные стрелки – маркеры вращения, 

используются для вращения объекта относительно центра 

вращения. 

                                             
 

                        Рис. 2. Маркеры в режиме вращения 
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ИНСТРУМЕНТЫ РАБОТЫ С ЦВЕТОМ 

В цветовом оформлении объекта выделяют заливку (цвет внутренней 

части объекта) и контур (цвет контура или обводки объекта). Для простого 

окрашивания выделенного объекта соответствующие цвета выбирают из 

цветовой палитры. 

Цвета назначают щелчком мыши: левой кнопкой назначают цвет 

заливки, правой – контура. 

После выполнения этих операций объект и его контур будут окрашены 

в выбранные цвета, а информация об этих цветах появится в строке 

состояния. 

Перетаскивая кнопку выбранного цвета на любой, даже не выделенный 

объект, можно поменять цвета заливки или контура. В зависимости от того, 

куда при перетаскивании указывает стрелка указателя мыши, около него 

появляется изображение заливки либо контура. 

Для тех случаев, когда в заливке нужно повторить какие-то цвета 

рисунка, в панели инструментов рисования присутствуют два инструмента 

Ведро краски (Paint bucket Tool) и Пипетка (Eyedropper Tool) (кнопка ). 

Пипеткой (Eyedropper Tool) с рисунка берется нужный цвет, а Ведро краски 

(Paint bucket Tool) закрашивает этим цветом указанный объект. Причем если 

рядом с курсором инструмента  Ведро краски (Paint bucket Tool) появляется 

закрашенный квадрат, то будет проводиться заливка объекта, а если 

появляется контур, то будет окрашиваться только контур объекта. 

Для получения более сложных цветовых заливок используется 

инструмент Заливка (Fill Tool) (кнопка ). На рис.1 представлена 

дополнительная панель этого инструмента. Кнопки панели позволяют 

выбирать тип заливки и настроить ее параметры. 

 

 
 

Рис.1.  Панель инструмента  Заливка (Fill Tool) 

Чтобы получить больше вариантов оформления контура объекта, 

используют инструмент Контур (Outline Tool) (кнопка ) панели 

инструментов рисования. 
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ОДНОРОДНАЯ ЗАЛИВКА 

Выполнить однородную заливку объекта можно двумя способами: 

1) с помощью цветовой палитры; 

2) с помощью кнопки Диалог однородная заливка (Fill Color Dialog). 

В первом случае объект выделяют и щелкают по образцу выбранного 

цвета на палитре цветов. В результате объект окрасится в нужный цвет. 

Во втором случае цвет заливки задается в диалоговом окне Однородная 

заливка (Uniform Fill), вызываемом кнопкой Диалог однородная заливка (Fill 

Color Dialog). Это окно содержит вкладки Модели (Models), 

Краскосмесители (Mixers) и Палитры (Palettes) (рис. 1). 

 

          
 

                                     а                                                                      б 

 

 
 

в 

 

Рис. 1. Диалоговое окно Однородная заливка (Uniform Fill): 

а – вкладка Модели (Models); б – вкладка Краскосмесители (Mixers);  

в – вкладка Палитры (Palettes) 

Назначение этих вкладок примерно одно и то же – они позволяют 

выбрать необходимый оттенок. 

 

Пример 1. 
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Выполнить однородную заливку эллипса с помощью инструмента 

Диалог однородная заливка (Fill Color Dialog) группы инструментов Заливка 

(Fill Tool). 

 

1. Выделить эллипс. 

2. Выбрать кнопку Диалог однородная заливка (Fill Color Dialog) 

инструмента Заливка (Fill Tool). В открывшемся диалоговом окне 

Однородная заливка (Uniform Fill) выбрать нужный цвет и 

нажать ОК. 

    В результате выделенный эллипс будет залит выбранным цветом 

(рис. 2). 
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Рис. 2. Выполнение однородной заливки 

 с помощью цветовой палитры: 

а – выделенный объект; б – выполненная заливка 

 

 

 

ГРАДИЕНТНАЯ  (ФОНТАННАЯ)  ЗАЛИВКА 

Градиентная (фонтанная) заливка объекта изображения основана на 

плавных переходах между цветами. В программе CorelDRAW X5 

предлагаются четыре типа градиентной заливки: линейная, радиальная, 

коническая и квадратная. 

Градиентная (фонтанная) заливка выполняется при помощи кнопки 

Диалог фонтанная заливка (Fountain Fill Dialog) инструмента Заливка (Fill 

Tool). В диалоговом окне Фонтанная заливка (Fountain Fill) настраиваются 

все параметры будущей заливки (рис. 1): 

 в поле Тип (Type) – тип заливки (линейная, радиальная, 

коническая и квадратная); 

 в группе Цветовой переход (Color blend) – вид градиента (два 

цвета, выборочный); 

 в полях Из (From) и В (To) – начальный и конечный цвета 

градиента; 
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 в поле  Центр (Mid-point) – положение границы смешивания двух 

цветов. 

 

 
 

Рис. 1. Диалоговое окно Фонтанная заливка (Fountain Fill) 

 

Интересные градиентные заливки можно получить, изменяя в 

диалоговом окне Фонтанная заливка (Fountain Fill) следующие настройки: 

 параметр Угол (Angle) изменяет наклон линии, используемой при 

создании градиента (например, линии, соединяющей начальный 

и конечный цвета); 

 кнопка  - цвета от начального к конечному для построения 

градиента будут выбираться  в цветовом круге по прямой (в 

образце цветового круга этот переход будет отмечен прямой 

линией); 

 кнопка  - цвета от начального к конечному для построения 

градиента будут выбираться  в цветовом круге против часовой 

стрелки (в образце цветового круга этот переход будет отмечен 

кривой); 

 кнопка  - цвета от начального к конечному для построения 

градиента будут выбираться  в цветовом круге по часовой 

стрелке (в образце цветового круга этот переход будет отмечен 

кривой). 

Так, выбрав начальный и конечный цвета, можно получить различные 

градиентные заливки. 

 

 

Пример 1. 

Выполнить градиентную радиальную заливку эллипса в два цвета по 

прямой, сместив центр градиента (рис. 2) 
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Рис. 2. Выполнение градиентной радиальной заливки 

 

1. Выделить эллипс. 

2. Выбрать инструмент Диалог фонтанная заливка (Fountain Fill 

Dialog) инструмента Заливка (Fill Tool). 

3. В диалоговом окне Фонтанная заливка (Fountain Fill) в поле Тип 

(Type) выбрать Радиальная (Radial); в группе Цветовой переход 

(Color blend) установит флажок Два цвета (Two color); в списке из 

поля Из (From) выбрать красный цвет, а в списке поля В (To) – 

желтый. В квадрате  с образцом перехода цветов прижать желтый 

центр и перетащить его немного влево и вверх, смещая таким 

образом центр окружности. Нажать кнопку ОК. 

В результате этих действий выполнится градиентная радиальная  

заливка выделенного эллипса с плавным переходом от красного цвета к 

желтому. 

Пример 2. 

Выполнить градиентную коническую заливку эллипса в два цвета 

против часовой стрелки (рис. 3). 

 

 
 

Рис. 3. Выполнение градиентной конической заливки 

 

1. Выделить эллипс. 

2. Выбрать инструмент Диалог фонтанная заливка (Fountain Fill 

Dialog) инструмента Заливка (Fill Tool). 

3. В диалоговом окне Фонтанная заливка (Fountain Fill) в поле Тип 

(Type) выбрать Коническая (Conical); в группе Цветовой переход 

(Color blend) установит флажок Два цвета (Two color); в списке из 

поля Из (From) выбрать красный цвет, а в списке поля В (To) – 

желтый. Нажать кнопки   и ОК. 
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В результате этих действий выполнится градиентная коническая 

заливка выделенного эллипса с переходом от красного цвета к желтому 

против часовой стрелки по конической поверхности. 

Градиентные заливки остальных типов выполняются аналогично. 

 

 

ЗАЛИВКА УЗОРОМ И ТЕКСТУРОЙ 

Для заливки объекта узором используется диалоговое окно Заливка 

узором (Pattern Fill)  (рис. 1). 

 

 

 
 

Рис. 1. Диалоговое окно Заливка узором (Pattern Fill) 

 

 

Программа CorelDRAW  X5 предлагает большой набор заготовок, 

которые разбиты на три категории: 

 Двухцветные – флажок 2-цветный (2-color) – узоры из линий, 

окружностей, прямоугольников, листочков, сердечек и т. п. Цвета 

выбираются в списках полей Основной и Фоновый  диалогового 

окна Заливка узором (Pattern Fill); 

 полноцветные – флажок Полноцветный (Full color) – узоры из 

более сложных полноцветных элементов (снежинок, зайчиков и 

др.); 

 растровые – флажок Растр (Bitmap) – более сложные фоновые 

узоры, состоящие из мелких деталей. 

Для создания заливки может быть использован любой растровый узор, 

хранящийся в файле. Файл загружается с помощью кнопки Загрузить 

(Load…). 

Выбранный узор можно преобразовать с помощью различных 

параметров диалогового окна Заливка узором (Pattern Fill). 

Пример 1. 
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Выполнить заливку эллипса двухцветным узором (рис. 2). 

 

 
 

Рис. 2. Пример заливки двухцветным узором 

 

1. Выделить эллипс. 

2. Выбрать инструмент Диалог заливка узором (Pattern Fill Dialog) 

инструмента Заливка (Fill Tool). 

3. В диалоговом окне Заливка узором (Pattern Fill) включить 

флажок 2-цветный (2-color), выбрать узор (кленовые листья), два 

цвета (зеленый - для рисунка, желтый – для фона). Изменить 

значение параметров групп Размер (Size), Преобразование 

(Transform), Сдвиг ряда или столбца (Row or column offset) и 

нажать кнопку ОК. 

В результате этих действий  эллипс будет залит выбранным и 

преобразованным узором. 

Заливка полноцветным или растровым узором выполняется аналогично. 

Также выполняется и заливка текстурой (рис. 3). 

 

           
 

                                   а                                                                          б 

Рис. 3. Пример заливки текстурой: 

а – диалоговое окно Заливка текстурой; б – готовая заливка 
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ИНТЕРАКТИВНАЯ ЗАЛИВКА СЕТКОЙ 

Чтобы залить объект частями, используют инструмент Интерактивная 

заливка сеткой (Interactive Mesh Fill Tool) (кнопки  на панели 

инструментов). Этот инструмент покрывает объект сеткой (рис. 1, а), 

количество столбцов и строк которой задается на панели свойств 

инструмента. Затем пользователь выделяет некоторые ячейки сетки и 

выбирает цвета для их заливки. Ячейки заливаются градиентно. Цветовые 

оттенки области заливки объекта определяются положением узлов сетки. 

 

 

Пример 1. 

Выполнить заливку овала по сетке. 

 

1. Выделить эллипс. 

2. Выбрать инструмент Интерактивная заливка сеткой (Interactive 

Mesh Fill Tool). Выделенный эллипс покроется сеткой. В панели 

свойств инструмента указать число столбцов – 4, число строк – 4. 

Сетка примет нужные размеры (рис. 1, а). 

3. Выделить ячейку сетки щелчком мыши и выбрать цвет в палитре. 

Объект перекрасится в ячейке и около нее. Выбрать другие 

ячейки и указать для них другие цвета. 

В результате этих действий эллипс будет залит сложной градиентной 

заливкой (рис. 1, в). 

 

 

 

 
 

               а                                                          б                                  в 

 

Рис. 1. Выполнение интерактивной заливки по сетке: 

а – панель настройки; б – сетка;  в – готовая з 
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ЦВЕТОВОЕ ОФОРМЛЕНИЕ КОНТУРА ОБЪЕКТА 

Чтобы залить цвет контура, существует два способа: 

1) с помощью палитры цветов; 

2) с помощью инструмента Перо абриса (Контур) (Outline Tool). 

В первом случае объект выделяют , а затем щелкают правой кнопкой 

мыши по нужному цвету. 

Инструмент Перо абриса (Outline Tool) (кнопка ) и его 

дополнительная кнопочная панель (рис. 1) дают гораздо больше 

возможностей. 

 

 

 
 

Рис. 1. Кнопочная панель инструмента Перо абриса (Outline Tool) 

 

 

Инструмент Диалог перо абриса (Outline Pen Dialog) (кнопка  ) 

открывает диалоговое окно (рис. 2), в котором можно задать следующие 

параметры: 

 Цвет (Color) – задает цвет контура; 

 Ширина (Wight) – толщину линии; 

 Стиль (Style) – вид линии (сплошная, пунктир, штрихпунктир); 

 Стрелки (Arrows) – вид начала и окончания линии (стрелка и т. 

п.); 

 Каллиграфия (Calligraphy) – зависимость вида линии от вида 

инструмента и способа рисования и т.д. 
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Рис. 2. Диалоговое окно Перо абриса (Outline Tool) 

 

 

 

Пример 1.  

Выполнить контур эллипса прерывистой зеленой линией толщиной 

2,822 мм. 

 

1. Выделить эллипс. 

2. Выбрать инструмент Диалог перо абриса (Outline Pen Dialog) и в 

диалоговом окне в поле Цвет (Color) выбрать зеленый цвет, в 

поле Ширина (Wight) – 2,822, Стиль (Style) – какую-нибудь 

прерывистую линию и нажать кнопку ОК. 

В результате этих действий контур выделенного эллипса станет 

прерывистой зеленой линией толщиной 2,822 мм (рис. 3). 

 

 
 

Рис. 3. Пример оформления контура объекта 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 133 

ИНСТРУМЕНТЫ СОПРОВОЖДЕНИЯ 

Для начала рассмотрим инструменты панели рисования, необходимые 

при работе с другими инструментами. 

Инструмент Указатель (Pick Tool)  (кнопка  на панели 

инструментов) предназначен для выделения одного или нескольких объектов, 

перемещения выбранного объекта по области документа, перехода к 

трансформации объекта (масштабированию, повороту и наклону). Можно 

выделить все нарисованные объекты, очертив вокруг них прямоугольную 

рамку инструментом Указатель (Pick Tool). При нажатой клавише Shift 

объекты можно выделять выборочно один за другим. Если дважды щелкнуть 

по кнопке этого инструмента, то выделяются все незаблокированные 

объекты в рабочей области рисования. 

Инструмент Масштаб (Zoom Tool) (кнопка  ) регулирует масштаб 

изображения страницы документа. Если щелкнуть этим инструментом – 

масштаб увеличится в два раза, а если щелкнуть правой кнопкой мыши (или 

левой при нажатой клавише Shift) – уменьшится в два раза. 

Инструмент Панорама (Hand Tool) (кнопка  ) расположен вместе с 

инструментом Масштаб (Zoom Tool) и позволяет перетаскивать страницу 

документа по рабочей области. Он дублирует работу полос прокрутки окна 

документа. 

 

ИНСТРУМЕНТЫ РИСОВАНИЯ ПРОСТЫХ ФИГУР 

Рассмотрим создание простых фигур (прямоугольника, эллипса, 

многоугольника, готовых автофигур и т. п.) с помощью кнопок панели 

инструментов рисования. 

Прямоугольники с различными закруглениями углов можно рисовать с 

помощью инструмента Прямоугольник (Rectangle Tool) (кнопка ). Если в 

процессе рисования удерживать нажатой клавишу  Shift, то фигура будет 

создаваться от ее центра. При нажатой клавише Ctrl будет формироваться 

квадрат. Создается прямоугольник горизонтально. Чтобы сделать его 

наклонным, нужно применить вращение. Углы прямоугольника можно 

скруглить перемещение углового маркера формы (рис. 1). 

 

 

 

 

 

 

 

 

Рис.1. Примеры прямоугольников 
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Пример 1. 

Нарисовать квадрат со скругленными углами и применить заливку. 

 

1. Инструментом Прямоугольник (Rectangle Tool) нарисовать 

квадрат (рис. 2, а) 

2. Потянув внутрь квадрата угловой маркер формы скруглить углы. 

В каждом углу вместо одного маркера появится два (рис. 2, б). 

3. Инструменто Заливка (Fill Tool) создать градиентную заливку 

(рис. 2, в). 

 

 

 

 

 

 

 

                                               а                                         б                                       в 

 

Рис. 2. Скругление углов квадрата: 

а – исходный прямоугольник; 

 б – прямоугольник со скругленными углами; готовый прямоугольник 

Удобным инструментом для рисования наклонных прямоугольников 

является инструмент 3-точечный прямоугольник (3 Point Rectangle Tool) 

(кнопка ) на дополнительной панели инструмента Прямоугольник 

(Rectangle Tool). Исходная вершина фигуры и наклон одной из ее сторон 

задаются перемещение курсора при нажатой левой кнопке мыши, а размеры 

фигуры – последующим перемещение курсора при отпущенной. Завершается 

создание прямоугольника щелчком мыши. Углы такого прямоугольника 

можно скруглить так же, как и углы простого (рис. 3). 

 

 

 

 

 

 

    

 

 

 

 

Рис. 3. Примеры наклонных прямоугольников 
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Для рисования фигур в виде эллипсов, секторов и дуг (рис. 4) 

используется инструмент Эллипс (Ellipse Tool) (кнопка ) и его панель 

настройки (рис. 5). 

 

 

 

 

 

                             

                            а                                               б                                            в 

                         

Рис. 4. Эллипс (а), сектор (б), дуга (в) 

 

 

 

 
 

Рис.5. Панель настройки инструмента Эллипс (Ellipse Tool) 

 

 

 

 

 

Если в процессе рисования удерживать нажатой клавишу Shift, то 

фигура будет создаваться от е центра. При нажатой клавиши Ctrl будет 

формироваться круг. 

Инструмент 3-точечный эллипс (3Point Ellipse Tool) (кнопка   на 

дополнительной панели инструмента Эллипс (Ellipse Tool) отличается от 

инструмента Эллипс (Ellipse Tool) тем, что формирует фигуру эллипса, 

сектора или дуги под наклоном. Конец одной из осей эллипса и ее наклон 

задаются перемещением курсора при нажатой кнопке мыши. (рис. 6). 

 

 

 

 

 

 

 

 

                                          а                                        б                                    в 

 

Рис. 6. Наклонные эллипс (а); сектор (б), дуга (в) 
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Инструмент Многоугольник (Polygon Tool) (кнопка  ) позволяет 

рисовать фигуры в виде выпуклых и звездчатых многоугольников. Выбор 

типа фигуры и определение числа вершин многоугольника осуществляется в 

панели настройки инструмента (рис. 7). 

 

 
 

Рис. 7. Панель настройки инструмента Многоугольник (Polygon Tool) 

 

 

Пример 2. 

Нарисовать выпуклый пятиугольник и пятиконечную звезду (рис. 8). 

 

1. На панели инструментов рисования выбрать инструмент 

Многоугольник (Polygon Tool). 

2. Для рисования выпуклого пятиугольника (рис. 8, а) в панели 

настроек нажать кнопку Многоугольник (Polygon Tool), а в поле 

Число вершин многоугольника (Number of Points on Polygon) 

установить 5.  Нажав кнопку мыши, растянуть многоугольник до 

нужных размеров. Произвести заливку фигуры. Щелкнуть 

мышью вне области многоугольника. 

3. Для рисования пятиконечной звезды (рис. 8, б) в панели настроек 

нажать кнопку Звезда (Star), Число вершин многоугольника 

(Number of Points on Polygon) выбрать 5. Нажав кнопку мыши, 

растянуть звезду до нужных размеров. Произвести заливку 

фигуры. 

 

 

 

 

 

 

 

 

                                                               а                                           б 

 

Рис. 8. Рисование инструментом Многоугольник (Polygon Tool) 

а – выпуклый пятиугольник; б – пятиконечная звезда 

 

 

Инструмент Спираль ( Spiral Tool) (кнопка   на дополнительной 

панели инструмента Многоугольник (Polygon Tool) используется для 
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рисования фигур в форме спиралей: симметричных (равномерных) и 

логарифмических (рис. 9). 

 

 

 
 

а 

 

 

 

 

 

 

 

                                        б                                                                    в 

 

Рис. 9. Рисование спиралей: 

а – панель настройки инструмента Спираль ( Spiral Tool);  

б– симметричная спираль; в – логарифмическая 

 

 

 

 

 

 

 

В программе CorelDRAW X5 имеется большой набор автофигур, 

которые представлены группами: основные фигуры, стрелки, блок-схемы, 

звезды и сноски. Наборы форм представлены в таблице 1. 

 

Таблица 1 

 

Инструмент  Набор форм Пример 

    

 

  

 

 

Основные фигуры 

(Basic Shapes) 

 

 

 

 

 

 

 

 

 

Стрелки 
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(Arrow Shapes) 

 
 

 

 

 

 

 

 

 

 

Блок-схемы 

(Flowchart Shapes)  

 

  

 

 

 

 

 

 

Фигуры баннера 

  

 

 

 

 

 

 

 

 

 

 

 

 

Фигуры выносок 

(Callout Shapes) 

  

 
 

 

 

 

Инструменты для работы с этими формами собраны в дополнительной 

панели инструмента Основные фигуры (Basic Shapes) (кнопка ) (рис. 10). 

Чтобы нарисовать такую фигуру, на панели свойств нажимают кнопку 

нужной группы, которая раскрывает набор форм. Из этого набора выбирают 

инструмент нужной формы и стиль контура и обычным способом создают 

объект. 

 
 

Рис. 10. Панель инструмента Основные фигуры (Basic Shapes) 
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ИНСТРУМЕНТЫ РИСОВАНИЯ ЛИНИЙ 

В программе CorelDRAW  есть много интересных инструментов для 

выполнения сложных операций рисования. Эти инструменты собраны в 

дополнительной панели инструмента Свободная форма (Freehand Tool) 

(рис.1). Рассмотрим некоторые из них. 

 

 
 

Рис. 1. Панель инструмента Свободная форма (Freehand Tool) 

 

Инструмент Свободная форма (Freehand Tool) (кнопка ) 

предназначен для рисования произвольных линий: прямых и кривых (рис. 2). 

 

 

                        
 

                                     а                                                                б 

 

Рис. 2. Примеры линий:  

а – кривая; б – прямые 

 

Чтобы создать кривую линию, нужно выбрать инструмент Свободная 

форма (Freehand Tool), нажать кнопку мыши в начальной точке линии и 

перетаскивать курсор до конца намеченной кривой. После этого следует 

отпустить кнопку мыши. Дальше можно исправить форму кривой, 

перетаскивая ее узелки. Можно применить к кривой линии инструмент 

Форма (Shape Tool) и, удаляя или добавляя узлы, довести линии до 

совершенства. 

Чтобы провести прямую линию, нужно щелкнуть указателем 

инструмента Свободная форма (Freehand Tool) в начальной точке прямой, 

потом отпустить кнопку мыши и щелкнуть в конечной точке прямой. Прямая 

линия будет создана между этими точками. 
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Пример 1. 

Нарисовать сердечко с помощью инструмента Свободная форма 

(Freehand Tool) (рис. 3). 

 

1. Выбрать инструмент Свободная форма (Freehand Tool) и 

нарисовать замкнутую кривую линию в виде сердечка. 

2. Выбрать инструмент Форма (Shape Tool) и исправить неровности 

изображения удалением лишних узлов. В результате линия 

сердечка станет плавной (рис. 3, а). 

3. Применить к полученному изображению градиентную заливку 

двух цветов: красного и желтого (рис. 3,б). 

 

                      
 

                                            а                                                               б 

 

Рис. 3. Рисование инструментом Свободная форма (Freehand Tool): 

а – удаление лишних узлов контура; б – готовое сердечко 

 

 

 

Инструмент Безье (Bezier Tool) (кнопка ) используется для 

формирования кривых Безье. Форма такой линии задается с помощью 

щелчков мышью в местах размещения ее узлов и последующей регулировки 

контрольных отрезков, которые относятся к данному узлу. Инструментом 

Безье (Bezier Tool) можно рисовать как кривые, так и прямые линии (рис. 4). 

 

             
 

Рис. 4. Примеры кривых Безье 

 

 

 

Пример 2.  
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Нарисовать сердечко с помощью инструмента Безье (Bezier Tool) 

(рис.5). 

 

1. Выбрать инструмент Безье (Bezier Tool). Поставить первую точку 

кривой, далее, не отпуская кнопки мыши, изменить в нужном 

направлении касательную и отпустить кнопку мыши. Нажать 

кнопку мыши во второй точке и, изменяя в нужном направлении 

пару касательных, получить некоторый изгиб кривой (рис. 5, а). 

Затем поставить третью точку и т. д. до образования рисунка 

сердечка (рис. 5, б). 

2. Нажимая и удерживая клавишу  Alt, откорректировать положение 

узлов кривой. 

3. Завершить рисование сердечка двойным щелчком мыши. 

4. Применить градиентную заливку двух цветов: красного и 

желтого (рис. 5, в). 

 

 

 

 

 

 

 

                                       а                            б                                    в 

 

Рис. 5. Рисование инструментом Безье (Bezier Tool): 

а– начало рисования; б – замкнутый контур; в – готовое сердечко 

 

 

Инструментом Художественное оформление (Artistic Media Tool)  

(кнопка ) состоит из пяти дополнительных инструментов, которые 

находятся на панели этого инструмента (рис. 6): Заготовка (Preset), Кисть 

(Brush), Пульверизатор (Sprayer), Каллиграфия (Calligraphic), Перо с 

нажимом (Pressure). Рассмотрим подробнее некоторые из них. 

 

 
 

Рис. 6. Панель инструментов Художественное оформление (Artistic 

Media Tool): 

1 - Заготовка (Preset), 2 - Кисть (Brush), 3 - Пульверизатор (Sprayer),  

4 - Каллиграфия (Calligraphic), 5 - Перо с нажимом (Pressure) 
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Инструмент Заготовка (Preset) предназначен для создания фигурной 

линии заданного профиля. На рис. 7, а показана панель настройки: справа 

выбирается тип мазка, левее – его размеры. Форма кисти меняется в 

зависимости от типа мазка. 

 

 
 

а 

 
 

 

б 

 

Рис. 7. Панель настройки инструмента Заготовка (Preset) (а) 

и пример мазка (б) 

 

 

Пример 3. 

Нарисовать сердечко с помощью инструмента Заготовка (Preset) (рис.8). 

1. Выбрать инструмент Заготовка (Preset). На панели настройки 

задать тип мазка и его размеры. 

2. Провести линии из которых будет состоять сердечко, так, чтобы 

они касались друг друга и сразу образовали форму сердечка 

(рис.8, а). 

3. Применить однородную заливку красного цвета (рис. 8, б). 

 

                           
                                           

                                         а                                                            б 

 

Рис. 8. Рисование инструментом Заготовка (Preset) 

а – отдельные линии; б – готовое сердечко 
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Инструмент Кисть (Brush) позволяет рисовать готовыми текстурами и 

заливками. На рис. 9, а показана панель настройки: справа выбирается тип 

кисти в виде готовой текстуры или градиентной заливки, а левее – ее 

размеры. 

 

 
 

а 

 

 
б 

 

Рис. 9. Рисование инструментом Кисть (Brush): 

а – панель настройки; б – образцы линий 

 

 

Рисуют инструментом Кисть (Brush) так же, как и инструментом 

Заготовка (Preset). Примеры объектов, нарисованных инструментом Кисть 

(Brush), приведены на рис. 10. 

 

 
 

Рис. 10. Примеры рисования тнструментом Кисть (Brush) 

 

Инструмент Пульверизатор (Sprayer) помещает изображения вдоль 

контурной линии. Каждое изображение может состоять не из одного, а из 

нескольких рисунков, следующих друг за другом случайным образом или в 

определенной последовательности. На его панели настройки (рис. 11) 

расположены шкала масштаба и поля, где можно задать угол поворота и 

чередование рисунков (случайное, последовательное в одном направлении). 
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Там же находится библиотека рисунков. Примеры изображений из 

библиотеки показаны на рис. 12. 

 

 

 
 

Рис. 11. Панель настройки инструмента Пульверизатор (Sprayer) 

 

 

               
 

Рис. 12. Примеры изображений из библиотеки Пульверизатор (Sprayer) 

 

 

Инструмент Каллиграфия (Calligraphic) используется для рисования 

фигурной линии, толщина которой зависит от угла наклона к горизонтальной 

оси. Инструмент имитирует рисование линии пером, чувствительным к 

нажиму. 

На панели настройки инструмента (рис. 13, а) можно установить 

параметры пера: сглаживание, толщину пера и угол наклона. 

 

 
 

а 

 
 

 
 

 

б 

 

Рис. 13. Панель настройки инструмента Каллиграфия (Calligraphic): 
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а – панель настройки; б – пример написания слов 

 

Пример 4. 

Напишите каллиграфическим пером слово Зима и примените заливку 

текстурой (рис. 14). 

 

1. Выбрать инструмент Каллиграфия (Calligraphic) и на панели 

настройки задать параметры пера: сглаживание – 100, толщина 

пера – 50,00 мм, угол наклона пера – 35,0 градуса. 

2. Написать слово Зима, не отпуская клавиши мыши или каждую 

букву отдельно (рис. 14, а). 

3. Выделит все слово инструментом Указатель (Pick Tool) и 

применить заливку текстурой. Текстуру желательно подобрать в 

соответствии со значение слова. 

4.  Для изменения цвета контура щелкнуть правой кнопкой мыши 

по голубому цвету на палитре (рис. 14  б). 

 

 
 

а 

 
 

б 

 

Рис.  14. Рисование инструментом Каллиграфия (Calligraphic): 

а – написание слова; б – готовая композиция 

 

 

Следующий инструмент панели рисования Перо (Pen Tool) (кнопка 

), так же как инструмент Безье (Bezier Tool), используется для 

формирования контура Безье с помощью узлов и контрольных точек. 

Двойной щелчок мышью заканчивает формирование линии объекта. По 

умолчанию на панели настрое инструмента активна кнопка  

Автоматическое добавление или удаление узлов (Auto Add-Delete), которая 
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позволяет в процессе рисования добавлять или удалять узлы формы. Чтобы 

добавить узел на линию, нужно подвести курсор к линии в нужном месте 

(около указателя появится знак +) и щелкнуть мышью. Чтобы удалить узел, 

нужно подвести к нему указатель (около указателя появится знак -) и 

щелкнуть мышью. Более сложную работу с формой объекта удобно 

проводить инструментом Форма (Shape Tool). 

Инструмент Ломаная линия (Polyline) (кнопка ) позволяет рисовать 

комбинированные линии, состоящие из прямолинейных и криволинейных 

участков (рис. 15). Прямолинейные участки формируются 

последовательными щелчками мыши, криволинейные – перемещением 

курсора при нажатой кнопке мыши. Двойной щелчок мышью заканчивает 

формирование объекта. 

 

           
 

Рис. 15. Пример комбинированной линии 

 

 

 

 

ИНСТРУМЕНТЫ ДЛЯ ОБРАБОТКИ ФОРМЫ ОБЪЕКТА 

 

Рассмотрим инструменты для обработки формы объекта (рис. 1). 

 

                    
 

Рис. 1. Инструменты для обработки формы объекта 

 

Инструмент Нож (Knife Tool) (кнопка ) разрезает простые объекты 

(кроме сгруппированных). Он разбивает объект с замкнутым контуром на 

части по произвольной линии, задаваемой пользователем. При выполнении 

этой операции нож должен стоять вертикально. Объект пред разрезанием 

выделять не нужно. 

 

Пример 1. 
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Разрезать шар на части по произвольной кривой (рис. 2). 

 

1. Нарисовать окружность и применить к ней градиентную заливку 

в два цвета (рис. 2, а). 

2. Не выделяя объект, выбрать инструмент Нож (Knife Tool) и 

установить его на контур шара. Нож должен принять 

вертикальное положение. 

3. Прижать кнопку мыши и, не отпуская ее, провести линию разреза 

до другой точки контура. Нож должен опять принять 

вертикальное положение (рис. 2, б). Если нож не становится 

вертикально, значит инструмент не достиг контура объекта. 

4. Каждая часть разрезанного объекта представляет собой 

самостоятельный объект. Чтобы убедиться в этом, переместить 

одну из его частей (рис. 2, в). 

 

                         
 

                          а                                            б                                             в 

Рис. 2. Разрезание шара: 

а – исходный шар; б – линия разреза; в – результат 

Инструмент Ластик (Eraser Tool), как и инструмент Нож (Knife Tool), 

выполняет действие с простыми объектами (кроме сгруппированных). Он 

стирает линии и части объектов. Форму и размер (толщину) ластика можно 

задать на панели настройки (рис. 3). Есть две формы ластика: круг и квадрат. 

Нужная выбирается щелчком по кнопке с белым кругом (квадратом). Для 

работы инструмента Ластик (Eraser Tool) объект необходимо выделить. 

 

 
 

Рис. 3.  Панель настройки инструмента Ластик (Eraser Tool) 

 

 

Пример 2. 

К нарисованному объекту применить инструмент Ластик (Eraser Tool), 

как показано на рис. 4. 
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1. Нарисовать окружность и применить к ней градиентную 

радиальную заливку в два цвета. Объект должен остаться 

выделенным. 

2. Выбрать толщину ластика (например, 4,5 мм) и форму (круг). 

Нарисовать поверх объекта какие-нибудь линии (рис. 4, а). 

3. Выбрать квадратную форму ластика и нарисовать какие-нибудь 

линии (рис. 4, б). 

 

 

 

 

 

 

 

                                           а                                                            б 

 

Рис. 4. Пример работы инструмента Ластик (Eraser Tool) 

 

 

Инструмент Фигура (Shape Tool) (кнопка ) предназначен для работы 

с формой объекта. Используя его, можно исправлять рисунок, менять его вид, 

добавляя или убирая узелки. 

 

 

 

 

 

Инструмент Размазывающая кисть (Smudge Brush) изменяет, 

«размазывает» контур объекта (рис. 5). Он имеет эллиптическую форму, 

параметры которой регулируются на панели настройки. 

При работе инструмент активируют, а затем, нажав кнопку мыши, 

проводят по контуру объекта, как бы размазывая его. 
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Рис. 5. Пример работы инструмента Размазывающая кисть (Smudge 

Brush) 

 

 

Инструмент Грубая кисть (Roughen Brush) сформировать зубцы на 

контуре объекта (рис. 6). Их параметры задаются на панели настройки. При 

работе инструмент активируют, а затем перемещают вдоль выбранного 

участка контура при нажатой кнопке мыши. 

 

 
 

Рис. 6. Пример работы инструмента Грубая кисть (Roughen Brush) 

 

 

Инструмент Свободное преобразование (Free Transform Tool) 

предназначен для трансформации выделенного объекта. На его панели 

настройки (рис. 7) можно выбрать следующие действия над объектом: 

Свободное вращение (Free Rotation Tool), Отражение под произвольным 

углом (Free Angle Reflection Tool), Свободное изменение масштаба (Free 

Scale Tool), Свободный наклон (Free Skew Tool). Здесь же задаются 

настройки для каждого действия. 

 

 

 

 

 

 

 

 

Рис. 7. Панель настройки инструмента Свободное преобразование (Free 

Transform Tool): 

1 - Свободное вращение (Free Rotation Tool), 2 - Отражение под 

произвольным углом (Free Angle Reflection Tool), 3 - Свободное изменение 

масштаба (Free Scale Tool), 4 - Свободный наклон (Free Skew Tool) 

 

 

Пример 3.  

Применить к нарисованному объекту инструмент Свободное 

преобразование (Free Transform Tool) (рис. 8). 

1 2 3 4 
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1. Нарисовать объект, применить к нему градиентную заливку в два 

цвета: красный и желтый (рис. 8, а). Выделить объект и создать 

еще три копии. 

2. Выделить второй объект. Выбрать инструмент  Свободное 

преобразование (Free Transform Tool). На панели настроек 

выбрать действие Свободное вращение (Free Rotation Tool) и 

задать на панели настройки новые параметры. Полученное 

изображение показано на рис. 8, б. 

3. Выделить третий объект. На панели настроек выбрать действие 

Отражение под произвольным углом (Free Angle Reflection Tool) 

и задать новые параметры. Полученное изображение показано на 

рис. 8, в. 

4. Выделить четвертый объект. На панели настроек выбрать 

действие Свободное изменение масштаба (Free Scale Tool) и 

задать новые параметры. Полученное изображение показано на 

рис. 8, г. 

5. Выделить пятый объект. На панели настроек выбрать действие 

Свободный наклон (Free Skew Tool) и задать новые параметры. 

Полученное изображение показано на рис. 8, д. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                   а                             б                              в                   г                          

д 

                

Рис. 8. Примеры действия инструмента Свободное преобразование  

(Free Transform Tool): 

а – исходное изображение; б - Свободное вращение (Free Rotation Tool); 

 в - Отражение под произвольным углом (Free Angle Reflection Tool);  

г - Свободное изменение масштаба (Free Scale Tool);  

д - Свободный наклон (Free Skew Tool) 
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ОПЕРАЦИИ ОБЪЕДИНЕНИЯ НЕСКОЛЬКИХ ОБЪЕКТОВ 

 

При работе с несколькими объектами часто возникает необходимость 

их объединить. Под объединением мы будем понимать некоторую операцию 

по созданию нового объекта, полученного в результате взаимодействия 

выбранных объектов. В программе CorelDRAW X5 применяются следующие 

операции объединения: Объединение (Weld), Подгонка (Trim), Пересечение 

(Intersect), Упрощение (Simplify), Передние минус задние (Front Minus Back), 

Задние минус передние (Back Minus Front). Кнопки этих операций 

появляются на панели настройки инструмента Указатель (Pick Tool), если 

выделено более одного объекта (рис. 1). 

 

 

 

 

 

 

 

Рис. 1. Кнопки операций объединения 

на панели настройки инструмента Указатель (Pick Tool): 

1 - Объединение (Weld); 2 - Подгонка (Trim); 3 - Пересечение (Intersect);         

4 - Упрощение (Simplify); 5 - Передние минус задние (Front Minus 

Back); 

 6 - Задние минус передние (Back Minus Front) 

 

 

 

Выполнить операции объединения объектов можно и по цепочке 

команд Упорядочить → Формирование (Arrange → Shaping), выбрав в 

дополнительном меню один из предложенных вариантов (рис. 2). 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 2. Меню команды Формирование (Shaping) 
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Рассмотрим действия формирования на примере исходного 

изображения (рис. 3). 

Действие Объединение (Weld) объединяет выделенные объекты в один 

новый объект. При этом заливка и контур передаются ему от последнего 

выделенного объекта (рис. 4). 

Чтобы произвести это действие, выполняют цепочку команд  

Упорядочить → Формирование → Объединение (Arrange → Shaping → Weld) 

или щелкают по кнопке . 

 

 

 
 

 

 

 

 

Рис. 3. Исходное 

изображение 

Рис. 4. Результат 

действия Объединение 

(Weld) 

Рис. 5. Результат 

действия Подгонка 

(Trim) 

 

 

Действие Подгонка (Trim) обрезает невидимые части объекта (то есть 

«спрятанные» под другими объектами). Результат этого действия показан на 

рис. 5. Выполняется оно по цепочке команд Упорядочить → Формирование 

→ Подгонка  (Arrange → Shaping → Trim) или щелчком мыши по кнопке 

. 

Действие  Пересечение (Intersect) создает новый объект, образованный 

пересечением выделенных объектов. При этом заливка и контур переходят к 

нему от нижнего объекта (рис. 6). Это действие выполняется по цепочке 

команд Упорядочить → Формирование → Пересечение   (Arrange → Shaping 

→ Intersect) или щелчком по кнопке . 

 

 

 

 

 

 

 

 

                                                 а                                   б  
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Рис. 6. Результат действия Пересечение (Intersect) (а) и новый объект (б) 

 

Действие Упрощение (Simplify) очень похоже на действие Подгонка 

(Trim). Оно также обрезает все скрытые части объектов (рис. 7) и 

выполняется по цепочке команд Упорядочить → Формирование → 

Упрощение    (Arrange → Shaping → Simplify) или щелчком по кнопке . 

Действие Передние минус задние (Front Minus Back) и  Задние минус 

передние (Back Minus Front) производят вычитание: первое – из переднего 

объекта вычитает задний, второе – наоборот, из заднего – передний. 

Действие Передние минус задние (Front Minus Back) выполняется 

цепочкой команд Упорядочить → Формирование →   Передние минус задние  

(Arrange → Shaping → Front Minus Back) или щелчком по кнопке . 

Полученный объект будет представлять собой «остаток» переднего объекта 

(рис. 8, а). 

 

 

 
 

 

                           
                      

                      а                                      б 

 

Рис. 7. Результат действия 

Упрощение (Simplify) 

Рис. 8. Результат действий  

Передние минус задние (Front Minus Back) 

(а)  

и  Задние минус передние (Back Minus 

Front) (б) 

 

 

 

Действие  Задние минус передние (Back Minus Front) выполняется 

цепочкой команд Упорядочить → Формирование →    Задние минус 

передние (Arrange → Shaping → Back Minus Front) или щелчком по кнопке 

. Полученный объект будет представлять слсбой «остаток» заднего 

объекта (рис. 8, б). 
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КОПИРОВАНИЕ,  ДУБЛИРОВАНИЕ И КЛОНИРОВАНИЕ ОБЪЕКТА 

 

Иногда при работе с изображениями возникает необходимость создать 

несколько одинаковых объектов. В этом случае обычно рисуют один объект, 

а затем делают несколько его копий. 

Для копирования объекта можно использовать несколько приемов: 

1) скопировать выделенный объект с помощью команд Копировать 

(Copy) и Вставить (Paste) меню  Правка (Edit); 

2) выделить объект и нажать на числовой клавиатуре клавишу «+» 

(плюс); 

3) нажать правую кнопку мыши при перемещении, повороте или 

растяжении объекта инструментом Указатель (Pick Tool). 

Изменения будут применены к копии, а оригинал останется на 

месте; 

4) перетаскивать объект при нажатой правой кнопке мыши. В 

появившемся меню выбрать команду Переместить сюда (Move 

Here) или Скопировать сюда (Copy Here). 

При использовании первых двух приемов копия появляется точно над 

оригиналом. Ее можно увидеть только, перетащив в другое место. 

В программе CorelDraw есть дополнительные операции для получения 

копий объектов: дублирование и клонирование. Причем они не используют 

буфер обмена и имеют некоторые особенности появления копии и ее 

дальнейших изменений. 

Дублирование выделенного объекта выполняют цепочкой команд 

Правка → Дублировать (Edit → Duplicate). Созданная копия размещается не 

поверх объекта, а с небольшим сдвигом (рис. 1).  

 

                              
 

                                                       а                                                  б  

 

Рис. 1. Дублирование объекта 

 

 

Параметры сдвига копии задаются на панели настройки инструмента 

Указатель (Pick Tool) в группе Дублировать расстояние (Duplicate Distance)  

(рис. 2). Копия-дубль является самостоятельным объектом – дальнейшее 

изменение оригинала не приводит к ее изменению. 
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 Рис. 2. Группа Дублировать расстояние (Duplicate Distance)  

 на панели настройки инструмента Указатель (Pick Tool) 

 

 

Клонирование выделенного объекта выполняют цепочкой команд 

Правка → Клонировать (Edit → Clone). Копия также появляется с небольшим 

сдвигом, но само изображение не является самостоятельным объектом. Клон 

наследует все особенности внешнего вида оригинала: форму, размеры, цвета, 

толщину линии, угол поворота т. д. Если изменять оформление оригинала, то 

автоматически изменяются и все его клоны      (рис. 3). 

 

         

 

 

 

 

Рис. 3. Клонирование объекта 

 

Все копии и дубли клонов являются клонами. 

Применять клонирование удобно, если необходимо создать несколько 

объектов, которые всегда должны оставаться одинаковы. 

 

ВЫРАВНИВАНИЕ И ВЗАИМНОЕ РАСПОЛОЖЕНИЕ ОБЪЕКТОВ 

 

При создании сложных графических изображений большое значение 

имеет расположение объектов относительно друг друга и на странице. 
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Рис. 1. Меню Выровнять и распределить (Align and Distribute) 

 

 

Действия по выравниванию и распределению выделенных объектов 

выполняются цепочкой команд Упорядочить → Выровнять и распределить 

(Arrange → Align and Distribute).  В дополнительном меню (рис. 1) 

выбирается способ выравнивания: 

 по левому краю - Упорядочить → Выровнять и распределить → 

Выровнять влево  (Arrange → Align and Distribute → Align Left);  

 по правому краю - Упорядочить → Выровнять и распределить → 

Выровнять вправо  (Arrange → Align and Distribute → Align Right);  

 по верху - Упорядочить → Выровнять и распределить → 

Выровнять по верху  (Arrange → Align and Distribute → Align 

Top);  

 по низу - Упорядочить → Выровнять и распределить → 

Выровнять по низу  (Arrange → Align and Distribute → Align 

Bottom);  

 центры по горизонтали - Упорядочить → Выровнять и 

распределить → Выровнять центры по горизонтали  (Arrange → 

Align and Distribute → Align Centers Horizontally);  

 центры по вертикали - Упорядочить → Выровнять и 

распределить → Выровнять центры по вертикали  (Arrange → 

Align and Distribute → Align Centers Vertically). 

Обратите внимание на изображения способов выравнивания: они 

показывают, каким образом будет происходить выравнивание (в области 

выделения объектов, по странице и т. п.). Следует также запомнить, что при 

выделении объектов с помощью клавиши Sift на месте  остается объект, 

выделенный последним, а все остальные объекты подравниваются под него. 

 

 

 

Пример 1. 

Выровнять красный прямоугольник и голубой круг по левому краю 

(рис. 2). 

 

1. Создать и выделить указанные объекты (рис. 2, а). 

2. Выполнить цепочку команд Упорядочить → Выровнять и 

распределить → Выровнять вправо  (Arrange → Align and 

Distribute → Align Right). 
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В результате объекты выровняются по правому краю (рис. 2, б). 

 

 

         
 

а                                         б  

 

Рис. 2. Выравнивание объектов по правому краю: 

а – исходное положение объектов; б – выровненные объекты 

 

Пример 2. 

Выровнять центры прямоугольника и круга по вертикали. 

 

1. Создать и выделить указанные объекты (рис. 3, а). 

2. Выполнить цепочку команд Упорядочить → Выровнять и 

распределить → Выровнять центры по горизонтали  (Arrange → 

Align and Distribute → Align Centers Vertically). 

В результате объекты выровняются по своим центрам (рис. 2, б). 

 

                
 

а                                         б  

 

Рис. 3. Выравнивание центров объектов по вертикали: 

а – исходное положение объектов; б – выровненные объекты 

 

 

Перемещение объектов по уровням относительно друг друга (вперед, 

назад, вперед на один, назад на один) выполняются так же, как и при 

рисовании в  Word: объект выделяют, а затем выполняют одну из цепочек 

команд (рис. 4): 
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 Упорядочить → Порядок  → На передний план слоя  (Arrange → 

Order → To Back) – помещает объект поверх всех остальных; 

 Упорядочить → Порядок  → На задний план слоя  (Arrange → 

Order → To Front) – помещает объект позади всех; 

 Упорядочить → Порядок  → На уровень вперед  (Arrange → 

Order → Forward One) – помещает объект на один уровень вперед; 

 Упорядочить → Порядок  → На уровень назад  (Arrange → Order 

→ Back One) – помещает объект на один уровень назад. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 4. Меню команды Порядок (Order) 

 

ГРУППИРОВКА ОБЪЕКТОВ 

Готовое изображение, состоящее из нескольких объектов, удобно 

объединить в один объект. В этом случае при перемещении или других 

операциях взаимное расположение составляющих его объектов изменяться 

не будет. Группировка упрощает работу: сгруппированные объекты 

перемещаются, вращаются, отражаются, а также изменяют свои размеры как 

единый объект. 

Для облегчения работы с объектами используют следующие команды  

меню Упорядочить (Arrange) (рис. 1): 

 Сгруппировать (Group) – объединяет несколько графических объектов 

в одну целостную группу. Для группировки необходимо выделить все 

объекты, а затем выполнить цепочку команд Упорядочить → 

Сгруппировать (Arrange → Group). Сгруппированный объект можно 
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вновь сгруппировать с другими объектами. В результате получится 

новая группа, которая фактически будет многоступенчатой; 

 Отменить группировку (Ungroup) – разделяет один графический объект 

на несколько отдельных объектов, из которых он был сгруппирован 

ранее. Для разгруппировки необходимо выдеоить объект и выполнить 

цепочку команд Упорядочить → Отменить группировку (Arrange → 

Ungroup). Эта команда отменяет только последнюю группировку; 

 Отменить группировку полностью (Ungroup All) – разгруппировывает 

сразу все выделенные группы, в том числе и многоступенчатые. Для 

разгруппировки необходимо выделить объект и выполнить цепочку 

команд Упорядочить → Отменить группировку полностью  (Arrange → 

Ungroup All). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 1. Меню команды Упорядочить (Arrange) 

 

Пример 1. 

Нарисовать кувшин, используя для рисования прямоугольник и овалы, 

применить фонтанную двухцветную заливку (рис. 2). 

 

1. Нарисовать прямоугольник и пять овалов разной величины (рис. 

2, а). 

2. Выделить все объекты и выполнить цепочку команд Упорядочить 

→ Выровнять и распределить → Выровнять центры по 

горизонтали  (Arrange → Align and Distribute → Align Centers 

Vertically) (рис. 2, б). 

3. Не снимая выделения, выполнить цепочку команд Упорядочить 

→ Сгруппировать (Arrange → Group). 

4. Выделить сгруппированный объект и применить к нему 

фонтанную двухцветную заливку. 

Готовый кувшин изображен на рис. 2, в. 
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                              а                                         б                                           в   

 

Рис. 2. Этапы рисования кувшина: 

а – рисование объектов; б – сгруппированные объекты; в – готовый  

 

РАБОТА С ТЕКСТОМ 

Работая с текстом в программе CorelDRAW X5, можно создавать текст 

двух видов: простой и художественный. Редактирование текста выполняется 

достаточно просто. В программу включена поддержка русского языка 

(проверка орфографии, расстановка переносов), поэтому программу 

CorelDRAW X5 можно использовать для компьютерной верстки небольших 

издательских работ (например, цветного буклета объемом в несколько 

страниц) или создания визитных карточек, открыток, этикеток, упаковок. 

Для ввода и обработки текстовой информации предназначен 

инструмент Текст (Text Tool) (кнопка ). 

Чтобы ввести простой текст, следует активировать этот инструмент и, 

удерживая левую кнопку мыши, нарисовать рамку в рабочей области 

рисования (рис. 1). В этой рамке текст будет набираться  и обрабатываться 

точно так же, как текстовом редакторе Word. 
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Рис. 1. Выделенный простой текст 

 

Художественный текст вводится прямо на страницу в месте 

расположениятекстового курсора инструмента Текст (Text Tool). Такой текст 

можно обрабатывать с помощью обычных средств форматирования текста. К 

нему можно применить все виды заливок и эффектов как к векторному 

объекту. 

Возможности работы с текстом собраны в команде меню Текст (Text 

Tool). На панели настройки этого инструмента можно выбрать стиль, вид, 

размер, начертание (полужирный, курсив, подчеркивание) шрифта, вид 

выравнивания текста и т. д. (рис. 2). 

 

 
 

Рис. 2. Панель настройки инструмента Текст (Text Tool) 

 

 

По команде Текст → Средства проверки правописания (Text → Writing 

Tools) открывается подменю (рис. 3), в котором находятся дополнительные 

команды работы с текстом: орфография, грамматика, тезаурус, язык, 

параметры. Выполнение этих действий напоминает аналогичные действия в 

Word. 
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Рис. 3. Меню команды Текст (Text Tool) 

 

 

Текст, как и любой объект, имеет цвет букв и контура. Они задаются 

так же, как цвет контура и заливка векторных объектов. На рис. 4 приведены 

примеры различных заливок текста (однородной, фонтанной, узором, 

текстурой). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 4. Примеры заливок текста 

 

 

 

Иногда необходимо, чтобы текст повторял вид какой-либо линии    (рис. 

5), причем эта линия может быть и не видна. 

Существуют два способа написания текста по кривой: 

1) сначала вводится текст, а затем выбирается путь; 

2) сначала рисуется путь, а затем по нему вводится текст. 

 

 

 

       

 

 

 

 

Рис. 5. Текст  вдоль кривой 

 

Однородная заливка
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В первом случае сначала набирают текст, затем одним из инструментов 

рисования рисуют линию (путь). Далее выделяют текст и выполняют 

цепочку команд Текст → Текст вдоль пути (Text → Fit Text to Path). Курсор 

принимает вид большой черной стрелки, которой и указывают путь. 

Во втором случае сначала рисуют линию (путь). Затем выбирают 

инструмент  Текст (Text Tool) и подводят курсор к кривой и щелчком мыши 

отмечают начало ввода текста. Далее набирают текст, который сразу 

располагается вдоль кривой. 

Если текст не помещается по кривой, можно уменьшить его размер или 

передвинуть вдоль кривой. 

Если снять выделение с текста, а затем щелкнуть инструментом 

Указатель (Pick Tool)  на одном из символов (букве, появится панель 

настройки инструмента) Текст (Text Tool) (рис. 6). На ней можно задать 

различные варианты расположения текста относительно кривой. 

 

 

 

 

 

 

 

 

 

 

 

Рис. 6. Панель настройки инструмента Текст (Text Tool) 

 

 

 

Чтобы сделать линию пути невидимой, ее можно выделить и 

обесцветить (например, сделать контур такого же цвета, что и фон). 

 

 

Пример. 1. 

Написать текст по кривой линии с помощью инструмента Ломаная 

линия (Polyline Tool) (рис. 7). 

 

1. Нарисовать инструментом Ломаная линия (Polyline Tool) 

ломаную линию. 

2. Курсором инструмента Текст (Text Tool) определить начало 

ввода текста, написать текст и выделить его (рис. 7, а). 

3. Выполнить цепочку команд Текст → Текст вдоль пути (Text → 

Fit Text to Path). Появившейся большой черной стрелкой указать 

направление движения текста (путь): подвести острый конец 

стрелки к линии и щелкнуть мышью (рис. 7, б). 
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В результате текст расположится вдоль прямой (рис. 7, в). 

 

 

 

 

 

 

 

                                 а                                        б                                        в 

 

Рис. 7. Размещение текста вдоль кривой: 

а– ввод текста; б – выбор пути; в – итоговое изображение 

 

 

Пример 2. 

Написать текст по кривой линии с помощью инструмента Безье (Bezier 

Tool) (рис. 8). 

1. Нарисовать инструментом инструмента Безье (Bezier Tool) 

кривую линию. 

2. Выбрать инструмент Текст (Text Tool) и щелкнуть мышью по 

кривой. В этом месте появится текстовый курсор (рис. 8, а). 

3. Ввести текст, который расположится вдоль кривой (рис. 8, б). 

4. Снять выделение с текста, а затем щелкнуть инструментом 

Указатель (Pick Tool)  по одному из символов. На панели 

настройки инструмента Текст (Text Tool) в списке Вертикальное 

положение (Vertical Placement) выбрать положение «под линией». 

В результате текст расположится под линией (рис. 8, в). 

 

 

 

 

 

 

 

 

 

                      а                                                    б                                                в  

 

Рис. 8. Размещение текста вдоль кривой: 

А – путь; б – ввод текста; в – текст под кривой 

 

 

 

СОЗДАНИЕ ЭФФЕКТОВ ДЛЯ ВЕКТОРНЫХ ОБЪЕКТОВ 
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Программа CorelDRAW X5  позволяет добавлять к векторным 

объектам тени, перспективу, контуры, переходы из одной формы в другую, 

декоративно изменять форму объекта и т. д. Для создания таких эффектов 

используют команды меню Эффекты (Effects) и группу кнопок на панели 

инструментов рисования (рис. 1). Параметры эффектов задаются на панелях 

настройки этих инструментов. 

 

 
 

Рис. 1. Группы Эффекты (Effects) на панели рисования 

 

Художественный текст обладает теми  же свойствами, что и любой 

другой векторный объект, поэтому мы рассмотрим выполнение 

художественных эффектов на примере текста (рис. 2). 

 

 
 

Рис. 2. Исходный текст 

 

Инструмент Контур (Conrour Tool) (кнопка ) позволяет создавать в 

векторном объекте эффект контура. Для этого сначала выделяют объект, 

затем выбирают инструмент Контур (Conrour Tool), щелкают указателем 

мыши по объекту и начинают перемещение: чем дальше перемещают 

указатель, тем больше контуров получается в результате. Голубая стрелка 

указывает направление созданияконтура (внутрь или наружу). Данный 

инструмент можно применять как к внутренней, так и наружной области 

векторного объекта. 

 

 

Пример 1. 

Применить эффект контура к художественному тексту. 

 

1. Написать художественный текст, применить к нему любую 

заливку и выделить. 

2. На панели инструментов выбрать инструмент Контур (Conrour 

Tool), прижать указатель мыши на выделенном объекте и 

переместить на некоторое расстояние (рис. 3, а). 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 166 

3. На панели настроек задать цвет контура и направление смены 

цветов (по часовой стрелке или против нее) и т.п. 

Готовый эффект показан на рис.3, б. 

 

 

 

 

 

 

          а                                                                         б 

 

Рис. 3. Создание эффекта контура: 

а – создание эффекта; б – готовое изображение 

 

Инструмент Искажение (Distortion Tool) (кнопка ) предназначен для 

формирования в векторном объекте эффекта искажения. Он может быть 

направлен внутрь или наружу. 

Для создания этого эффекта объект выделяют, выбирают инструмент 

Искажение (Distortion Tool), затем прижимают указатель мыши на объекте и 

начинают перемещать его в сторону создания эффекта (показывается 

стрелкой). 

При сильном искажении векторный объект изменяется до 

неузнаваемости, поэтому перемещение указателя мыши должно быть 

минимальным. 

 

 

Пример 2. 

Применить эффект искажения к художественному тексту. 

 

1. Написать художественный текст, применить к нему любую 

заливку и выделить. 

2. Выбрать инструмент Искажение (Distortion Tool), прижать 

указатель мыши на выделенном объекте и немного переместить 

(рис. 4, а). 

3. Параметры эффекта (вид, амплитуда, частота искажения) задать 

на панели настройки инструмента. 

Готовый эффект показан на рис.4, б. 
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а                                                 б  

 

Рис. 4. Эффект искажения: 

а – создание эффекта; б – готовое изображение 

 

Инструмент Оболочка (Envelope) (кнопка ) используется для 

создания в векторном объекте эффекта оболочки, с помощью которой можно 

изменить его форму, перемещая маркеры формы. 

 

 

Пример 3. 

Применить эффект оболочки к художественному тексту. 

 

1. Написать художественный текст, применить к нему любую 

заливку и выделить. 

2. Выбрать инструмент Оболочка (Envelope Tool). Вокруг текста 

образуется рамочка с маркерами. Перемещая их, придать объекту 

некоторое движение (рис. 5, а). 

3. Параметры эффекта задать на панели настройки инструмента. 

Готовый эффект показан на рис. 5, б. 

 

 

 

 

 

 

а                                          б   

 

Рис. 5. Создание эффекта оболочки : 

а – создание эффекта; б – готовое изображение 

 

Инструмент Вытянуть (Extrude Tool) (кнопка ) позволяет 

формировать в векторном объекте эффект вытягивания, имитирующий объем. 

Он создается так же, как эффект Контур (Conrour Tool) и Искажение 

(Distortion Tool). 

 

 

 

 

 

 

Пример 4. 

Применить эффект Вытянуть (Extrude Tool) к художественному тексту. 

 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 168 

 

 

 

 

 

 

 

а                                          б   

 

Рис. 6. Создание эффекта вытягивания : 

а – создание эффекта; б – готовое изображение 

 

1. Написать художественный текст, применить к нему любую 

заливку и выделить. 

2. Выбрать инструмент Вытянуть (Extrude Tool), прижать указатель 

мыши на выделенном объекте и переместить на некоторое 

расстояние (рис. 6, а). 

4. Параметры эффекта задать на панели настройки. 

Готовый эффект показан на рис. 6, б. 

 

 

Инструмент Тень (Drop Shadow Tool) (кнопка ) предназначен для 

формирования тени от объекта. Для этого объект выделяют, выбирают 

инструмент, прижимают указатель мыши на объекте и перемещают в ту 

сторону, куда должна быть направлена тень (указывается стрелкой). 

 

 

Пример. 5. 

Применить эффект тени к художественному тексту. 

 

1. Написать художественный текст, применить к нему любую 

заливку и выделить. 

2. Выбрать инструмент Тень (Drop Shadow Tool), прижать указатель 

мыши на выделенном объекте и переместить на некоторое 

расстояние (рис. 7, а). 

3. Параметры эффекта (направление и цвет тени) задают на панели 

настройки. 

Готовый эффект показан на рис. 7, б. 

 

 

 

 

 

 

а                                          б   
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Рис. 7. Создание тени от объекта : 

а – создание эффекта; б – готовое изображение 

 

 

Инструмент Прозрачность (Transparency Tool) (кнопка ) позволяет 

регулировать уровень прозрачности объекта (градиентного рисунка, формы 

шаблона или мозаичного элемента текстуры и т. п.). 

 

 

Пример 6. 

Применить эффект прозрачности к художественному тексту. 

 

1. Написать художественный текст, применить к нему любую 

заливку и выделить. 

2. Выбрать инструмент Прозрачность (Transparency Tool) и с 

помощью голубой стрелки указать направление образования 

прозрачности (рис. 8, а). 

3. Параметры эффекта (тип, режим прозрачности, угол и ширину 

градиентной прозрачности и др.) задать на панели настройки. 

Готовый эффект показан на рис. 8, б. 

 

 

 

 

а                                          б   

 

Рис. 8. Создание эффекта прозрачности : 

а – создание эффекта; б – готовое изображение 

 

 

Инструмент Перетекание (Blend Tool) (кнопка ) создает эффект 

перетекания между объектами. Из двух исходных векторных объектов, 

расположенных на некотором расстоянии друг от друга, формируется 

комбинированный объект (объект перехода), состоящий из начального и 

конечного объектов и группы промежуточных. 

 

Пример 7. 

Применить эффект перетекания между художественным текстом и 

окружностью. 

 

1. Написать художественный текст и применить к нему любую 

заливку. Нарисовать контур окружности. Выделить текст и 

окружность. 
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4. Выбрать инструмент Перетекание (Blend Tool), прижать 

указатель мыши на выделенном объекте и начать тянуть, 

указывая с помощью голубой стрелки переход от 

художественного текста в окружность  (рис. 9, а). 

5. Параметры эффекта (направление перетекания, число 

промежуточных объектов, направление изменения цветов при 

переходе и др.) задать на панели настройки. 

Готовый эффект показан на рис. 9, б. 

 

 

 

 

 

 

 

 

 

 

а                                          б   

 

Рис. 9. Создание эффекта перетекания : 

а – создание эффекта; б – готовое изображение 

 

СОЗДАНИЕ ЭФФЕКТОВ ДЛЯ РАСТРОВЫХ ОБЪЕКТОВ 

В программе CoreDRAW X5 предусмотрены широкие возможности 

создания художественных эффектов для растровых (битовых) изображений. 

Все команды создания эффектов в растровой графике расположены в 

меню Растровые изображения (Bitmaps), где они сгруппированы в подменю. 

Далее рассмотрим создание некоторых эффектов с помощью команд 

Растровые изображения (Bitmaps) на примере одного изображения (рис. 1). 

 

 
 

Рис. 1. Исходное изображение 
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Чтобы применить эти эффекты, изображение необходимо выделить, а 

затем выполнить цепочку команд Растровые изображения → Преобразовать в 

растровое изображение… (Bitmaps → Convert to Bitmap…). Затем можно 

применять различные эффекты, выбрав их в подменю команды Растровые 

изображения (Bitmaps) (рис. 2). Каждый эффект имеет свое подменю. 
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Рис. 2 Меню команды Растровые изображения (Bitmaps) 

 

 

Эффект Загиб края страницы… (Page Curl…) из группы эффектов  

Трехмерные эффекты (3D Effect) создает изображение в виде листа бумаги, 

один из углов которой завернут. 

В диалоговом окне Загиб края страницы… (Page Curl…) (рис. 3) задают 

параметры эффекта: угол листа, который должен быть завернут, направление 

скручивания, цвет фона, видимого в области завитка и т. д. 

 

 

 
 

Рис. 3. Диалоговое окно Загиб края страницы… (Page Curl…) 

 

 

Пример 1. 

Применить  эффект Загиб края страницы… (Page Curl…) к исходному 

изображению. 

 

1. Вставить изображение из буфера обмена и выделить его. 

2. Выполнить цепочку команд Растровые изображения → 

Трехмерные эффекты → Загиб края страницы… (Bitmaps  → 3D 

Effect → Page Curl…). В появившемся диалоговом окне задать 

параметры эффекта. 

Результат применения эффекта Загиб края страницы… (Page Curl…) 

показан на рис. 4. 
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Рис. 4. Эффект Загиб края страницы… (Page Curl…) 

Эффект Импрессионизм… (Impressionist…) из группы эффектов 

Художественные мазки (Art Strokes) создает имитацию живописи мазками. 

В диалоговом окне Импрессионизм… (Impressionist…) (рис. 5) 

выбирают стиль рисования (размер штриха или мазка), цветовой диапазон, 

яркость будущего изображения. 

 

 
 

Рис. 5. Диалоговое окно Импрессионизм… (Impressionist…) 

 

 

Пример 2.  

Применить эффект  Импрессионизм… (Impressionist…) к исходному 

изображению. 

 

1. Вставить изображение из буфера обмена и выделить его. 

2. Выполнить цепочку команд Растровые изображения → 

Художественные мазки →  Импрессионизм… (Bitmaps  → Art 

Strokes → Impressionist…). В появившемся диалоговом окне 

назначить параметры эффекта. 
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Результат применения эффекта Импрессионизм… (Impressionist…) 

показан на рис. 6. 

 

Рис. 6. Эффект Импрессионизм… (Impressionist…) 

Эффект Уголь… (Charcoal…) их той же группы эффектов создают 

имитацию рисования углем по бумаге. Рисунок становится черно-белым. 

В диалоговом окне Уголь… (Charcoal…) (рис. 7) настраивают толщину 

линий обводки и интенсивность черного цвета и регулируют диапазон 

прорисовки полутонов и теней. 

 

 
 

Рис. 7. Диалоговоу окно Уголь… (Charcoal…) 

 

 

 

Пример 3. 

Применить к исходному изображению эффект Уголь… (Charcoal…). 

 

1. Вставить изображение из буфера обмена и выделить его. 

2. Выполнить цепочку команд Растровые изображения → 

Художественные мазки →  Уголь… (Bitmaps  → Art Strokes → 

Charcoal…) . В появившемся диалоговом окне настроить  

параметры создания эффекта. 

Результат применения эффекта Уголь… (Charcoal…) показан на рис. 8. 
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Рис. 8. Эффект Уголь… (Charcoal…) 

 

Эффекты группы Творческие (Creative) имитируют различные 

варианты приемов изображения (кристаллизация, мозаика, виньетка, цветное 

стекло и др.). Например, при создании эффекта 

Кристаллизация…(Crystalize…) изображение разбивается на блоки заданных 

размеров, которые смещаются относительно друг друга. Размер кристалла 

задают в диалоговом окне эффекта (рис. 9). 

 

 

 
 

Рис. 9.  Диалоговое окно Кристаллизация…(Crystalize…) 

 

 

 

Пример 4. 

Применить к исходному изображению эффект 

Кристаллизация…(Crystalize…). 

 

1. Вставить изображение из буфера обмена и выделить его. 

2. Выполнить цепочку команд Растровые изображения → 

Творческие → Кристаллизация… (Bitmaps  → Creative → 

Crystalize…). В появившемся диалоговом окне задать размер 

кристалла. 
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Результат применения эффекта Кристаллизация…(Crystalize…) показан 

на рис. 10. 

 
 

Рия. 10. Эффект Кристаллизация…(Crystalize…) 

Эффекты группы Искажение (Distort) имитируют различные 

вариантыискажения изображения (блоки, рябь, жидкая краска и др.). 

например, эффект Рябь… (Ripple…) создает эффект волн, идущих в одном 

или в двух перпендикулярных направлениях. Параметры этих волн (период и 

амплитуда волн, уголнаклона осей волн) можно регулировать в широких 

пределах в диалоговом окне созжания эффекта (рис. 11). 

 

 
 

Рис. 11. Диалоговое окно Рябь… (Ripple…) 

 

 

 

Пример 5. 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 177 

Применить к исходному изображению эффект Рябь… (Ripple…). 

 

1. Вставить изображение из буфера обмена и выделить его. 

2. Выполнить цепочку команд Растровые изображения → 

Искажение  → Рябь… (Bitmaps  → Distort → Ripple…). В 

появившемся диалоговом окне задать угол наклона осей, вдоль 

которых формируются волны, и отрегулировать амплитуду 

основной волны. 

Результат применения эффекта  Рябь… (Ripple…) показан на рис. 12. 

 
 

Рис. 12. Эффект Рябь… (Ripple…) 
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2. ПРАКТИЧЕСКИЙ РАЗДЕЛ 

 

Тема 1: Теория и методика изучения основных тем графических 

редакторов растровой, векторной графики для школьников 6 класса. 

Принципы и средства работы с растровой, векторной графикой. Графический 

редактор Paint, рисование в Word, создание мультимедийной презентации в 

программе Microsoft Power Point. Приѐмы и методы работы в графическом 

редакторе Pаint. Создание простых графических изображений с помощью 

примитивов. Редактирование графических изображений. Операции с 

графическими изображениями. Шрифт. Вставка и редактирование 

изображений. Приѐмы и методы рисования в Word. Создание графических 

изображений с помощью инструментов рисования. Виды заливок, контур. 

Редактирование графических изображений. Операции с графическими 

изображениями. Текст WordArt в графике, виды заливки текста, текст по 

кривой. Создание 3D изображений. Объѐм, тень. Создание мультимедийных 

презентаций в программе Microsoft Power Point. Методы создания 

презентации с использованием размѐтки слайда и шаблона. Изменение 

цветовой схемы слайда. Вставка текста. Создание анимационных эффектов 

презентации. Принципы использования шрифтовой композиции WordArt при 

оформлении слайдов. Смена слайдов.  Показ слайдов. Гиперссылки. Звук. 

Просмотр слайдов. 

Тема 2. Методика изучения графических редакторов растровой графики 

для школьников 7 класса. Принципы  работы с растровой графикой 

Adobe Photoshop. 

Задание 1.Редактирование фотографий.Обрезка. 

Задание 2. Коррекция портретов. 

Задание 3.Замена цвета. 

Задание 4.Выполнить колаж «Подводный мир», «Мир пернатых». 

Задание 5.Выполнить портрет, используя клонирующий штамп. 

  
 

Задание 6. Создание новогодней открытки. 

 

  

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

ПУ



 

 179 

 

Задание 7.Рисуем с помощью графического планшета. 

Задание 8.Выполнить цветную фотографию с черно-белой. 

            
 

 

Задание 9. Живая фотография. 

 
Задание 10.Объѐмная фотография. 

 
 

Тема 3: Методика изучения графических редакторов векторной графики 

для школьников 8 класса. Основные принципы работы в графическом 

редакторе векторной графики CorelDRAW. 
Задание 1.Нарисовать квадрат со скругленными углами (рис. 2. а). 
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                                       а                                       б                                       в 

 

Рис. 2. Наклонный квадрат со скругленными углами и синим контуром: 

а- исходная форма; б- наклонный квадрат;  

в – готовое изображение 

 

1. Повернуть квадрат. 

Для этого дважды щелкнуть по квадрату инструментом  Указатель 

(Pick Tool) (кнопка ) и наклонить его, потянув за угловые 

двунаправленные стрелки (рис. 2, б). 

2. Выполнить контур квадрата синей линией толщиной 3,0 мм. 

Это можно сделать двумя способами: 

1) Выделить квадрат. На панели настроек инструмента задать 

толщину абриса (контура) 3,0 мм и щелкнуть правой кнопкой 

мыши по образцу выбранного цвета на палитре цветов. 

 

2) Выделить квадрат. Выбрать инструмент Перо абриса (Outline 

Tool) и в диалоговом окне (рис. 3)  в поле Цвет (Color) выбрать 

синий цвет, в поле Ширина (Wight) – 3,0 мм, Стиль (Style) – 

сплошная линия и нажать кнопку ОК. 

В результате этих действий контур выделенного квадрата станет 

сплошной синей линией толщиной 3,0 мм (рис. 2, в). 
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                Рис. 3. Диалоговое окно Перо абриса (Outline Tool) 

 

Задание 2.Создать орнаментальную композицию в круге. 

 

1) Нарисовать окружность, применить к ней градиентную заливку, 

изменить толщину и цвет контура (рис. 4, а). 

2) Поместить в центр круга изображение звезды с эффектом 

прозрачности и увеличить его размеры в соответствии с кругом 

(рис. 4, б). 

3) Наложить второе изображение, слегка увеличив его размеры (рис. 

4, в). 

4) Оставшиеся изображения разместить в соответствии с рис. 4, г. 

                             
 

            а                                                                                б  
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               в                                                                              г        

            

Рис. 4.  Этапы создания орнамента в круге 

 

 

Задание 3.Создание эффекта Power Clip 

 

1. Написать художественный текст жирным шрифтом (рис. 1). 

 

 
 

Рис. 1. Художественный текст 

 

 

2. Нарисовать квадрат,  применить к нему градиентную заливку и создать 

копию (рис. 2). 

 

 
 

Рис. 2. Квадрат с градиентной заливкой  

 

 

3. Применить к квадрату эффект Искажение (Distortion Tool). 

 

1) Выделить один квадрат. Выбрать инструмент Искажение 

(Distortion Tool), прижать указатель мыши к центру выделенного 

квадрата и  переместить его влево (рис. 3). 

 

текст
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Рис. 3. Создание эффекта искажения: 

а – создание эффекта; б – готовое изображение 

 

2) Выделить второй квадрат. Выбрать инструмент Искажение 

(Distortion Tool), прижать указатель мыши к центру выделенного 

квадрата и  переместить его вправо (рис. 4). 

 

                 
 

Рис. 4. Создание эффекта искажения: 

а – создание эффекта; б – готовое изображение 

 

 

4. Применить к полученным изображениям эффект Перетекание (Blend 

Tool). 

 

1) Инструментом Указатель (Pick Tool) объединить полученные 

изображения. 

2) Выбрать инструмент Перетекание (Blend Tool), прижать 

указатель мыши на центре одного объекта и потянуть к центру 

другого  (рис. 4). 

 

 
а 
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б  

 

Рис. 4. Создание эффекта перетекания: 

а – создание эффекта; б – готовое изображение 

 

5. Применить к художественному  тексту эффект Power Clip . 

 

1) Выделить изображение, полученное в результате перетекания,  и 

выполнить цепочку команд Эффекты → Power Clip → Поместить 

в контейнер… (Effects → Power Clip → …). Появившуюся 

черную стрелку навести на текст, и щелкнуть левой клавишей 

мыши. 

2) Выполнить цепочку команд Эффекты → Power Clip → 

Редактировать содержимое (Effects → Power Clip → …). 

3) Перетянуть выделенное изображение на текст и применить 

команду Эффекты → Power Clip → Завершить редактирование 

(Effects → Power Clip → …). 

В результате этих действий однородная заливка текста преобразуется в 

сложный узор (рис. 5). 

 

             
            

Рис. 5. Создание эффекта Power Clip РЕ
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Задание 4.Создание новой кисти и использованиееѐ в создании  открытки. 

 
 

 

 
1. Выполнить из звезд небольшую композицию. 

Для этого сделать несколько копий, изменить их размеры и 

сгруппировать все объекты (рис. 8). 

 

 

 
 

Рис. 8. Композиция из звезд 

2. Добавить созданную композицию в список аэрозолей. 

Для этого выделить композицию. На панели инструментов рисования 

выбрать инструмент Художественное оформление (Artistic Media Tool) 

(кнопка ), а на панели настройки инструмента Распылитель (Sprayer) 

(кнопка ) и нажать на кнопку   Добавить в список аэрозолей. 
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3. Нарисовать  новой кистью сердце по центру открытки (рис. 9). 

Нарисовать новой кистью сердце, выделить контуры полученного 

изображения и на панели настройки инструмента Распылитель (Sprayer) 

настроить эффект в интервалах . 

 

4.Выполнить  объемное сердечко. Всѐ сгруппировать и добавить текст по 

кривой. 

Задание 5.Нарисовать натюрморт 
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Применить к нарисованному натюрморту эффекты растровой графики. 
 

 

Задание 6.Изображение плаката. 
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4. РАЗДЕЛ КОНТРОЛЯ ЗНАНИЙ 

 

3.1. Критерии оценок результатов учебной деятельности 

 

Отметк

а в 

баллах 

Показатели оценки результатов учебной деятельности 

1 Отсутствие знаний и компетенций в рамках образовательного 

стандарта или отказ от ответа или невыполненный объем практических, 

самостоятельных и лабораторных заданий предусмотренных 

программой.  

2 Фрагментарные теоретические знания в рамках образовательного 

стандарта. Неумение использовать научную терминологию дисциплины, 

наличие в ответе грубых стилистических и логических ошибок. 

Пассивность на семинарских, практических и лабораторных занятиях. 

Низкий методический и художественный уровень культуры исполнения 

задания или неполный объем выполненных заданий.  

3 Фрагментарные теоретические знания в рамках образовательного 

стандарта, изложение ответа на вопросы с существенными ошибками. 

Неумение ориентироваться в основных теориях, концепциях и 

нормативно-методических документах по изучаемой дисциплине. 

Пассивность на практических и лабораторных занятиях. Выполнение 

практических, самостоятельных, лабораторных заданий с 

существенными ошибками. Низкий методический и художественный 

уровень культуры исполнения заданий. 

4 Умение ориентироваться в основных теоретических положениях 

учебного материала, воспроизведение его содержания в логической 

последовательности с использованием научной терминологии. Усвоение 

основной литературы, рекомендованной учебной программой 

дисциплины. Умение под руководством преподавателя решать 

стандартные методические и художественно-творческие задачи на 

практических и лабораторных занятиях. Допустимый уровень культуры 

исполнения задания в полном объеме предусмотренном программой. 

5 Умение ориентироваться в основных теоретических положениях 

учебного материала, воспроизведение его содержания в логической 

последовательности с использованием научной терминологии. Усвоение 

основной литературы, рекомендованной учебной программой 

дисциплины. Ориентация в основных теориях, концепциях и нормативно 

- методических документах по дисциплине. Способность самостоятельно 

решать типовые задания в рамках учебной программы. Периодическое 

участие в групповых обсуждения. Высокий уровень культуры 

исполнения заданий без существенных ошибок.  
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6 Достаточно полные и систематизированные знания в объеме учебной 

программы, использование необходимой научной терминологии. 

Усвоение основной и дополнительной литературы, рекомендованной 

учебной программой дисциплины. Стилистически грамотное и 

логически правильное изложение теоретического материала, умение 

делать обоснованные выводы. Ориентация в основных теориях, 

концепциях, нормативно-методических документах по дисциплине и 

умение анализировать их. Способность самостоятельно применять 

полученные знания при выполнении учебных заданий, активная 

самостоятельная работа на практических и лабораторных занятиях. 

Периодическое участие в групповых обсуждениях, выполнение заданий 

на высоком уровне культуры исполнения без существенных ошибок. 

7 Систематизированные, глубокие знания в объеме учебной 

программы, логически правильное изложение ответа на вопросы, умение 

делать обоснованные выводы. Усвоение основной и дополнительной 

литературы, рекомендованной учебной программой дисциплины. 

Владение инструментарием учебной дисциплины, умение его 

использовать в постановке и решении учебных задач. Ориентация в 

основных теориях, концепциях и нормативно-методических документах 

по дисциплине, умения анализировать и давать им критическую оценку. 

Активная самостоятельная работа на практических и лабораторных 

занятиях, участие в групповых обсуждениях на семинарских занятиях. 

Выполнение заданий на высоком методическом и художественном 

уровне культуры исполнения. 

8 Систематизированные, глубокие знания в объеме учебной 

программы. Логически правильное изложение ответа на вопросы, умение 

делать обоснованные выводы. Усвоение основной и дополнительной 

литературы, рекомендованной учебной программой. Владение 

инструментарием учебной дисциплины, умение его использовать в 

постановке и решении сложных учебных задач. Ориентация в основных 

теориях, концепциях и нормативно-методических документах по 

дисциплине, умение анализировать и давать им критическую оценку. 

Активная самостоятельная работа на практических и лабораторных 

занятиях, систематическое участие в групповых обсуждениях. 

Выполнение заданий на высоком методическом и художественном 

уровне культуры исполнения. 

9 Систематизированные, глубокие знания в объеме учебной 

программы. Свободное оперирование научной терминологией и 

инструментарием учебной дисциплины, умение его использовать в 

постановке и решении сложных учебных задач и нестандартных 

ситуациях. Высокая познавательная активность. Ориентация в основных 

теориях, концепциях и нормативно-методических документах по 

дисциплине, умение анализировать и давать им критическую оценку. 

Усвоение основной и дополнительной литературы, рекомендованной 

учебной программой дисциплины. Логически правильное изложение 
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ответа на вопросы, умение делать обоснованные выводы. Активная 

самостоятельная работа на практических и лабораторных занятиях. 

Систематическое участие в групповых обсуждениях на семинарских и 

практических занятиях. Выполнение заданий на высоком методическом 

и художественном уровне культуры исполнения.  

10 Систематизированные, глубокие теоретические знания в объеме 

учебной программы, а также по основным вопросам, выходящим за ее 

пределы. Безупречное владение инструментарием учебной дисциплины, 

умение его эффективно использовать в постановке и решении научных и 

профессиональных задач. Стилистически грамотное, логически 

правильное изложение ответа на вопросы. Высокая познавательная 

активность. Выраженная способность самостоятельно и творчески 

решать сложные проблемы в нестандартной ситуации. Активная 

творческая самостоятельная работа на практических и лабораторных 

занятиях. Использование современных достижений художественной 

практики в своей художественно-педагогической деятельности, 

способность к творческому эксперименту. Систематическое участие в 

групповых обсуждениях. Выполнение заданий на высоком 

методическом и художественном уровне культуры исполнения. 
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3.2. Вопросы к экзамену по дисциплине «Методика обучения 

компьютерной графике» 

 

Вопросы к экзамену по методике компьютерной графики 4 курс. 

1. Предмет «Методика обучения компьютерной графике», цели, задачи, 

содержание курса, его роль в общей системе подготовки учителя 

«изобразительного искусства и компьютерной графики».  

2. Связь методики  преподавания компьютерной графики с другими 

науками. Межпредметные связи компьютерной графики. 

3. Виды компьютерной графики и программного обеспечения для 

решения конкретных задач. Цветовые модели CMYK, RGB, HSB. Виды 

создания анимации. 

4. Основные понятия растровой и векторной графики. Типы файлов и 

способы хранения графической информации.   

5. Этапы и методы научных исследований, применяемые при 

изучении компьютерной графики. Структура курсовой работы. 

6. Дидактические принципы, применяемые при изучении 

компьютерной графики. 

7. Методы, формы проведения занятий компьютерной графики. 

8. Подготовка учителя к уроку. Типы и структура уроков 

компьютерной графики. 

9. Планирование учебной работы. Программа. Календарно-

тематический план. 

10. Планирование учебной работы. Программа. План - конспект урока.  

11. Планирование учебной работы. Создание мультимедийных 

презентаций.  

12. Методика изучения графических редакторов растровой графики. 

Основные принципы  работы с растровой графикой. Организация работы в 

графическом редакторе Pаint. Создание простых графических изображений. 

Рисование. Редактирование графических изображений. Операции с 

графическими изображениями. 

13. Методика изучения графических редакторов растровой графики. 

Основные принципы работы в графическом редакторе Pаint. Сложные 

графические изображения с помощью инструментов: дуги, кисти, 

распылителя. Примеры рисования. 

14. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровая графика Adobe Photoshop. 

Использование инструментов рисования. Рисование с помощью инструмента 

Кисть. Пример пейзаж. 

15. Методика изучения графических редакторов растровой графики. 
Основные принципы работы с растровая графика Adobe Photoshop. 
Рисование с помощью инструментов выделения. Опишите способы    
создания    выделенной    области    с    помощью    инструментов  
Прямоугольная   область.   Овальная   область.   Пример натюрморт.  
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16. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровая графика Adobe Photoshop. 
Использование инструментов рисования. Рисование с помощью 
инструментов выделения. Лассо, Полигональное лассо. Магнитное лассо и 
Волшебная папочка. Пример замены цвета с помощью этих выделений.  

17. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровая графика Adobe Photoshop. 

Использование инструментов рисования.  Какие  параметры  инструмента  

Фигуры  содержит Панель    настройки?    Заливка.    Рисование с помощью 

инструмента Форма пользователя. 

18. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой Adobe Photoshop. 

Изменение формы объектов. Трансформация. 

19. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой Adobe Photoshop. Работа с 

цветом.. Копирование, перемещение и удаление фрагментов.  

20. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой Adobe Photoshop. Работа с 

цветом. Коррекция цвета. RGB, CMYK,  

21. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой Adobe Photoshop 

Клонирующий штамп, узорный штамп, инструменты размазывания.  

22. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой  Adobe Photoshop Слои. 

Эффекты слоя, действия со слоями. Значение растушѐвки при работе со 

слоями. 

23. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой  Adobe Photoshop Слои. 

Эффекты слоя, действия со слоями. Значение растушѐвки при работе со 

слоями. Маска слоя. 

24. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой  Adobe Photoshop Слои. 

Каналы. Пример. 

25. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой  Adobe Photoshop 

Художественные эффекты. Фильтры растровой графики. 

26. Методика изучения графических редакторов растровой графики. 

Основные принципы работы с растровой графикой  Adobe Photoshop Слои. 

Художественные эффекты. Фильтры растровой графики. 

27. Методика изучения графических редакторов векторной графики. 

Средства работы с векторной графикой. Организация работы и рисование в 

Word. Создание графических изображений с помощью линии и основных 

фигур, виды заливки. Операции с графическими изображениями. Текст в 

графике, текст по кривой. 
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28. Методика изучения графических редакторов векторной графики. 

Средства работы с векторной графикой. Организация работы и рисование в 

Word. Тень и объѐм. Конструктор. 

29. Методика изучения графических редакторов векторной графики. 
Основные принципы работы с векторной графикой CorelDRAW. Запуск 
программы, сохранение документа, завершение работы. Создание документа, 
заданного размера. Назвать основные области окна программы: панель 
инструментов, строка состояния, навигатор документа, навигатор страницы и 
для чего они предназначена.Пользование линейками и направляющими при 
верстке. 

30. Методика изучения графических редакторов векторной графики. 
Основные принципы работы с векторной графикой CorelDRAW. 
Трансформация объектов: масштабирование, перекос, вращение. Изменение 
формы стандартных объектов (закругление углов, создание секторов). 
Пример задания трансформации. 

31. Методика изучения графических редакторов векторной графики. 
Основные принципы работы с векторной графикой CorelDRAW. 
Редактирование контура и заливки. Виды заливок. Дополнительные 
возможности заливки (смешивание цветов). Текстура, узор. Заливка по сетке. 
Пример. 

32. Методика изучения графических редакторов векторной графики. 
Основные принципы работы с векторной графикой CorelDRAW. Рисование. 

Виды кистей. Виды заливки  кистей. Редактирование контура и заливки. 
Пример рисования с помощью простых фигур. 

33. Методика изучения графических редакторов векторной графики. 
Основные принципы работы с векторной графикой CorelDRAW. 
Инструменты рисования линий. Виды кистей. Виды заливки  кистей. Пример 
рисования линиями с использованием заливок..  

34. Методика изучения графических редакторов векторной графики. 

Основные принципы работы с векторной графикой CorelDRAW Рисование с 

помощью Пульверизатора. Виды заливки. Редактирование заливки. 

Новогодняя открытка. 

35. Методика изучения графических редакторов векторной графики. 

Основные принципы работы с векторной графикой CorelDRAW. Основы 

работы с текстом. Фигурный и обычный текст. Действия над текстом. 

Создание нового текста.. 

36. Методика изучения графических редакторов векторной графики. 

Основные принципы работы с векторной графикой CorelDRAW. Основы 

работы с текстом. Текст по кривой (два вида написания текста). Заливка.  

37. Методика изучения графических редакторов векторной графики. 

Основные принципы работы с векторной графикой CorelDRAW. Применение 

эффектов векторной графики к тексту. 

38. Методика изучения графических редакторов векторной графики. 

Основные принципы работы с векторной графикой CorelDRAW. Применение 

эффектов векторной графики к растровым изображениям. Пример 
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39. Методика изучения графических редакторов векторной графики. 

Основные принципы работы с векторной графикой CorelDRAW. 

Художественные эффекты растровой графики. 

40. Методика изучения графических редакторов векторной и растровой 

графики. Творческое задание календарь. 

41. Методика создания мультимедийных презентаций в программе 

Microsoft Power Point. Методы создание презентации с использованием 

оформления слайда и шаблона. Изменение цветовой схемы слайда. 

Форматирование слайдов. Сортировщик слайдов. Вставка текста. 

42. Методика создания мультимедийных презентаций в программе 

Microsoft Power Poin. Принципы создание анимационных эффектов 

презентации. Анимация текста и объектов. Создание анимационных слайдов. 

Выполнение анимации текста и объектов. Использование шрифтовой 

композиции WordArt при оформлении слайдов.  Показ слайдов. 

43. Методика создания мультимедийных презентаций в программе 

Microsoft Power Poin. Методы создание презентации с использованием 

заливок. Форматирование слайдов. Применение анимации. 

44. Методика создания мультимедийных презентаций в программе 

Microsoft Power Poin.  Смена слайдов.  Показ слайдов. Вставка гиперссылки. 

45. Методика создания анимация Macromedia Flash. Файлы с 

расширением gif. Виды анимации. Примеры. 

46. Методика создания анимация Macromedia Flash. Рисование, 

трансформации объекта. Работа с цветом. Виды заливок. 

47. Методика создания анимация Macromedia Flash. Работа с текстом. 

Анимация текста. 

48. Методика создания анимация Macromedia Flash. Анимация. 

Использование слоев в анимации. Виды анимации движения объекта. 

Покадровая анимация.  

49. Методика создания анимация Macromedia Flash. Анимация. 

Использование слоев в анимации. Виды анимации движения объекта. 

Автоматическая анимация. Использование слоев в анимации. Управление 

движением. 

50. Методика создания анимация Macromedia Flash. Использование 

импортируемых растровых изображений при создании анимации. 

Применение визуальных эффектов. 
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3.3 Рейтинговые контрольные задания 

 

Рейтинговая контрольная работа № 2 

Тема: Принципы и средства работы с растровой графикой 

Задание: 1. Ознакомится с графическим редактором Paint. 

  2. Создать простое графическое изображение с помощью 

примитивов.  

    3. Разработать план конспект урока и мультимедийную 

презентацию по данной теме. 

 

Рейтинговая контрольная работа № 2 

Тема: Принципы и средства работы с векторной графикой 

Задание: 1. Создать графическое изображений с помощью инструментов 

рисования.  

    2. Отредактировать графические изображения. 

    3. Создать 3D изображение.  

    4. Разработать план конспект урока и мультимедийную 

презентацию по данной теме. 

 

Рейтинговая контрольная работа № 3 

Тема: Проведение фрагментов факультативных занятий редакторов 

растровой, векторной графики для младших школьников 

Задание: 1. Разработать план конспект урока; 

    2. Подготовит мультимедийную презентацию по теме; 

    3. Проведсти фрагмент уроков с использованием интерактивной 

доски на практическом занятии 
 

. 
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ВСПОМОГАТЕЛЬНЫЙ РАЗДЕЛ 

 

4.1 Список основной и дополнительной литературы 

Основная литература 

1. Бурлаков, М. СorelDRAW 11 / М. Бурлаков.– СПб.: БХВ-Петербург, 2003. 

2. Блум, С.Р. Создаѐм коллажи и иллюстрации с помощью Photoshop и Painter / 

С.Р. Блум. – М., 2009 

3. Вишневская, Л.А. Компьютерная графика для школьников / Л.А. Вишневская. 

– Минск: ОО «Новое знание», 2007. 

4. Графический дизайн и реклама / В.Д. Курушин. – М.: ДМК Пресс, 2001. 

5. Лапин, П. Самоучитель Macromedia Flash MX 5 / П. Лапин. – СПб.: Питер, 

2005. 

6. Левин, А. Самоучитель Adobe Photoshop / А. Левин. – СПб.: Питер, 2005. 

7. Миронов Д. CorelDRAW 11: учебный курс / Д. Миронов. – СПб.: Питер, 2009. 

8. Нодельман, Л.Я. Учебная программа по дисциплине компьютерная графика / 

Л.Я. Нодельман. – М. : Тровант, 1999. 

9. Петров, М.Н. Компьютерная графика: учебник [Электронный ресурс] / М.Н. 

Петров, В.П. Молочков. – СПб Питер, 2006.– 1 электрон. опт. диск (CD-ROM) : 

зв., цв. 

10. Пупцев, А.Е., Информатика 9 кл. Повышенный уровень: Учебное электронное 

издание / А.Е. Пупцев, Л.А. Вишневская, А.И. Лаппо, А.Г. Огейко, С.Г. 

Ершова. – Минск: «Народная асвета», 2006. 

11. Страсницкас, М. Эффективная работа с Adobe Photoshop 5.0 /                   М. 

Страсницкас. – СПб.: ПИТЕР, 1999. 

12. Тимофеев, Г.С. Графический дизайн [Текст] / Г.С. Тимофеев,                 Е.В. 

Тимофеева. – Ростов н/Д. Феникс, 2010. 

13. Хомский, Е.Г. Adobe Premiere / Е.Г. Хомский. – М, 2000. 

14. Яцюк, О.Г. Компьютерные технологии в дизайне. Эффективная реклама / О.Г. 

Яцюк, Э.Т. Романычева. – СПб.: БХВ-Петербург, 2002. 

 

Дополнительная литература 

1. Беляев, М.В. Основы композиции: учеб-метод. пособие / М.В. Беляев. – Минск, 

2002. 

2. Елсаков, А. Эволюция Компьютерной графики / А. Елсаков // Компьюарт. – 

2008. – № 4. – С. 15-18. 

3. Миронова, Л.Н. Цветоведение / Л.Н. Миронова. – Минск, 1984. 

4. Романычева, Э.Т. Инженерная и компьютерная графика /                        Э.Т. 

Романычева, Т.Ю. Соколова, Г.Ф. Шандурина. – М.: ДМК Пресс, 2001. 

5. Рунге, В.Ф.Основы теории и методологии дизайна: учебное пособие (конспект 

лекции) / В.Ф. Рунге, В.В. Сеньковский. – М.: М3 - Пресс, 2001.  

6. Чернышѐв, О.В. Формальная композиция / О.В. Чернышѐв. – Минск, 1999.  
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4.2.Рекомендации по написанию курсовых работ. 

Курсовая работа по дисциплине «Теория и методика обучения 

изобразительному искусству» относится к основным видам учебно-

исследовательской деятельности студентов.  

Цель курсовой работы:  

 расширить и углубить теоретические знания по дисциплине;  

 овладеть приемами самостоятельной познавательной деятельности, 

выработать умения формулировать рассуждения и обоснования, логично, 

последовательно и доказательно их излагать; 

 сформировать навыки работы с литературой; 

 выработать умения публичного выступления по подготовленному 

материалу; 

 В процессе работы на курсовой работой студент должен 

продемонстрировать умения: 

 обосновать актуальность, новизну и практическую значимость научной 

проблемы; 

 работать с научной литературой, оперировать терминами и понятиями в 

области методики; 

 раскрывать содержание исследуемой проблемы системно и 

последовательно; 

 выполнять методические разработки, необходимые для раскрытия 

проблематики исследования; 

 письменно излагать теоретический и фактический материал. 

Курсовая работа носит учебно-исследовательский характер и должна опираться 

на современные подходы и направления в развитии художественного образования 

и методической науки.  

Структура, содержание и оформление курсовой работы зависит от 

выбранного направления. Курсовая работа по дисциплине «Теория и методика 

преподавания изобразительного искусства может быть выполнена по одному из 

трех направлений инновационной работы в области художественного образования 

средствами изобразительного и декоративно-прикладного искусства. 

  психолого-педагогическое направление объединяет курсовые работы, 

целью которых является изучение процесса развития способностей, интереса и 

творческой активности детей разного возраста, выявление актуальных условий 

успешного художественного воспитания детей средствами изобразительного 

искусства; 

 искусствоведческое направление представлено курсовыми работами, в 

основе которых лежит сбор и адаптация для школы, учреждений дополнительного 

образования материала из области теории и истории изобразительного искусства; 

 методическое направление объединяет курсовые работы, нацеленные 

на решение методических проблем и разработку дидактических пособий для 

занятий по изобразительному искусству в школе, на факультативных и 

кружковых занятиях. Структура, содержание и оформление курсовой работы 

зависит от выбранного направления.  
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Курсовая работа должна характеризоваться самостоятельностью, полнотой 

раскрытия темы, логичностью выводов, научным стилем. Объем работы в 

компьютерном варианте-25-40 страниц, с одной стороны белого листа бумаги 

формата А4 (текстовый редактор Microsoft Word, шрифт Times New Roman 

(кириллица), размер 14 пт, интервал одинарный, выравнивание по ширине, поля: 

верхнее – 2 см, нижнее – 2,0 см, левое – 3,0 см, правое – 1,5 см; 

Курсовая работа включает следующие структурные части 

 задание  

 титульный лист;  

 оглавление;  

 введение, в котором отражается обоснование темы и ее актуальность, 

объект и предмет, цель, задачи, методы исследования, база исследования (1,5-2 

страницы). При обосновании выбора и актуальности темы исследования 

необходимо обратить внимание на степень ее изученности (кратко осветить 

историю вопроса), сформулировать проблему (указать на то, что надо изучить). 

Также во введении дается общая характеристика работы и указывается ее объем: 

количество глав, точное количество таблиц, схем, рисунков, приложений и 

использованных источников. 

Цель курсовой работы – определенный результат (теоретический, 

практический), который должен быть достигнут в ходе исследования. Для 

формулировки цели используются глаголы обосновать, раскрыть, установить, 

разработать, доказать, обобщить и т. п. 

Задачи курсовой работы – это программа, направленная на достижение цели. 

Для формулировки задач используются глаголы изучить, определить, описать, 

апробировать и т. д.  

 основная часть, в которой выделяются главы и параграфы. 

Содержание глав и параграфов должны отвечать поставленным задачам 

исследования. Каждая глава завершается выводами;  

 заключение; 

 библиографический список – это перечень литературных источников 

и других материалов, на которые в курсовой работе приводятся ссылки, 

представляется в алфавитном порядке. Библиографический список оформляется в 

соответствии с требованием «Инструкции по оформлению диссертации, 

автореферата и публикаций по теме диссертации». Ссылки на литературу в тексте 

курсовой работы приводятся цифрой в квадратных скобках [5] – ссылка на 

источник, [5, с. 8] – ссылка с указанием страницы процитированной работы, [3; 5; 

24] – ссылка на несколько работ. Номер литературного источника в ссылке 

должен соответствовать его номеру в библиографическом списке. Для раскрытия 

темы необходимо использовать не менее 20-25 источников, отражающих развитие 

научных тенденции по выбранной проблематике, как правило, за последнее 

десятилетие; 

 приложения, которые включают: таблицы, схемы, диаграммы, детские 

рисунки, технологические карты, разработки сценариев уроков, разработки 

программ по разным видам художественно-творческой деятельности, 

мультимедийные пособия и презентации, разработки наглядных пособий и другие 
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материалы позволяющие полнее раскрыть методику исследования и показать 

методические навыки студента.  Каждое приложение оформляется на отдельных 

листах и имеет свое тематическое заглавие. В верхнем правом углу указывается 

порядковый номер и т.д. 

Каждую главу курсовой работы следует начинать с нового листа. Заголовки 

глав печатаются симметрично тексту прописными буквами. 

Заголовок подразделов печатается с абзаца, строчными буквами, кроме 

первой прописной. Переносы слов в заголовках не допускаются. Точку в конце 

заголовка не ставят. Если заголовок состоит из двух предложений, их разделяют 

точкой. 

Страницы нумеруют арабскими цифрами в нижнем колонтитуле по центру. 

Титульный лист включается в общую нумерацию работы, однако на титульном 

листе номер не ставится. Нумерация листов и приложений должна быть сквозной. 

Страницы, содержащие приложения, в общий объем работы не входят. 

Разделы курсовой работы должны иметь порядковую нумерацию в пределах 

всей работы и обозначаться цифрами с точкой в конце. Введение и заключение не 

нумеруются. 

Если разделы подразделяются на подразделы, то они нумеруются арабскими 

цифрами в пределах каждого раздела. В конце заголовка подраздела точка не 

ставится, например «3.2» (второй подраздел третьего раздела). 

В текст курсовой работы следует помещать только наиболее важные 

таблицы. Вспомогательный материал целесообразно помещать в приложении. 

Иллюстрации располагают после первой ссылки на них. Иллюстрации (кроме 

таблиц) обозначаются словом «Рисунок» и нумеруются последовательно 

арабскими цифрами в пределах раздела, например «Рисунок. 1.2» (второй рисунок 

первого раздела). Если приведена только одна иллюстрация, то ее не нумеруют и 

«Рисунок» не пишут. 

Таблицы нумеруются последовательно арабскими цифрами в пределах 

раздела. Перед таблицей указывается ее наименование. В правом верхнем углу 

над соответствующим наименованием помещается надпись «Таблица» с 

указанием ее номера, например, «Таблица 1.2» (вторая таблица первого раздела). 

Если в работе приведена только одна таблица, то ее не нумеруют и слово 

«Таблица» не пишут. При переносе части таблицы на другой лист указывают над 

ней, например, «Продолжение таблицы 1.2». На все таблицы должны быть ссылки 

в тексте.  
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4.3.Примерная тематика курсовых работ по дисциплине «Методика обучения 

компьютерной графике» 

 

1. Методические разработки факультативных занятий по компьютерной графике 

в программе Adobe Photоshop  

2. Основы педагогического моделирования при построении образовательной 

технологии "Компьютерная анимация как средство медиаобразования"Основы 

создания видеоролика в программе  Nero Vision   
3. Теоретическое обоснование обучения компьютерной графике в высшей школе 

на примере использования графического редактора Corel Draw Основы 

трехмерного компьютерного моделирования.  

4. Роль компьютерных технологий в развитии творческих способностей 

учащихся 

5. Обучение школьников приемам стилизации в процессе обучения основам 

дизайна на факультативных занятиях по компьютерной графике. 

6. Особенности изобразительной деятельности учащихся младшего школьного 

возраста на факультативных занятиях по компьютерной графике. 

7. Методические особенности конструирования мультимедийных презентаций 

для  факультативных занятиях по компьютерной графике. 

8. Специфика и содержание обучения компьютерной графике в системе 

дополнительного образования. 

9. Интерактивные технологии обучения на уроках изобразительного искусства. 

10. Методика и организация проведения уроков тематического рисования на 

факультативных занятиях по компьютерной графике в школе. 

11. Факультатив по компьютерной графике как форма организации и управления 

художественно-творческой деятельностью учащихся. 

12. Методическое обеспечение учебного процесса по компьютерной графике 

(программа Windows Movie Maker). 

13. Методические разработки по компьютерной графике и анимации в программе 

Adobe Premiere 

14. Развитие творческих способностей на  факультативных занятиях по 

компьютерной графике в программе «Adobe Photoshop»  

15. Методическое обеспечение учебного процесса по компьютерной графике. 
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4.4. Типовые учебные планы 

4.4.1. Типовой учебный план 
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4.4.2. Учебный план 
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1.2. Программная документация 

 

Учреждение образования  

«Белорусский государственный педагогический университет 

имени Максима Танка» 

 

 

УТВЕРЖДАЮ 

Проректор по учебной работе БГПУ 

__________________ В.В. Шлыков 

__________________  

   

Регистрационный № УД-____________/уч. 

 

 

 

 

МЕТОДИКА ОБУЧЕНИЯ КОМПЬЮТЕРНОЙ ГРАФИКЕ 

 

Учебная программа учреждения высшего образования  

по учебной дисциплине для специальности:  

1-03 01 03 Изобразительное искусство и компьютерная графика 
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Учебная программа составлена на основе образовательного стандарта высшего 

образования ОСВО 1-03 01 03-2013 по специальности 1-03 01 03 Изобразительное 

искусство и компьютерная графика, от № 87 от 30.08.2013 г.  

 

СОСТАВИТЕЛИ: 
П.А. Кашевский, доцент кафедры художественно-педагогического образования 

учреждения образования «Белорусский государственный педагогический 

университет имени Максима Танка»; 

Л.А. Вишневская, старший преподаватель кафедры художественно-педагогического 

образования учреждения образования «Белорусский государственный 

педагогический университет имени Максима Танка» 

 

РЕЦЕНЗЕНТЫ: 

Л.Е. Дягилев, заведующий кафедрой дизайна частного учреждения образования 

«Институт современных знаний имени А.М. Широкова», доцент; 

Г.Ф. Шауро, заведующий кафедрой народного декоративно-прикладного искусства 

учреждения образования «Белорусский государственный университет культуры и 

искусств», доктор искусствоведения, профессор 

 

РЕКОМЕНДОВАНА К УТВЕРЖДЕНИЮ: 

Кафедрой художественно-педагогического образования  

(протокол № 10 от 15.05.2017 г.); 

И.о. заведующего кафедрой _____________ П.А. Кашевский 

Научно-методическим советом учреждения образования «Белорусский 

государственный педагогический университет имени Максима Танка» 

(протокол № _____ от 13.06.2017г.) 

 

Оформление учебной программы и сопровождающих ее материалов действующим 

требованиям Министерства образования Республики Беларусь соответствует 

Методист учебно-методического 

управления БГПУ 

___________________ Е.А. Кравченко 
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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 

 

Учебная программа по учебной дисциплине «Методика обучения 

компьютерной графике» разработана для учреждений высшего образования 

Республики Беларусь в соответствии с требованиями образовательных стандартов 

по специальности 1-03 01 03 Изобразительное искусство и компьютерная графика 

Данная учебная дисциплина является одной из учебных дисциплин, которые 

завершают процесс формирования профессиональных качеств будущего учителя 

изобразительного искусства и компьютерной графики. В курсе учебной 

дисциплины рассматриваются вопросы компьютерной подготовки школьников на 

факультативных занятиях в общеобразовательной средней школе. В учебной 

программе раскрывается теоретическая сущность дидактических принципов, 

методов, форм и пути их применения на занятиях путем использования пакета 

программ векторной графики Corel Draw или Adobe Illustrator, растровой графики 

Paint, Adobe PhotoShop, анимации в программе Adobe PhotoShop и Macromedia 

Flash с целью создания художественно-творческих работ. 

Содержание учебного курса методики обучения компьютерной графике 

обеспечивает базу для дальнейшего усовершенствования педагогического 

мастерства и компьютерной подготовки будущего учителя. По ходу изучения 

курса студент должен усвоить основные понятия, овладеть умениями и навыками 

работы на компьютере, умело использовать знания на уроках изобразительного 

искусства и факультативных занятиях по компьютерной графике.  

Учебная дисциплина «Методика обучения компьютерной графике» 

базируется на знаниях, умениях и навыках приобретенных при изучении таких 

учебных дисциплин, как «Композиция», «Цветоведение», «Художественное 

проектирование», «Компьютерная графика» и др. Указанные связи дисциплины 

«Методика обучения компьютерной графике» дают студенту системное 

представление о комплексе изучаемых дисциплин, что обеспечивает 

соответствующий теоретический уровень и практическую направленность в 

системе обучения и будущей деятельности педагога-художника. 

Цель учебной дисциплины обеспечение студента теоретическими 

знаниями и практическими умениями, рациональными методами, средствами и 

формами обучения компьютерной графике учащихся на факультативных занятиях 

в средней общеобразовательной школе. 

Задачи учебной дисциплины: 

 освоение теоретических и практических основ работы с графическими 

редакторами растровой и векторной графики, а также со способами создания 

анимации; 

 формирование у студента практических навыков работы в графических 

редакторах для решения художественно-творческих задач в средней 

общеобразовательной школе; 

 формирование графической культуры и развитие художественно-

творческих способностей; 

 повышение культуры использования информационных технологий в 

сфере профессионального художественного творчества и образования. 
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Учебная программа включает теоретическую и практическую подготовку 

будущего специалиста, которая реализуется через различные формы работы со 

студентом: лекции, лабораторные занятия, самостоятельную работу. 

Практическая деятельность студента определяется работой с литературными 

источниками, выполнением учебных художественно-творческих работ, а также 

работу с редакторами компьютерной графики. 

Наряду с этим при работе с персональным компьютером у студента 

эффективно развиваются многие личностные качества: пространственное, 

аналитическое, образное и логическое мышление, воображение, память и др. 

Особое значение для формирования профессиональных умений и навыков имеет 

развитие творческих способностей студентов педагогических специальностей.  

Структура учебной дисциплины «Методика обучения компьютерной 

графике» в учебной программе построена на основе традиционного подхода с 

разделением содержания на разделы и темы, представляющие собой относительно 

самостоятельные дидактические единицы обучения. 

Изучение учебной дисциплины «Методика обучения компьютерной 

графике» должно обеспечить формирование у студента академических, 

социально-личностных и профессиональных компетенций. 

Требования к академическим компетенциям 

Студент должен: 

АК-1. Уметь применять базовые научно-теоретические знания для решения 

теоретических и практических задач. 

АК-4. Уметь работать самостоятельно. 

Требования к социально-личностным компетенциям 

Студент должен: 

СЛК-6. Уметь работать в команде. 

СЛК-7. Быть способным осуществлять самообразование и совершенствовать 

профессиональную деятельность. 

Требования к профессиональным компетенциям 

Студент должен быть способен: 

ПК-22. Осуществлять самообразование и совершенствования 

профессиональной деятельности. 

В соответствии с содержанием конкретной темы и определенной системой 

художественно-творческих компетенций (знаний и умений, способов 

деятельности) студентом выполняются задания.  

В результате изучения дисциплины студент должен  знать: 

- структуру и содержание курса компьютерной графики в школе; 

- учебно-методическое и программное обеспечение курса; 

- методику изучения основных понятий и тем; 

- современные тенденции в графическом компьютерном дизайне; 

В результате изучения дисциплины студент должен  уметь: 

- использовать методику обучения учащихся приемам создания 

графических компьютерных композиций; 

- организовать художественно-творческую деятельность учащихся в 

виртуальной среде; 
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- развивать и совершенствовать у учащихся навыки освоения программного 

обеспечения. 

В результате изучения дисциплины студент должен  владеть: 

 векторной, растровой и трехмерной графикой; 

 системами автоматического проектирования; 

 инструментами  обработки анимации и звука. 

В данной программе структура содержания учебной дисциплины «Методика 
обучения компьютерной графике» построена на основе традиционного подхода с 
разбиением содержания на темы; при этом они представляют собой относительно 
самостоятельные дидактические единицы содержания обучения. 

Основными методами (технологиями) обучения являются: 
коммуникативные технологии, основанные на активных формах и методах 
обучения (мозговой штурм, дискуссия, творческий диалог и др.); теоретико-
информационные методы (лекционный метод изложения материала, объяснение, 
мультимедийная демонстрация, консультирование и др.); практико-операционные 
методы (упражнения, алгоритм, педагогический показ технологических приемов 
работы и др.); методы самостоятельной работы студента; контрольно-оценочные 
методы (устное выступление, опрос, просмотр, контрольно-рейтинговый срез и др.). 

Учебная дисциплина «Методика обучения компьютерной графике» 

позволит глубже понять возможности и общую неразрывную связь 

педагогических учебных дисциплин и видов изобразительного искусства. 

На изучение учебной дисциплины «Методика обучения компьютерной 

графике» отведено: дневная форма получения образования всего 139 часов, из них 

62 часа аудиторных занятий (12 лекционных, 40 практических и 8 

лабораторных), 41 час на самостоятельную работу студентов. 

Итоговая форма контроля: экзамен. 

Распределение аудиторных часов по курсам и семестрам: 

3 курс, 6 семестр: 4 часа лекций, 22 часа практических занятий; 16 часов 

самостоятельной работы студентов; 

4 курс, 7 семестр: 4 часа лекций, 20 часов практических занятий; 25 часов 

самостоятельной работы студентов, форма контроля – экзамен. 
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СОДЕРЖАНИЕ УЧЕБНОГО МАТЕРИАЛА 

Тема 1. «Методика обучения компьютерной графике» как научная 

дисциплина 

1.1 Предмет «Методика обучения компьютерной графике»  

1. Цели, задачи, связь с другими науками, межпредметные связи. 

2. Этапы и методы научных исследований, которые используются при 

изучении методики обучения компьютерной графики.  

3. Основные дидактические принципы. 

4. Методы формы проведения занятий по компьютерной графике 

1.2.Принципы и методы обучения компьютерной графике 

1. Факультативные занятия по компьютерной графике. Программа 

2. Планирование учебной работы. 

3. Типы и структура занятий компьютерной графики. 

4. Подготовка учителя к уроку. Организация учебной работы на 

факультативных занятиях компьютерной графики. План-конспект урока.  

5. Иллюстрированный календарно-тематический план. 

6. Мультимедийные презентации. 

Тема 2. Теория и методика изучения основных тем графических 

редакторов растровой, векторной графики для школьников 

2.1. Методика изучения графических редакторов растровой графики 

для школьников  
Принципы  работы с растровой графикой Adobe Photoshop. Цветовые 

модели CMYK, RGB, HSB. Создание документа с нужными параметрами. 

Использование инструментов рисования. Рисование с помощью инструмента 

«Кисть», рисование с помощью выделений, рисование с помощью инструмента 

«Форма пользователя». Изменение формы объектов. Работа с цветом «Палитра 

цветов». Коррекция цвета. Копирование, перемещение и удаление фрагментов. 

Трансформация объектов. «Клонирующий штамп», инструменты размазывания. 

Слои. Стили. Художественные эффекты (фильтры) растровой   графики. Работа с 

текстом. Анимация.  

2.2. Проведение фрагментов факультативных занятий в редакторе 

растровой графики Adobe Photoshop 

 Подготовка  учителя к факультативным занятиям, план конспект, создание 

мультимедийных презентаций. Проведение фрагментов уроков с использованием 

интерактивной доски. 

2.3. Методика изучения графических редакторов векторной графики 

для школьников  

Основные принципы работы в графическом редакторе векторной графики 

CorelDRAW. Векторная графика (CorelDRAW или Adobe Illustrator). Основные 

инструменты программы, базовые термины компьютерной графики. Создание 

объектов-примитивов. Операции с объектами. Работа с узлами и кривыми. Виды 

заливок и текстур. Решение композиционных задач на основе простых 

геометрических фигур. Приемы трансформации, моделировки и цветового 

решения объектов при выполнении задач формальной композиции. Эффекты, 
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применяемые к объектам векторной графики. Использование специальных 

эффектов программы, их настройки, возможности. Создание простых текстур и 

орнамента, путем связи двух и более элементов. Работа с текстом средствами 

векторной графики. Многообразие шрифтов и их модификации. Форматирование. 

Простой и художественный тест. Решение художественно-графических задач: 

шрифтовая композиция, элементы фирменного стиля (логотип, товарный знак), 

плакат (социальный, кино-плакат, театральный, рекламный плакат). 

2.4. Проведение фрагментов факультативных занятий в редакторе 

векторной графики CorelDRAW 

Подготовка  учителя к факультативным занятиям, план конспект, создание 

мультимедийных презентаций. Проведение фрагментов уроков с использованием 

интерактивной доски. 

Тема 3. Теория и методика изучения основных тем графических 

редакторов растровой, векторной графики для младших школьников 

3.1.Принципы и средства работы с растровой графикой 
 Графический редактор Paint. Приѐмы и методы работы в графическом 

редакторе Pаint. Создание простых графических изображений с помощью 

примитивов. Редактирование графических изображений. Операции с 

графическими изображениями. Шрифт. Вставка и редактирование изображений. 

3.2.Принципы и средства работы с векторной графикой 

Приѐмы и методы рисования в Word. Создание графических изображений с 

помощью инструментов рисования. Виды заливок, контур. Редактирование 

графических изображений. Операции с графическими изображениями. Текст 

WordArt в графике, виды заливки текста, текст по кривой. Создание 3D 

изображений. Объѐм, тень. 

3.3. Создание анимации и мультимедийных презентаций в программе 

Microsoft Power Point 
Методы создания презентации с использованием размѐтки слайда и 

шаблона. Изменение цветовой схемы слайда. Вставка текста. Создание 

анимационных эффектов презентации. Принципы использования шрифтовой 

композиции WordArt при оформлении слайдов. Смена слайдов.  Показ слайдов. 

Гиперссылки. Звук. Просмотр слайдов. 

3.4. Проведение фрагментов факультативных занятий редакторов 

растровой, векторной графики для младших школьников  
Подготовка учителя к факультативным занятиям, план конспект, создание 

мультимедийных презентаций. Проведение фрагментов уроков с использованием 

интерактивной доски 
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ТРЕБОВАНИЯ К КУРСОВОЙ РАБОТЕ 

 

Курсовая работа по учебной дисциплине «Методика обучения компьютерной 

графике» относится к основным видам учебно-исследовательской деятельности 

студента.  

Цель курсовой работы:  

  расширить и углубить теоретические знания по дисциплине;  

  овладеть приемами самостоятельной познавательной деятельности, 

выработать умения формулировать рассуждения и обоснования, логично, 

последовательно и доказательно их излагать; 

  сформировать навыки работы с литературой; 

  выработать умения публичного выступления по подготовленному 

материалу; 

В процессе работы на курсовой работой студент должен продемонстрировать 

умения: 

 обосновать актуальность, новизну и практическую значимость научной 

проблемы; 

 работать с научной литературой, оперировать терминами и понятиями в 

области методики; 

 раскрывать содержание исследуемой проблемы системно и 

последовательно; 

 выполнять методические разработки, необходимые для раскрытия 

проблематики исследования; 

 письменно излагать теоретический и фактический материал. 

Курсовая работа носит учебно-исследовательский характер и должна опираться 

на современные подходы и направления в развитии художественного образования 

и методической науки.  

Структура, содержание и оформление курсовой работы зависит от 

выбранного направления. Курсовая работа по дисциплине «Методика обучения 

компьютерной графике» может быть выполнена по одному из двух направлений 

инновационной работы в области художественного образования.  

–  психолого-педагогическое направление объединяет курсовые работы, 

целью которых является изучение процесса развития способностей, интереса и 

творческой активности школьников; выявление актуальных условий успешного 

художественного воспитания школьников средствами компьютерной графики и 

изобразительной деятельности; 

  методическое направление объединяет курсовые работы, нацеленные 

на решение методических проблем и разработку дидактических пособий для 

занятий по компьютерной графике в школе на факультативных занятиях. 

Структура, содержание и оформление курсовой работы зависит от выбранного 

направления.  

Курсовая работа должна характеризоваться самостоятельностью, полнотой 

раскрытия темы, логичностью выводов, научным стилем. Объем работы в 

компьютерном варианте-25-30 страниц, с одной стороны белого листа бумаги 

формата А4. (текстовый редактор Microsoft Word, шрифт Times New Roman 
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(кириллица), размер 14 пт, интервал одинарный или полуторный), выравнивание 

по ширине.  

Курсовая работа включает следующие структурные части:  

  титульный лист;  

  оглавление;  

  введение, в котором отражается обоснование темы и ее актуальность, 

объект и предмет, цель, задачи, методы исследования, база исследования (1,5-2 

страницы).  При обосновании выбора и актуальности темы исследования 

необходимо обратить внимание на степень ее изученности (кратко осветить 

историю вопроса), сформулировать проблему (указать на то, что надо изучить); 

 основная часть, в которой выделяются главы и параграфы. Содержание 

глав и параграфов должны отвечать поставленным задачам исследования. Каждая 

глава завершается выводами;  

  заключение; 

  список литературы, который представляется в алфавитном порядке с 

сохранением библиографических требований. Для раскрытия темы должно быть 

использовано не менее 20-25 источников, отражающих развитие научных 

тенденции по выбранной проблематике, как правило, за последнее десятилетие. 

При написании курсовой необходимо делать ссылки на использованную 

литературу; 

 приложения, которые включают: таблицы, схемы, диаграммы, детские 

рисунки, технологические карты, разработки сценариев уроков, разработки 

программ по разным видам художественно-творческой деятельности, 

мультимедийные пособия и презентации, разработки наглядных пособий и другие 

материалы позволяющие полнее раскрыть методику исследования и показать 

методические навыки студента. 
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1 2 3 4 5 6 7 8 9 10 11 

 3 курс, 6 семестр          

1. Теория и методика обучения компьютерной 

графике как научная дисциплина 

       Компьютерная 

презентация  

№ 1. 

  

1.1 Предмет «Теория и методика обучения 

компьютерной графики » 

1. Цели, задачи, связь с другими науками, 

межпредметные связи. 

2. Этапы и методы научных исследований, 

которые используются при изучении методики 

преподавания компьютерной графики.  

3. Основные дидактические принципы. 

4. Методы формы проведения занятий по 

компьютерной графике 

2        [6] 

[10] 

[11] [15] 

[18] 

 

 

 

 

1.2 Принципы и методы обучения 

компьютерной графике 

1. Факультативные занятия по компьютерной 

  2 4    4  [6], [10], 

[11],  [15], 

[18] 
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графике. Программа 

2. Планирование учебной работы. 

3. Типы и структура занятий компьютерной 

графики. 

4. Подготовка учителя к уроку. Организация 

учебной работы на факультативных занятиях 

компьютерной графики. План-конспект урока.  

5. Иллюстрированный календарно-

тематический план. 

6. Мультимедийные презентации. 

 

2. Теория и методика изучения основных тем 

графических редакторов растровой, векторной 

графики для школьников  

   4         

2.1 Методика изучения графических редакторов 

растровой графики для школьников  
Принципы  работы с растровой графикой Adobe 

Photoshop. Цветовые модели CMYK, RGB, HSB. 

Создание документа с нужными параметрами. 

Использование инструментов рисования. Рисование 

с помощью инструмента «Кисть», рисование с 

помощью выделений, рисование с помощью 

инструмента «Форма пользователя». Изменение 

формы объектов. Работа с цветом «Палитра цветов». 

Коррекция цвета. Копирование, перемещение и 

удаление фрагментов. Трансформация объектов. 

«Клонирующий штамп», инструменты 

размазывания. Слои. Стили. Художественные 

эффекты (фильтры) растровой графики. Работа с 

текстом. Анимация.  

     2  [2] 

[3] 

[5] [8] 

[12] [13] 

 

 

2.2 Проведение фрагментов факультативных 

занятий в редакторе растровой графики Adobe 

Photoshop 
Подготовка учителя к факультативным 

 8    4  [2] 

[3] 

[5] [8] 

[12] [13] 
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занятиям, план конспект, создание мультимедийных 

презентаций. Проведение фрагментов уроков с 

использованием интерактивной доски. 

 

2.3 Методика изучения графических редакторов 

векторной графики для школьников  

Основные принципы работы в графическом 

редакторе векторной графики CorelDRAW. 

Векторная графика (CorelDRAW или Adobe 

Illustrator). Основные инструменты программы, 

базовые термины компьютерной графики. Создание 

объектов-примитивов. Операции с объектами. 

Работа с узлами и кривыми. Виды заливок и текстур. 

Решение композиционных задач на основе простых 

геометрических фигур. Приемы трансформации, 

моделировки и цветового решения объектов при 

выполнении задач формальной композиции. 

Эффекты, применяемые к объектам векторной 

графики. Использование специальных эффектов 

программы, их настройки, возможности. Создание 

простых текстур и орнамента, путем связи двух и 

более элементов. Работа с текстом средствами 

векторной графики. Многообразие шрифтов и их 

модификации. Форматирование. Простой и 

художественный тест. Решение художественно-

графических задач: шрифтовая композиция, 

элементы фирменного стиля (логотип, товарный 

знак), плакат (социальный, кино-плакат, 

театральный, рекламный плакат). 

  2     2  [1] 

[3] 

[5] [9] 

[10] [12] [13] 

 

 

 

2.4 Проведение фрагментов факультативных 

занятий в редакторе векторной графики 

CorelDRAW 

Подготовка  учителя к факультативным 

занятиям, план конспект, создание мультимедийных 

 10    4  [1] 

[3] 

[5] [9] 

[10] [12] [13] 
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презентаций. Проведение фрагментов уроков с 

использованием интерактивной доски. 

 Всего:    4 22    16    

 4 курс 7 семестр          

3. Теория и методика изучения основных тем 

графических редакторов растровой, векторной 

графики для младших школьников 

4       [3] 

[10] 

[12]  

 

3.1 Принципы и средства работы с растровой 

графикой 
Графический редактор Paint. Приѐмы и методы 

работы в графическом редакторе Pаint. Создание 

простых графических изображений с помощью 

примитивов. Редактирование графических 

изображений. Операции с графическими 

изображениями. Шрифт. Вставка и редактирование 

изображений.  

 

   4  6   

[3] 

[10] 

[12] 

Рейтинговая 

контрольная 

работа № 1 

3.2 Принципы и средства работы с векторной 

графикой 
Приѐмы и методы рисования в Word. Создание 

графических изображений с помощью инструментов 

рисования. Виды заливок, контур. Редактирование 

графических изображений. Операции с 

графическими изображениями. Текст WordArt в 

графике, виды заливки текста, текст по кривой. 

Создание 3D изображений. Объѐм, тень. 

   2  6  [3] 

[10] 

[12] 

Рейтинговая 

контрольная 

работа № 2 

3.3 Создание мультимедийных презентаций в 

программе Microsoft Power Point 
Методы создания презентации с 

использованием размѐтки слайда и шаблона. 

Изменение цветовой схемы слайда. Вставка текста. 

Создание анимационных эффектов презентации. 

   2  4  [3] 

[10] 

[12] 
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Принципы использования шрифтовой композиции 

WordArt при оформлении слайдов. Смена слайдов.  

Показ слайдов. Гиперссылки. Звук. Просмотр 

слайдов. 

3.4 Проведение фрагментов факультативных 

занятий редакторов растровой, векторной 

графики для младших школьников 
Подготовка  учителя к факультативным 

занятиям, план конспект, создание мультимедийных 

презентаций. Проведение фрагментов уроков с 

использованием интерактивной доски 

 20    9  [3], [10], 

[12],  [15], 

[18] 

 

Рейтинговая 

контрольная 

работа № 3 

 Всего: 4 20    25   Экзамен 

 ВСЕГО: 8 44    41    
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ИНФОРМАЦИОННО-МЕТОДИЧЕСКАЯ ЧАСТЬ 

 

Перечень основной и дополнительной литературы 

Основная:  

1. Боресков, А. Компьютерная графика. Учебник и практикум / А. Боресков, 

Е. Шишкин. – М.: Юрайт, 2016. 

2. Бурлаков, М. СorelDRAW 11 / М. Бурлаков.– СПб.: БХВ-Петербург, 2013. 

3. Блум, С.Р. Создаѐм коллажи и иллюстрации с помощью Photoshop и Painter / 

С.Р. Блум. – М., 2010 

4. Вишневская, Л.А. Компьютерная графика для школьников / Л.А. Вишневская. – 

Минск: ОО «Новое знание», 2007. 

5. Гурский, Ю. Компьютерная графика Photoshop CS5, CorelDRAW X5, Illustrator 

CS / Ю. Гурский. – СПб.: Питер, 2009. 

6. Ершов, А.П. Методика обучения информатике в средней школе / А.П. Ершов,  

С.А. Бешенков, Т.А. Бороненко, Гейн, А.Г.– М, 2010 

7. Петров, М.Н. Компьютерная графика: учебник [Электронный ресурс] / 

М.Н. Петров, В.П. Молочков. – СПб Питер, 2014.– 1 электрон. опт. диск (CD-

ROM). 

8. Пупцев, А.Е., Информатика 9 кл. Повышенный уровень: Учебное электронное 

издание / А.Е. Пупцев, Л.А. Вишневская, А.И. Лаппо, А.Г. Огейко, С.Г. 

Ершова. – Минск: «Народная асвета», 2006. 

9. Тимофеев, Г.С. Графический дизайн [Текст] / Г.С. Тимофеев, Е.В. Тимофеева. – 

Ростов н/Д. Феникс, 2010. 

 

Дополнительная:  

7. Беляев, М.В. Основы композиции: учеб-метод. пособие / М.В. Беляев. – Минск, 

2002. 

8. Елсаков, А. Эволюция Компьютерной графики / А. Елсаков // Компьюарт. – 

2008. – № 4. – С. 15-18. 

9. Кудрина, М.А. Компьютерная графика: учеб. / М.А. Кудрина, К.Е. Климентьев. 

– Самара: Изд-во Самар. гос. аэрокосм. ун-та, 2013. 

10. Лапчик, М.П. Методика преподавания информатики / М.П. Лапчик, И.Г. 

Семакин, Е.К. Хеннер. -М., 2001. 

11. Миронова, Л.Н. Цветоведение / Л.Н. Миронова. – Минск, 1984. 

12. Нодельман, Л.Я. Учебная программа по дисциплине компьютерная графика / 

Л.Я. Нодельман. – М.: Тровант, 1999. 

13. Романычева, Э.Т. Инженерная и компьютерная графика / Э.Т. Романычева, 

Т.Ю. Соколова, Г.Ф. Шандурина. – М.: ДМК Пресс, 2001. 

14. Рунге, В.Ф. Основы теории и методологии дизайна: учебное пособие (конспект 

лекции) / В.Ф. Рунге, В.В. Сеньковский. – М.: М3 - Пресс, 2001.  

15. Чернышѐв, О.В. Формальная композиция / О.В. Чернышѐв. – Минск, 1999.  
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ПЕРЕЧЕНЬ ИСПОЛЬЗУЕМЫХ СРЕДСТВ ДИАГНОСТИКИ 

РЕЗУЛЬТАТОВ УЧЕБНОЙ ДЕЯТЕЛЬНОСТИ 

 

Для текущего контроля усвоения знаний и умений студента по учебной 

дисциплине «Методика обучения компьютерной графике» рекомендуется 

использовать следующий диагностический инструментарий: 
– систематический устный опрос (беседа); 

– проведение фрагментов уроков с использованием интерактивной доски; 

– просмотр выполнения практических заданий и учебно-творческих 

разработок; 

– просмотр выполнения практических заданий, относящихся к 

рейтинговой работе. 

Учебным планом в качестве формы итогового контроля по учебной 

дисциплине «Методика обучения компьютерной графике» предусмотрен 

экзамен. 

Текущий контроль успеваемости проводится по десятибалльной шкале. 
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МЕТОДИЧЕСКИЕ РЕКОМЕНДАЦИИ ПО ОРГАНИЗАЦИИ И 

ВЫПОЛНЕНИЮ САМОСТОЯТЕЛЬНОЙ РАБОТЫ СТУДЕНТОВ 

 

Самостоятельная деятельность студента на дисциплине «Методика 

обучения компьютерной графике» направлена на усвоение учебной программы, 

самообразование и саморазвитие под руководством педагога. 

Целью самостоятельной работы студента является усовершенствование 

умений и навыков полученных на занятиях под руководством преподавателя. 

Задачами самостоятельной работы являются:  

 углубление и расширение теоретических и практических знаний в 

области композиции в компьютерном дизайне; 

 развитие познавательных способностей и активности студентов: 

творческой инициативы, самостоятельности, ответственности и 

организованности;  

 развитие исследовательских умений; 

 воспитание целеустремленности, ответственности, 

дисциплинированности, самоконтроля и т. д.; 

 выработка умений рациональной организации студентом трудовой 

деятельности и свободного времени; 

 использование знаний, умений, навыков, полученных в ходе лекций и 

в процессе выполнения аудиторных работ под руководством преподавателя. 

Структура содержания учебной программы по учебной дисциплине 

«Методика обучения компьютерной графике» построена на основе 

последовательного изложения содержания дисциплины; при этом темы 

представляют собой относительно самостоятельные задания обучения. 

Выполнение работ осуществляется в компьютерных классах под руководством 

преподавателя и могут продолжается в рамках внеаудиторной самостоятельной 

работы по заданию преподавателя в домашних условиях.  

Процесс организации самостоятельной работы студентов включает в себя 

следующие этапы: 

 подготовительный (определение целей, задач); 

 основной (выполнение практических заданий и подготовка к 

проведению   фрагментов уроков); 

 заключительный (анализ результатов). 

Основными видами самостоятельной работы по дисциплине «Методика 

обучения компьютерной графике» являются:  

 выполнение заданий;  

 подготовка методических разработок для проведения фрагментов уроков 

с использованием интерактивной доски; 

Успешность осуществления самостоятельной деятельности 

контролируется преподавателем в процессе проведения занятий, на экзамене. 
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СПИСОК КОМПЬЮТЕРНЫХ ПРОГРАММ 
 

На лабораторных занятиях, в процессе работы над заданиями, 

рекомендуется использовать следующие программы компьютерной графики: 

– Word, Paint, Microsoft Power Point, Adobe Photoshop, Corel DRAW. 
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ПЕРЕЧЕНЬ ЛИТЕРАТУРЫ ДЛЯ ПРЕПОДАВАТЕЛЯ 

ПО ОРГАНИЗАЦИИ САМОСТОЯТЕЛЬНОЙ РАБОТЫ СТУДЕНТОВ 
 

1. Беляев, М.В. Основы композиции: учеб.-метод. пособие / М.В. Беляев. – 

Минск: БГПУ, 2002. – 57 с. 
 

2. Кликс, Р.Р. Художественное проектирование экспозиций / Р.Р. Кликс. – М.: 

Высшая школа, 1978. – 368 с. 
 

3. Степанов, А.В. Объемно-пространственная композиция: учебное пособие для 

вузов / А.В. Степанов. – М.: Архитектура-С, 2007. – 137 с. 
 

4. Устин, В.Б. Композиция в дизайне. Методические основы композиционно-

художественного формообразования в дизайнерском творчестве: учебное 

пособие / В.Б. Устин. – М.: Астрель, 2006. – 239 с. 
 

5. Чернышев, О. В. Формальная композиция. Творческий практикум / 

О.В. Чернышев. – Минск: Харвест, 1999. – 312 с. 
 

6. Яцюк, О.Г. Компьютерные технологии в дизайне. Эффективная реклама / 

О.Г. Яцюк, Э.Т. Романычева. – СПб.: БХВ-Петербург, 2001. – 354 с 

 

 

ПЕРЕЧЕНЬ ЛИТЕРАТУРЫ ДЛЯ ПРЕПОДАВАТЕЛЯ  

ПО РЕАЛИЗАЦИИ РЕКОМЕНДУЕМЫХ МЕТОДОВ И ТЕХНОЛОГИЙ 

ОБУЧЕНИЯ 
 

1. Пидкасистый, П.И. Организация учебно-познавательной деятельности 

студентов / П.И. Пидкасистый. – М.: Высшее образование, 2004. – 420 с. 
 

2. Хуторской, А.В. Современная дидактика для вузов / А.В. Хуторской. – СПб.: 

Питер, 2001. – 380 с. 
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ПРОТОКОЛ СОГЛАСОВАНИЯ УЧЕБНОЙ ПРОГРАММЫ 

 

Название 

дисциплины, с 

которой требуется 

согласование 

Название 

кафедры 

Предложения об 

изменениях в 

содержании 

учебной 

программы 

учреждения 

высшего 

образования по 

учебной 

дисциплине 

Решение, 

принятое 

кафедрой, 

разработавшей 

учебную 

программу (с 

указанием даты и 

номера 

протокола)  

1. Композиция 

2. Художественное 

проектирование 

3. Компьютерная 

графика 

4. Цветоведение 

 

Кафедра 

художественно-

педагогического 

образования 

Из учебной 

программы 

дисциплины 

«Теория методика 

обучения 

компьютерной 

графике»  

Тема № 3 Теория и 

методика изучения 

основных тем 

графических 

редакторов 

растровой, 

векторной графики 

для младших 

школьников 

перенесена для 

изучения с 6 

семестра на 7 

семестр, в связи с 

наличием 

лабораторных 

занятий в 7 

семестре 

Протокол № 10 

от 15.05.2017 
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